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1 Getting Started with the Zimbra Web Client

The Zimbra Web Client (ZWC) is a full-featured messaging and collaboration application that
offers reliable, high-performance email, address books, calendaring, task lists, and Web
document authoring capabilities.

This chapter explains how to...
e Select the version of ZWC to use
e Login and log out
e Navigate your account
e Use Zimbra Assistant

e Learn about the availability of shortcut keys

Ny . . . . . . .
.‘1 % Some accounts will not include all the features mentioned in this guide. Check with

-" v : your administrator to see which features are enabled for your account.
ap

Advanced and Standard ZWC

The ZWC has two versions:

Advanced Web Client offers the full set of Ajax-based Web collaboration features. The
advanced Web client works with newer browsers and faster Internet connections.

Standard Web Client is a good option when Internet connections are slow or users prefer
HTML-based messaging for navigating within their mailbox.

This user guide describes the advanced ZWC. Many of the same features are available for the
standard ZWC but may not be accessed as described in this guide. The differences between
the advanced and standard versions of the ZWC are summarized in Appendix A: Standard
and Advanced ZWC. Refer to the Help in the ZWC for more information about these features.
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Features of the Zimbra Web Client (ZWC)

The features of the ZWC are summarized in the following table.

Function

| Feature Name

|Descnpﬂon

Safety and Security Features

Spam Protection

SpamAssassin

Besides using predefined rules to control
spam, the SpamAssassin filter learns what
users consider spam and not spam from
messages they specifically mark as Junk or
Not Junk in their mailbox.

Extra email

identities

Persona

The name and address configured for the
account creates the primary account persona.
Users can create up to 20 additional email
identities (personas) to manage different
roles.

Capacity and Flexibility Features

Quickly see all
related messages
with the same

subject

Conversation View

Users can see all their messages in a thread —
inbox, sent, filed, and even trash — in one

view.

Filter incoming

Email

Email Filters

Users can set up different filters to sort and

prioritize incoming email.

Manage the
mailbox quota

Quota

Users can store email messages up to the
quota set for their mailbox. They can see their
quota usage from their mailbox main page.

12
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Function Feature Name Description

With POP3 access, users can download their
Access messages . .
.. email messages from email programs such as
coming in to other | POP3 access

Outlook Express, Outlook, Eudora, or

email accounts s
Netscape Mail into the ZWC.

Users can send all their email from one place
Send messages ) but make it look like it's coming from

Choice of From . i - )
from more than 4d different email addresses. This is useful if
addresses
one account users are replying to messages sent to them

at a different email address, via POP3 access.

Users can redirect their email to another

Automatically Set Forwarding email account. They choose whether or not to
forward Email address have the forwarded message saved to their
ZWC account.

Positive Member Experience Features

Keep dormant Accounts may Users are not required to sign in to keep their

accounts remain dormant account active.

13
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Zimbra Web Client Components

The main ZWC components are Email, Address Book, Calendar, Tasks, and Documents. User
Preferences and Zimbra Assistant are also powerful ZWC features.

The features of each component are included in the following table.

Component Features

e Compose and send new email messages

e Include attachments with your message

e Read and reply to email messages

e Forward email messages to one or more recipients

e Track email exchanges using the Conversation feature (to view
an entire message thread at once) or traditional message view

Email e Search email messages, attachments, and other ZWC areas
e Create your own folders to organize email

e Create tags to organize your email, contacts, etc.

e Create filters to route incoming email to designated folders

e Configure your ZWC account to receive email from your POP3

accounts

e Share your email folders

e Create and manage multiple address books
e Easily add contacts from email messages you receive
Address Book

e Import and export contact lists

e Share your address books
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Component Features

Calendar

Create and manage multiple calendars
Create appointments, meetings, and events
See attendee's free/busy schedules

Import and export calendars

Share your calendars

Tasks

Create multiple tasks lists

Create to-do tasks

Add attachments to your tasks

Manage a task, set the priority, and track the progress

Share your task lists

Documents

Create multiple notebooks to organize your Web documents

Design pages using an HTML editor, create tables and
spreadsheets, add graphics, and create links to Web pages

Share your notebooks

Briefcase

Upload any type of file to your briefcase so that you can access
the file whenever you log on to ZWC

Create folders to organize files that you upload

Share your Briefcase folders

15
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Component Features

e Manage how your mailbox features work for Email, Address
Book, and Calendar

e Create email filters
e Set up forwarding to another email account

e Create notification messages, such as a vacation message, and
Preferences designate when to turn them on and off

e Choose a different language to view a mailbox user interface

e Assign shortcut keys to quickly access email folders, saved
searches, and tags

e Use different account identities (personas) and addresses to
manage different roles in your job or personal life

e Use keyboard shortcuts to:

e Create new appointments

. . ¢ (o to a specific date in your calendar
Zimbra Assistant

e (Create new contacts

¢ Send a new email message without leaving the application you

are using
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Browser Compatibility

The Zimbra Web Client is designed to work within an Internet browser. The recommended

browser is Mozilla Firefox 2.0 or later. Not all browsers are supported, so check with your

administrator if you have questions.

Follow these general guidelines when using the Zimbra Web Client within a browser:

e The browser's Back button takes you to the previous page you were viewing. You can

also use the Forward button.

e Do not use the browser's Reload (Refresh) button. Doing so will restart your session.

Logging In

Open a browser window and enter the URL provided by your administrator. In most cases,

Advanced is the default client and is
opened automatically when you log in.
Before you enter your name and
password, you can switch to the
standard web client or to the mobile

client.

Username: |

Password: |

[ Remamber me on this computer Log In

Which version would you Ble to use? | Dafauk | What's This?

Ticchey o= the leader in open source messaging and collaboration o Zinbes Blog Dirkey Wi

opyright £ 20052007 Tmbea, Inc. Tirnkes' snd tha Zimbra bgos am trademacs of Zimbra, Inc.

You can change the default from your Preferences General tab after you log in.

To change the default to standard after logging in:

1. Select the Preferences > General tab.

2. Select either Advanced or Standard in the Login Options section.

in using:

Theme: | Sand -

Language: | 'Z= Englis|

i+ Adwvanced {Ajax)
¢ Standard {HTML)

nited States) +

Default Timezone: | GMT -08:00 US)Canada Pacific

3 Change Password

4. Click Save.

17
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The next time you log in, your selection will be the default.

To log in

5. Open a browser window and enter the URL provided by your Zimbra
administrator.

For example:

http://mail.domain.com/zimbra/mail

6. When the login screen appears, type your user name. You may be required to type
your full email address as the user name and your password.

Example of a full email address, type:

myra@example.com
myral23

Your password displays as ****** on-screen, to protect your privacy.

To be remembered on this computer until the session expires or you log out, check
Remember me on this computer.

If you check this, you will not have to log in every time you restart the browser
during a day. When this is checked and you do not log out, your session remains
active until the session expires. The system administrator configures how long a
session is active.

Note: If you leave your web client open in your browser but do not access your
mailbox for a period of time, your session may time out and then you will need to
log back in.

If you do not want the default client type, change the version displayed.
7. Click Log In.

To log out

To prevent others from logging in to your email account, you should always use the Log Out

link to close your session.

Forget your password?

If you forget your password, contact your administrator to reset it for you.

18
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If Your Session Expires

Your system may be configured with a session time-out that automatically logs you out if your

session is inactive for a pre-configured period of time.

Your administrator may also set a maximum session length, e.g.., a maximum amount of time

that you can be logged in, regardless of whether any activity occurs or not.

Therefore, you may periodically see the login screen, even if you are already logged in. If that

happens, simply log in again and continue working.

Navigating the Zimbra Web Client

When you log in you see a full screen view similar to the one shown below. The view changes

when you use another ZWC application. This view is the Mail view.
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o Ry el oakremiBock [ Ceerde B Taeds I Cocuments Frefereroes
L . Howm Frdkior Jhem = Getpal [JOsets [F [0 ¥ Regly TiRephviodl (YRomxd [gaek ] ¢ T Vo 1-& @
v Fokders T e F AT i - I
] [ P Fral: Tobis i thet 'l el Sousmal - Feb 27
Lo Dt [ L3 [risrwiu, Sve e First Deall § 0¥ Feb D
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Lol [ Eoarvss Brown Ta sirarg Dbt sbles Pviws P I
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Refer to the following table when viewing the ZWC.

Number Description

1 Window Header. Displays the following:

Search Bar - including the Save and Advanced buttons for ZWC

searches
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Number Description

@I Help

and “JLog Out are displayed on the right

2 Toolbar. Displays the following:

Tools Tabs — click a tab to access the different ZWC tools

available for your account. In this example, Email is open.

Action Buttons — click an action button to perform a task
available for the application you are currently using. In this
example, the Email action buttons are displayed in the toolbar.

3 Overview Pane. Displays the following:
User Name - the user name under which you logged in
Quota Display — your mailbox quota

Folders — including system folders (Inbox, Sent, Draft, Junk,
Trash) and folders you created

Searches — search queries that you created and saved for future

use

Tags — any tags you have created. Click on a tag to quickly see
all messages that are tagged with that tag.

Zimlet - links that may have been created to integrate with
third-party applications from within your mailbox. Depending
on your configuration, you may not have access to Zimlets from
the Overview Pane.

Mini-Calendar — optional. You can disable the mini-calendar
using the Preferences > Calendar tab.

4 Content Pane. The content of this area changes depending on
what application is in use. In the Inbox view, it displays all
messages or conversations in your Inbox.
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Number Description

5

Reading Pane. Email messages are displayed in the Reading
Pane. In the email message shown here, you can see:

Contact Zimlet: Click a name in any email message to quickly
add the name as a contact in an address book.

Meeting Zimlet: Click a meeting or appointment in any email

message to quickly add the meeting to your calendar.

User Interface Features and Shortcuts

The Zimbra Web Client interface includes many convenient features.

[g Mew =

[-.g! Mew Emnail
g Mew Conkact

£ 4 Mew Motebook

ey, New Contack Group
E‘_ Mew Appoinkment

Down-arrow menus. Some buttons have a small down-arrow

icon next to them.

e C(Click on the button to perform one action (such as open a
new compose window).

ﬁ Tew Task
| 4 Mew Page . . .
e C(Click on the down-arrow icon to display a drop-down menu
%] Mew Address Baok of additional choices, as shown here.
E‘_ Mew Calendar
E_J_ Mew Task List

Drag and drop. Click on and drag messages, conversations, tasks, etc. between folders.

L7 D

=

L= SeEt | ! =] arah Soap

Zach Zimkra & Fimbra in the \Wall St
1

+

Movable sash. For split-pane windows such as the

i Subiect: Meeting ¢ Conversation view, you can use the sash to increase or

decrease the relative sizes of the upper and lower
panes. Click and drag on the bar separating the panes.
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Clickable items. Zimbra follows standard browser conventions by changing the mouse cursor

to a hand when it passes over an active link.

g New = ([ Get Mail| [ Tag

-

L)
alle

Check for new mail in Inbox

Tool-tips. Passing your mouse cursor over items, such
as command buttons, conversations, or email addresses
in message headers, displays a small text box of

descriptive information about the item.

= 101- Eﬂﬂ_ﬂ Paging. Use the left and right arrows in list windows to page back and
forth if the list is too long to fit into a single window. Note that the

paging buttons may behave differently on different screens. The numbers represent the
sequence of items on that page. Use the Tool-tips display to identify what the paging will do

on your current screen.

e
€
o
i

E3

Fa
=i
B
«

0
i
£
=

4

[ Junk

[ show Original

Search
Advanced Search
Mew Email

Add To Contacts

Mark As Read
Mark A= Unread

Reply
Reply ko Al
Faorward

Edit

Tag Message 3
Delete
Move

Prink

Mew Filber

Right-click menus. Right-click on items (such as folders,
conversations, messages, or items in email headers) to display a
menu of functions that you can perform on that item. This is an
example of the right-click menu on a user name in the Inbox

From column.

The menu choices displayed depend on the type of item. Right
clicking on the following displays right-click menus:

Conversations. You can mark conversations as read or
unread, apply tags to conversations, delete conversations, or
move conversations between folders.

Messages. You can reply to or forward messages, mark as
read or unread, apply tags to a message, delete a message,
move it to another folder, print, show original header
information, and create a new filter.

Names in message headers. You can perform searches on the
name, begin composing a new Email message addressed to
that person, or add the person to your personal Contacts list.
If the name is an existing contact, you can edit the contact
entry.
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5 Folders .
BB 1nbox Folder Information. If you hover the cursor over a folder, the number
B e messages in the folder and the size of the folder are displayed.

Messhoes: 3089 . . . .
Stze: s1%s | Applying an Action to Multiple Selections

When you view a folder by clicking on the folder name in the Overview pane, the contents of
the folder display with one item selected (highlighted). You can select one or more items to

perform actions as follows:
e Click to select one item at a time. Click on another item to de-select the previous one.
e Double-click to open an item.

¢ Right-click an item to display a menu of actions that can be applied to this item. You
can also right-click after selecting multiple items, to apply the same action to all of

them at once.

e Control-click selects multiple items. Can also be used to de-select the current item,

leaving nothing selected.

e Shift-click selects multiple items in sequence. Click on one item and then Shift-click
another item further down the list. All items between the two selected items are
highlighted.

You can select multiple items, and with one right-click, choose to Mark as Unread, Tag,
Delete, or Move all selected items.

Zimbra Assistant

Zimbra Assistant is an advanced user feature that provides a quick way to interact with the
ZWC using the keyboard to do the following tasks:

e Create new appointments

¢ (o to a specific date in your calendar

e Create new contacts

¢ Send a new Email message without changing the application you are currently using

You can open Zimbra Assistant from any ZWC view except the Preferences tab.
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The keyboard shortcut to open Zimbra Assistant is * (back quote) or shift~ (tilde) |- The
tilde key can be found below the Escape (Esc) key.

Wy
.‘q‘ .' Shift ~ (tilde) does not work when using Safari or Firefox from a Mac OS X. The
-'l '. back quote () does work.
*unt

To use Zimbra Assistant:

1. Use a shortcut key (either the back quote or shift tilde) from within the ZWC to
open the Zimbra Assistant dialog.

Zimbra Assistant

Enter Command:

available commands: appointment, calendar, contact, mail, map, task

Help Cancel

2. Click Help for detailed help on Zimbra Assistant.
3. Enter one of the following commands into the dialog:

0 To create an appointment, type appointment. You can then enter a subject in
quotes, the time, a date and day of week, and any notes for the appointment.
Click OK.

Note: If you want more advanced appointment features, click More details to
go to the Calendar Appointment page.

0 To go to a specific date in your calendar, type calendar and the date, or the day
of the week. Click OK.

Note: After the date you can enter the Calendar view you prefer: day, work
week, week, or month. The Calendar opens in that view.
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0 To create a new contact, type contact and enter the contact information. Click
OK.

Note: If you want to open the Contacts detail form, click More Details. Use this

form to specify which address book you want to add the contact name to.

0 To send an email without opening a compose window, type mail. Enter the
subject in quotes; type to:name@address; and then type the body of the
message. Click OK.

ZWC Keyboard Shortcut Keys

Shortcut keys can be used to navigate in the Zimbra Web Client (ZWC) and you can create
your own shortcut key combinations. Use the Preferences > Shortcuts tab to see the list of
shortcut keys and to create your own shortcut keys. The four Shortcuts tabs display the
following;:

e Shortcut List includes a list of shortcuts for all applications.
e Email Folder Shortcuts lets you create and assign shortcuts to access email folders.
e Saved Search Shortcuts lets you create and assign shortcuts to your saved searches.

e Tag Shortcuts lets you create and assign shortcuts to tags that you have created.
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2 Receiving and Managing Email

This chapter explains how to...

o Customize your email page

o Navigate the email views

. Receive and read email messages
o Organize email messages

Customizing Your Initial Email Page

By default, your mailbox opens with the Inbox view. In this view, all messages in your Inbox
are displayed in the Content pane. You can change the initial view to be any of the folders,
searches, or tags in the Overview pane. Change your initial view using the Preferences > Mail

tab.

To display only specific messages when you open your mailbox, use the Default Mail Search

field on the Preferences > Mail tab.

Display: | 25 -

Group mail by: | Conversation
Check for new mail every: | 5 minutes |

Display Mail * As HTML {when possible) (&5 Text

Message Preview: " Display Message Feading Pane
I Display snippets of messages in email lisk
[ Double-click opens message in new window

Images: | Download pictures automatically in HTML Email

\
E Default Mail Search: | insinbim; )
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Here are some examples of how you can display only specific messages when you open your
mailbox:

e To display only unread messages, type is:unread in the default mail Search field.

e To display messages that are tagged with specific tags, type tag:<tagname> in the
default mail Search field. For example, to display only messages marked with the
ToDo tag, type tag:ToDo. Tags are covered in Chapter 4.

e To display messages that you sent to a specific folder via an email filter, type
in:<foldername> in the Default Mail Search field. For example, to display messages
in the Work folder, type in:work. Filters are covered in Chapter 5.

Wy
.‘q‘ % Use quotes if the folder or tag is more than one word. For example in:"Unread
' @ . a1
Email.
". . ".

Email Views

If you receive a few email messages a day, you probably can quickly view the content of your
mailbox to find the message you are looking for, but if you receive dozens of email messages a

day, you may want to group them to more quickly find what you are looking for.
Your ZWC mailbox offers two options for viewing the messages in your mailbox.

Message view. Messages can be displayed in the Inbox by date. This is the traditional message
view, where messages received today display the hour received, messages received in
previous days show the date received.

[] | F "] | %| Fram | & | subject | Folder | Size | Received T
1 E| Zimbra Team Read Me First! Important Demo Account Information - Welcome o Zimbra O Inbox ] Feb 08
1 Sam Sample Re: Flight Plan - Hi Dan, I'll be arriving on UA 852 or ACA 4196 in the mornine Inbox 4KE 12}28i2007

Conversation view. The Conversation view displays your messages grouped by subject, as
shown below. Because all messages in a conversation have the same subject, the subject
displays only once in the conversation view pane. All messages related to the conversation are
displayed, even if they are stored in different folders.
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[ ] | [ 3 | ﬁ E Q | '—E‘)| From | §| Subject | Folder | Size | Received T
1 = E Yahoo ... Kevin RE: ¥ahoao! Metwork Division All Hands - 2719 & 2/21 - MAR} (30 Feb11

1w Jeremy Johnstone Re: Cascade setup docs? - Mevermind, Found a more up to (2) Febo9

- Sean, articles Re: Reviewed articles - [ will copy edit these three articl (2} 9/5/2007

[ o] articles I will copy edit these three articles and then : personal 2 KB 9/5/2007 ‘
O Sean Gallagher I've reviewed the Following articles and they're techn personale 2 KB 8/30/2007

Parts of the Content Page View

Each message, in message or conversation view, has a separate line that displays the following

columns of information.

Clie | 9 (80 5% From &9 | subject Folder | Size Received ¥

e Check box. Use the checkbox to select one or more messages to perform the same
action on, such as delete, move, mark as read. Check the box in the header will

automatically check all the messages on the page.

e Conversation indicator. Is this email part of a conversation? If * is displayed, the

message is part of a conversation.

¢ Flag indicator. Did you flag this message to indicate an action-needed item or to
otherwise distinguish the message or conversation from a larger number of other items
of lesser importance?

e Priority indicator. Did the sender mark this message as high priority?
e Tags. Did the message get marked by a Tag you defined?

e Status. Open or closed envelopes indicate whether a message has been read. Bold text

also indicates that a message has not been read.
¢ From. Name or email address of the sender.
e Attachment indicator. A paper clip indicates that a message has an attachment.

e Subject. Brief description of the email message. If Snippets is enabled in your account,
the first line of an email message is displayed.

e Folder. Shows the name of the folder where the message is located. For conversations,
no folder name is displayed because messages can span multiple folders. When you
open the conversation, this column displays where the message is located.
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e Size. Size of the message or number of messages in the conversation.

e Received. Date or time the message was received.

How Do Conversations Work?

The Conversation view displays your messages grouped by subject, as shown below. Because
all messages in a conversation have the same subject, the subject displays only once in the
conversation view pane. All messages related to the conversation are displayed, even if they
are stored in different folders.

The number of messages in the conversation is displayed in parentheses in the Size column
(after the subject). Each conversation consists of the original message and all replies.
Conversations containing unread messages are shown in bold.

[ | > | F E D | '—T&')| From | & | Subject | Folder | Size | Received
1 - Donna, Sam Re: First Draft - Hi Sam, Todd pushed out the deadline fo (3) Febze
[ || Donna Brown Hi Sam, Todd pushed out the deadline for the Inbox 2 KB Feb 26
[ = Sam Sample Donna, I plan ko review the first draft that afternoon Sent 868 B Feb 26
[ @ Donna Brown Hi Sam, My first draft of the training materials will be  Inbosx ] Feb 26

Messages in a Conversation

You can read messages grouped together in context and ordered by date, including replies
and forwarded messages. Messages grouped in a conversation have the same subject.

For example, the following subject lines would be considered part of the same conversation.
Who"s i1n charge of the project?
Re: Who"s in charge of the project?

Fwd: Who"s in charge of the project?

If you change the subject to who's in charge of the project? - ask Mike, the message would
not be included in this conversation.

Conversations do not continue indefinitely. If the last message in the conversation is 30 days
old or older, messages sent with the same subject begin a new conversation.
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Conversations Can Span Folders

If a conversation includes three email messages, one of those messages could be in your Inbox,
your reply (which is also part of the conversation) will most likely be in your Sent folder, and

another message could be in a custom folder.

If you search for email messages and one message is found that matches your search, but that
message is in a conversation with several other messages that do not match your search, the
entire conversation and all messages within it are listed under the search results. When you
open the conversation, only messages that match your search criteria are highlighted.

The same conversation may appear to exist in more than one folder. This can happen if the
email messages are in different folders, either because you moved them there, or you applied

a filtering rule that put them there when they were received.

Because a conversation is a group of related messages, if you move a conversation from one
folder to another, all messages within that conversation are also moved to that folder. Sent

messages, however, are not automatically moved. They remain in your Sent folder.

Reading Email
To read an email message:
e Using Message view.

0 If you have the Reading pane on, click on a message to display its contents in the

Reading pane.

0 If you do not have the Reading pane on, double-click on a message to display it

in a separate window.

e Using Conversation view. Click the arrow in the conversation row containing the

message.

%:] Sean, articles Roe: Reviewed arbiches - [ ol copy edt theos thees stic {2} 9/5/2007

The Content pane changes to show the individual messages in the conversation. The
Subject column shows the first line of the message body.

0 If you have the Reading pane on, click the line that contains the message you

want to read. The message body appears in the Reading pane.

31



Z Zimbra Web Client User Guide

0 If you do not have the Reading pane on, double-click the line that contains the
message you want to read. The message body will fill the Content pane.

The Reading Pane

The Reading pane is the area below the messages in your Inbox.

If you have the Reading pane on, when you click on an email message, the message displays
in a pane below the message header information, and the message is marked as read. To
adjust the size of the Reading pane, click and drag the divider bar up or down.

By default, viewing messages in the Reading pane is on.
To turn the Reading pane off:

e For this session only—Click the arrow next to View on the toolbar, and select Reading

Pane.

[ Wiew =

D\] By Conversation
@ [ By Message

v E Reading Pane

e For the default view—Use the Preferences > Mail tab. Uncheck Display Message
Reading Pane.

Display: | 100 =
Group mail by: | Message -
Check for new mail every: | 15 minutes «

Display Mail & AsHTML (when possible) ¢ As Text

Message Previeps

MESSage in new window

Images: W Download pictures automatically in HTML Email

Default Mail Search: | intinbox

32



Receiving and Managing Email Z

If you have the Conversations view feature, the default view is conversation.
#4p?* Tochange views:

e For this session only - Click the arrow next to View on the toolbar, and select the view

you want. The Reading pane option toggles the Reading pane on and off.

e For the default view — Use the Preferences > Mail tab.

Displaying HTML in Email Messages
You can view email messages in two formats:

e Plain text. Plain text messages are messages that contain no HTML formatting code.
Messages sent in plain text can always be read by other email clients. You can view
messages in plain-text mode even if it contains HTML. The HTML tags are displayed
in the body of the message in the plain text view.

e HTML. HTML messages can have text formatting, numbering, bullets, colored
background, and links which can make messages easier to read. Some email clients
may not accept messages formatted in HTML.

To always view your email messages in HTML:
1. Use the Preferences > Mail tab.

2. Check Display Mail As HTML (when possible).

Display: | 100 =
Group mail by: | Message -

Check for new mail every: | 15 minutes |

Display Mail & s HTML {wmpussyle]l  As Text

\/

Messages will now be displayed in formatted layout, if they were sent in HTML.
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Parts of an Email message

An email message is shown below.

Subject: Zimbra in the Wall Street Journal
¥ Sent By s Dan Demaouser On: March 3, 2008 4:15 PM

To: ssample@demo, zimbra, com
Attachments :Feg Zimbra_ws1.pdf (123,9 KB, download)

From: Zach Zimbra

To: 203z3k60@demoz. zimbra. com

Sent: Sunday, November 25, 2007 114426 AM GMT -08:00 US/Canada Pacific
Subject: Zimbra in the Wall Street Journal

Hey Dan,
Did wou ever check out this article that the Wall Street Journal ran on Zimbra? It (Chramicle ;
was a front page article. 1

i

(T | B

A ZWC email message has two main sections:

1. Header. The message header contains information concerning the sender and
recipients, including the following information:

0 Subject. Description of the topic of the message. A subject line could be
something like 2007 company mission statement or, if your spam filtering
application is too lenient, Lose weight fast!!! Ask me how.

0 Sent By. Sender’s name and/or email address. This is the email address that

becomes the recipient if you click TAReRl. 1f the sender has specified a
Reply-to address, your reply will be sent to that address instead.

0 On. Date and time the message was received.

0 To. Name and/or email address of the email recipient (where the message

was actually sent).
0 Attachments. Any files that were included in the email message.

Body. The body of a message contains the content of the email. The message body
also may include signatures or automatically generated text that is inserted by the
sender's email system.
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Viewing an Attachment
Email messages can include attached files, such as the following:
e Word processing documents
e Spreadsheets
o Text files
e .zip files
e Images (.bmp, .jpg, etc.)
e Executable applications

e Any other type of computer file that resides on the sender's computer network

Messages containing an attachment have an icon displayed next to the subject.

Some types of files, such as JPEG images or text files, can be opened on almost any computer

system. Others, such as Microsoft Word documents, must be opened using the same
application that created them.

To view an attachment, click on either the name of the attachment or the download link.

Subject: Fwd: Zimbra in the Wall Street Journal
¥ Sent By: gy "Dan Demouser” <127kngif@demoz. zimbra.com> On: February 27, 2008 5:47 PM

P
Lo eI 2T <. LT

Seachgnts - Zimbra_WS.pdF (123, KE, download) >

External images are not displayved. Display Images

In an effort to prevent abuse, you may only send to one person at a time. --The Zimbra Team

Sincerely,
Dan Demouser
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e Click the name of the attachment to open the attachment (if you have the correct

application available).

e Click the view as html link (if it is displayed) to open the attachment even if the
application is not installed on your network. This feature is set by your administrator.

e C(lick the download link to open a dialog prompting you to open or save the file.

Dpening Zimbra_WSs1.pdf ﬂ

vou have chosen to open

%) Zimbra_WS1.pdf
which is a: Adobe Acrobat 7.0 Document
from: http:/demo?.zimbra.cam

‘What should Firefox dao with Ehis File?

i | Adobe Reader 7.0 (default) j
{~ Save ko Disk

™ Do this automatically For files ke this From now on,

(874 I Cancel |

If you choose Save to Disk, a browse dialog appears showing your file system. Choose a
location and save the file. You can then open the file outside of your email client.

Marking an Email as Unread

The Zimbra Web Client (ZWC) marks messages that you open as read. Conversations
containing unread messages are shown in bold.

To change a message's status back from read to unread:

e Right-click the message.

e Choose I@Mark.ﬁ.s Llnreau:ll

You can also mark a conversation as unread.

e Marking a conversation as unread marks all messages within that conversation as

unread.

e Marking a single message as unread marks the conversation that contains the message

as unread.
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To change a message or conversation status back to read, do either of the following:

e Open the message or conversation.

|_:J. Mark As Read

¢ Right-click the message, and choose

Virus Safety

Computer viruses can spread through email attachments. It is standard practice for Email
administrators to implement virus filtering for incoming Email as well as virus scanning for
personal computers. However, there is always a chance that a virus could get through.

Many email viruses are activated when a file attachment containing the virus is opened or
viewed. Many of these viruses have been known to spread themselves using entries in users'
address books. Therefore, use care when opening file attachments, even from senders who
you know.

Printing an Email Message
To print an email message:

1. Click on the message you want to print.

2. Click = in the toolbar. A standard print dialog appears.

3. Choose a printer.

. oK . .
4. Click The message is sent to the selected printer.

.y
g % Do not use the browser's File > Print feature. The page will not be well-

,.' formatted, and your message may be difficult to read.
st
To print a conversation (all messages):

1. Right-click the conversation to be printed, and select Print. You must be in
Conversation view.
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» Donna, ~-—" b
Donna B L Mark As Read

Oo0Oo0Ooind

Donna E Mark As Unread
Daorna E
DonnaE 0 Reply

23 Reply to Al

£ Forward

% Accept v ? Tentakive + (] TagMessage  »

Subject: Staff Meeting T Delete

¥ Sent By: 2. Donna Brown On

To: "ssample” <sségole@ (= Prink Jhn >

The following is ane [gunk
Showe Criginal

Subject:  Staff Meeting Mevy Filker

Two windows appear:

¢ One window, as shown below, shows all the messages in the conversation in a single

scrolling window, and the total number of messages to be printed is displayed at the

top.

Zimbra Collaboration Suite ssample@demo.zimbra.com

Re: First Draft

3 messages

Re: First Draft Tuesday, February 26, 2008 8:10:33 PM

From: dbrown@demo zimbra com
To: ssample@demno. zimbra. com
Hi San.
Todd pushed out the deadline for the first draft, so let's move our meeting out a day
Donna
————— Original Message —————
From: "Sam Sample’ <ssample@demo.zimbra.com>
To: "Donna Brown" <dbrown@demo.zimbra.com:
Sent: Tussday, February 26, 2008 8:06:05 PM GHT —08:00 US-Canada Pacific
Subject: Re: First Draft
Donna,
I plan to review the first draft that aftsrnoon. so sverything will be ready in time for our mesting
Look forward to it,
San
————— Original Message —————
From: "Donna Brown" {dbrown@demo.zimbra.com>

To. “ssample’ <ssample@denc.zimbra.com
Sent: Tussday, February 26, 2008 8:03:41 PM GHT —08:00 US/Canada Pacific

e A standard print dialog. In the print dialog;:
8. Choose a printer.

9. Click OK. The message is sent to the selected printer.

10. Close the window.
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Organizing Email Messages Using Folders

ZWC provides the following methods for organize email messages. You can use these along

with the Search feature to quickly locate and retrieve messages.

e Folders. You can create folders to organize your messages, and you can move email

between folders. Use of folders is covered in this chapter.

e Filters. In the Preferences > Mail Filters tab, you can create rules for classifying

inbound email according to items in the subject line, sender, recipient, or other

characteristics. Filters are covered in Chapter 5.

e Tags. You can use tags as labels on email messages and then use the Search feature to

show all email with a certain tag. Tags are covered in Chapter 4.

Mail System Folders Overview

The mail system folders are Inbox, Sent, Drafts, Junk, and Trash. You cannot move, rename,

or delete these folders. System folders are always displayed at the top of your folder list,

followed by any folders you create.

Refer to the following table for more information on the ZWC mail system folders.

Folder Name

Description

Inbox New email arrives in the Inbox. Your Inbox is displayed by default
after you log in.

Sent A copy of each message you send is saved in the Sent folder.

Drafts Messages you have composed but have not sent can be saved in the

Drafts folder. Messages are automatically saved to the Drafts folder
as you compose. If you navigate away from an unsent message, you
will be asked if you want to save the message as a draft.
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Folder Name | Description

Junk Most filtering of unsolicited automated email (also known as spam or
junk mail) is handled by a spam filter before those email messages
reach your Inbox. Email that might possibly be junk mail, but isn't

certain to be junk, may be placed in your Junk folder.

You can review these messages and either move them or delete them.
If you don't delete them, they will be purged after a period of time, as

specified by your administrator.

Trash Deleted items are placed in the Trash folder and remain there until
you manually empty the trash or until the folder is purged
automatically. Email is purged from this folder after a specified

period of time, as specified by your administrator.

‘i.#‘ If your email account was migrated from another email system,

: > : such as Microsoft® Outlook®, you may see extra folders that represent folders
‘*.?;" from the previous email system.

Sharing Your Mail Folders

You can share any of your mail folders, including the Inbox folder and sub-folders. You can
share with internal users who can be given complete manager access to the folder or only the

ability to view the folder.

When internal users share a mail folder, a copy of the shared folder is put in the Grantee's
Folder list on the Overview pane. When the folder is selected, the content displays in the
Content pane. You do not need to log on to the Grantor's mailbox.

Scenarios for sharing a mail folder

¢ Your sales department wants one central mailbox for all email messages requesting
information about your product, and everyone in sales should be able to view
email messages immediately when they come in. You can give everyone in the
department permission to view the mail folder and they can copy the messages to
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their mailbox, or you can give them permission to manage the mail folder and they
can reply on behalf of this address.

e A manager is often out of the office and does not have time to respond to her email
messages. When the manager delegates access to her Inbox mail folder, her
assistant (grantee) can manage the content of her mail, respond to messages on her
behalf, create folders to organize message in that mail folder, and delete messages.

e Instead of sending email messages to dozens of addresses every time you have an
announcement, you can identify one of your folders as a public folder that contains
the email announcements. You can create shared access to only specific email
addresses and set a password that must be entered to view the content, or you can
make it a public URL for anyone who has the URL can view the content.

To learn how to share your mail folders, see Chapter 15, Sharing Your Account Items.

Moving Email Messages

You can transfer email messages or entire conversations from one folder to another using one
of two methods:

e Drag and drop the item to the desired folder in the left-hand Overview pane.

=

E;?) Senkt I 1 5] arabh Soan
B or By Zach Zinbra &7 Zimbra in the Wil St
2 | |

ﬂ' Move

e Select the item(s), right-click, and select . The Move Message dialog appears.

Move Message

Select the destination folder

¥ Folders

EE| Inbox

E-V Chats

B3 sent

Ea Junk.

ﬁ Trash

Zach's Forum Posts
& Zimbra Blog RSS

Mew | Ok | Cancel |

e Select a destination folder, and click OK.
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If you are moving a few messages within a conversation, the conversation appears in both
places. The Conversation Detail View window shows the new location of the message that
was moved.

Sorting Messages in the Content Pane

Any pane containing email messages, such as your Inbox, can be sorted by the From, Subject,
and Received columns. Sortable columns are highlighted as you pass your mouse cursor over
them.

To sort by a particular column, click the column title. The column shows an arrow indicating
whether the sort is in ascending order (up arrow) or descending order (down arrow).

You can only sort by one column at a time.

Deleting a Message: The Trash Folder

When you delete a message, it is moved to the Trash folder.
To recover a deleted message:

e Drag and drop the message from the Trash folder into another folder.

-

=l

i
a

EamEiaiple [-IMail | &k AddressBook | [] Calendar @ Tasks | E | Documents Preferences
E"‘_ New Folde [ gMew ¥ | Get Mai [ Delete _*5 [=1 | =5 Reply 7 Replytoal = Forward @ Junk il W D\) Wipw w0 1-14 o
=8| | > | F A | '—7§)| Fram | & | Subject | Folder | Size: | Received

o ] Dan Demouser Flight Plan - From: Dan Demouser Ta: 20323kE0@demo2. Mar 03
End-L@"roject Dan Demouser Dan, Danfwd: Flight Plan - FromgZEapgampial giw iz kel Sdemodambra cam s Mar 035y I\‘{Er 03
EE‘) Sent (] Dan Demouser Fwd: Flight Plan - From: Sam Sarmple To: 203z23k60@derm: Mar 03
E} Drafts {1} (| Donna Brown Pickup - Hi Sam, Can you pick me up from the airpart 3710 Feb 26
% Junk, 0w Donna, Sam Training Deliverables Review - The Following is a new mee (2) Feb 26
Trash — - - —raa s ITI.“ P— . . . —_—

In the example above, the message from Dan Demouser is being dragged from the Trash
folder into the Inbox folder (highlighted in Folder pane).

Purging an Email Message from the Trash Folder

You can purge messages in Trash, which means the messages are permanently deleted and
cannot be recovered.

To purge or delete messages from Trash:

e Right-click on the Trash folder and select Empty Trash. All messages are permanently
deleted.
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¥ Folders -
¥ Laﬁ Inbox {7)
End-User Praject

EE') Sent

E/} Drafts (1)

EB Jurk.

ﬁ Trast

Parsi m_ Mew Folder

Mark &ll as Read

¥ search
Delete
m Powe
({28l Rename Folder
¥ Tags
[ave
Q End-l
Edit Propetties
4 |

Expand Al

L. | Iy
s mCT @Emptv Trash

Automatic Purge

Your administrator sets the policies for your site regarding how long messages remain in your
folders before automatic purge occurs.

Managing Junk Email & Spam: The Junk Folder

Most filtering of unsolicited automated email (also known as spam or junk mail) is handled

by a spam filter before those email messages reach your Inbox.

Email that might possibly be junk mail, but is not certain to be junk, is placed in your Junk
folder. You can review these messages and either move them out of the Junk folder or delete
them. If you don't move or delete the messages, they are purged after a number of days as
specified by your administrator.

Spam

If you find that you are receiving a large number of unwanted email messages, often referred
to as spam, contact your administrator. Reporting email as spam helps your email
administrator to fine-tune any spam filtering that may be in use at your site.

Marking an Email as Junk
To mark an email as junk:

1. Select the message in your Inbox.

2. Click L@ dunk on the toolbar.
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The email is moved to your Junk folder.

Sometimes messages may be put in the Junk folder that are not really junk mail. Drag those
messages to another folder.

To empty the Junk folder:

1. Right-clicking the Junk folder and select Empty Junk.

¥ Folders -
¥ EE. Inbox (7)
End-User Projeck
EE') Sent;
E:/; Drafts {1}

Ea Junk
ﬁ Tre Tew FD|\£D

Fe Mark &ll as Read
¥ Seam Delete

m pg Uzt Rename Foldsr
¥ Tags Maove

D En Edit Properties

A Expand All
“« 4 @ Ernpty Junk

The contents of the Junk folder are automatically purged after an administration-configured

number of days. Contact your administrator to find out how often your messages are purged.
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3 Composing and Sending Email

This chapter explains how to...

e Compose a new email message

e Add attachments to messages

¢ Reply to email messages

e Forward email messages

e Configure optional email features

e Set up email signatures

e Set a forwarding address

Composing a New Email Message

The ZWC uses standard email functionality with several enhancements. Using the ZWC, you

can take advantage of the following features:

Use automatic address completion to complete addresses for you (from your Address

Book contacts) as you type into the To, Cc, and Bcc fields.
Attach one of the many file types supported by the ZWC.

Create custom signatures for use in your email messages.

To compose a new email message, either:

[ gl Mew -

Click on the toolbar.

Right-click on a sender (in the From column) in the Inbox, and select

A blank compose page opens.

[ g Mews Email
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[AMal 2k Address Book | [ Calendar @ Tasks | &[] Documents Preferences

[-15end 3% Cancel E} Save Draft &2 Add Atkachment ag Spell Check, Options ¥

To: |
Cco |
Priarity: -

Subject: |

Depending on your email preferences, the blank compose page opens in the Zimbra content

pane (as shown above) or opens as a separate compose window.

To complete the email:
Enter the email address of the person or persons to whom you are sending the
message in the To and Cc fields. Either type the address into the field, or click

Tos
4 to search through your contacts or the global address list.

Add Bec addresses (if necessary) by clicking Options > Show BCC Field on the

1.

compose toolbar.

Opkions -
44 Format As HTML
|:‘| Format As Plain Text

@

3. Enter the subject of the email in the

Subject:

field.

4. Type the body of the email in the text area below the formatting icons.

From the compose toolbar:

5. Click A2 Spell Check to check the spelling in the message.
6. Click el vt to add an attachment.
7. Click L=} {4 send the email.
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8. Click | L 3ave Draft | to save the message as a draft (to send later). The message is
saved in the Drafts folder.

0 To retrieve a draft, open the Drafts folder and click on the message. You can

compose and send the completed message as normal. When sent, the message is
removed from the Drafts folder.

9. (lick |=] Signature

to select a signature you have defined for use in this message.

0 Creating signatures is covered in the Optional Email Features section.

+*"¥, Ifyouhave more than one email identity (also known as a persona) configured,
: % : a From drop-down list will be displayed. Choose the identity to use for this
'4. -11. message from the From drop-down list. More information on email identities

and personas is provided in Chapter 6, Customizing Your Email Features.

. . If you supply a first and last name that is not in the form of a valid Internet
. : address (name@domain.com), a confirmation dialog appears advising you that

the address does not appear to be valid. You can choose to send the email
anyway, even though it may not be deliverable.

Cc and Bcc Addresses

The abbreviations Cc and Bcc stand for Carbon Copy and Blind Carbon Copy, respectively.

e Cc. Lets you send a copy of a message to someone who's interested but is not the

primary recipient. All Cc'ed recipients see the entire list of addressees when they read
the message.

e Bcc. Lets you send a copy of an email message to someone without their address
appearing in the copies of the message sent to other recipients.

You can send a message without any addresses in the To field, as long as there is at least one
address in either the Cc or Bcc fields.
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Using HTML Editor

You can compose your messages using HTML as the rich-text editor. Messages created using
HTML can have text formatting, numbering, bullets, colored background, tables, and links

which can make messages easier to read.
To quickly change the format for this message only:

e C(lick Options > Format As HTML to format your message with different font styles,

tables, color, etc.

e C(lick Options > Format As Plain Text to produce text with no style or formatting.

4[5 Format As HTML
~J_Format As Plain Texe

Shove BCC Field

You can set the HTML editor as your default editor and set the default font settings (including
style, size and color) using the Composing Messages area of the Preferences > Composing

tab.
@t: Yerdana = |Size: | 12pt - |%>
Pl 7Y I _
a® u Some email clients may not accept messages formatted in HTML.
]
. ¥
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Using Spell Check

To check the spelling of your message:

1. Click aﬁﬁpell Check,

on the toolbar. Words in the email message that are unknown
to the spell checker are highlighted.

ag Resume editing | Check again

Hellao,

I hope you reemember to Spell Check your email,

Sincerely,
Can Demouser

2. Right-click on a highlighted word. A drop-down menu displays suggested
corrections.

ég Resume editing | Check again

Hello,

I hope you reemember to Spell Check yvour email.

remember
. remembers
Sincerealy, b
Cran Cen

renumber

3. Select the correct word. The word is highlighted in another color.

a‘g Resume editing | Check again

Hello,

Sincerely,
Can Demouser
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4 Click aﬁ Resume ediking

at the top of the body to accept your changes and close the
spell checker.

»
.‘a.‘; Before you close the spell checker you can change a corrected word back to the
]

- ,.' original spelling. Click on the highlighted word and select the initial spelling

Gan from the top of the pop-up.

Adding an Attachment

Email messages can include attachments. You can attach documents, spreadsheets, pictures,
slide shows, and other types of files.

To attach a file to a message:

1. Compose the email message.

& add Atkachment

2. Click . The Attach File(s) dialog appears.

Attach File(s)

My Camputer Flickr Phatas

Attach File 1:| Browse... |

Attach File 2; | Browse. .. |w
Attach File 3 | Browse. .. |w
Attach File 4: | Browse... |Rem0ve
Attach File 5 | Browse. .. |w

Add Mare Attachments

[T shaw images in message body

Attach Cancel

3. Click LI5S to locate the file.

4. Select the file and click Open. The file name appears in the Attach File 1 field.

add More Attachments |

5. Click to attach another file.
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6. Repeat steps 3 and 4 for each attachment.

Attach
7. Click ﬁ . The compose window appears with the attachment(s) in the
header.

Click =989 6 send the message and the attachment(s).

". v, Recipients of your email message must have the appropriate software to open and
" 2 read the file. For files created in commonly used packages such as Microsoft Office,

> 4
n
1‘ @;g' other users on a typical desktop system will be able to open them. Common file
ol formats, such as text files, HTML files, and images such as GIF or JPEG files, can be

opened in a variety of programs.

Attachment File Types Supported

You can attach any file on your file system that you can find using M.

You can open any file attachment directly from the ZWC, provided that you have the right
application and the extension is not blocked by your administrator. For example, to open a
document created using Microsoft Word, you must have Microsoft Word on your computer.

On most computers, the file type is indicated by the extension, which is usually a period
followed by a three-letter code. Examples could include files such as expenses.xls or New-
Items.doc. If the file type is one that is supported by the installed software on your computer,
you can typically double-click the file and your computer will automatically launch the right
application for reading that file.

Many types of files can be opened directly from your browser using various plug-ins. Usually,
if you click a file link on a page, your browser automatically detects whether or not you have
the right plug-in and prompts you to download it. Note that your system administration
policies may not permit end users to download and install any sort of software.

On Windows computers, the computer assumes that the file type in the filename matches the
actual format. Even if the file is correctly formatted internally, if it does not have the right file
type extension in the filename, your computer may not be able to recognize it and open the
right application.

An increasing number of computer viruses have been designed to spread via file attachments.
Therefore, in some environments, system administrators have opted to block incoming email
containing certain types of attachments, most notably files with the extension .EXE or .ZIP as
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part of their filename. If you send an email message to someone whose email system has been
configured to block certain types of attachments, you may not receive any notification if the
email was blocked.

For your reference, here are some widely used file extensions:

File Extension | Description

Axt Indicates a text file, which is a file containing only text

information.

Text files can be opened and read using a wide variety of
text editors, including Notepad, WordPad, Word,
command-line editors, browsers, and even spreadsheet

programs.

htm Indicates an HTML file, a special type of text file that is
usually opened using a Web browser.

Zip Indicates a file that has been compressed using ZIP

compression.

You will need WinZip or another compression program that
can read and expand the ZIP file.

.exe Indicates an executable or program file.

Double-clicking or opening such a file usually launches the
application.

.doc Indicates a Microsoft Word document file, which can be
opened with Microsoft Word or OpenOffice.

jpg Indicates a graphical image in the JPEG format.

You can open JPEGs in a browser or by using one of a
variety of graphics programs such as Paint or Adobe
Photoshop.

gif Indicates a graphical image in the GIF format.

You can open GIFs in a browser or with a graphics program.
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.mpg Indicates a movie clip or animation in the MPEG format.

MPEGs are often playable with a browser plug-in or a
player such as Windows Media Player.

wmv Indicates a movie clip in the WMV format, which is a
Windows-only format.

pdf Indicates a document in PDF format.

You can typically open it from within your browser using

an Adobe plug-in.

Automatic Address Completion

The autocomplete feature suggests names as you type into the To, Cc, and Bcc fields in a new
message. A list of possible addresses from your contacts list that start with the text you typed
is displayed.

As you continue to type into the To field, the list of matching addresses becomes smaller as
fewer matches are available. The list disappears if there are no matches.

The autocomplete feature matches the text you type against the following:
e First name
e Last name
¢ Email address

For example, you want to send an email message to David Brinks, whose email address is
dbrinks@acme.com. When you type D into the To field, a list appears showing all possible
matches, with the matching portions highlighted. In this case, it might display:

e Dale Edwards <ded@acme.com>
e David Brinks <dbrinks@acme.com>
e Erica Dodd <erica878@xyz.com>

As you type more characters into the To field, the list of matches grows smaller. To continue
the previous example, when you type Da into the To field, the list would display:
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e Dale Edwards <ded@acme.com>

e David Brinks <dbrinks@acme.com>

Using Autocomplete

When your text matches one or more of your contacts, the matches are displayed in a list
below the field you are currently editing. By default, the first match will be highlighted.

Several keys you can type trigger special behavior. The mouse may also be used to select a

match.

e The comma, semicolon, Return/Enter, and Tab keys all trigger completion. The text
you have typed will be replaced by the currently selected match.

e ESC hides the list.

e The up and down arrow keys change the selection in the list. Moving the mouse cursor

over the list also changes the selection.
e Clicking the mouse on a match selects it for completion.
To use a single key to quickly enter an address:

9. Type a few characters that will cause a certain contact to be the first match. For
example, type s to cause <Sam Sample> to be the first match.

To: |5

= |’ AL Sam Sample <3am Sample =
: 4L Sarah Soap «Sarah Soap=
10. Press a quick key. For example, press Enter or the semicolon. The address appears.

T | "Sam Sample” <Sam Sample=;

Saving Your Work

The Zimbra Web Client is a graphical user interface (GUI) that includes windows, buttons,
and text entry fields.
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With a GUI that uses Internet browser technology to display and operate the user features, it is
not always possible for the application to detect when you have done something that you

might want to save.

Within the ZWC, the following rules apply:

e If you are in the middle of composing an email message, and you click another portion
of the Zimbra screen, you are prompted to save your work. You can subsequently find

the message in your Drafts folder.

e Emails you are composing are periodically saved to your Drafts folder by default.

Your administrator sets the frequency of the auto-saves.

Saving Messages You Send: The Sent Folder

By default, a copy of every email you send is saved in the Sent folder. You can delete email

from the Sent folder at any time.
To change the default to not save a copy of messages you send:

1. Select the Preferences > Composing tab.

Compose: . A<HTML Font: msiz:: 127t ~ | Color: | A W ~

" AsText

I Always compose in new window

[ automatically save drafts of messages whie you are compasing

Reply / Reply All: then replying to an email:

Include criginal message -]

Forward: When forwarding an emails

Include original message -

Prefin: Prefix included messages with:

— e —
Sent Messages: (¢ Sawe 3 copy ko Sent Folder
"~ Do not save sent messages.
Addl mposing options can be set on the Accounts V

Select Do not save sent messages in the Sent Messages area.

[ save

2. Click
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Replying to an Email Message

You can reply to the sender of a message or you can reply to the sender and all recipients of

the message.

o
ZIREBY | Click this button in the toolbar to open a new email compose window with

the To field populated with the name of the person who sent you the original message.

= Reply to Al

Click this button in the toolbar to open a new email compose window

with the To, Cc, and Bcc fields populated with the names of all recipients of the
original message. Use this option if you want everyone who received the original

message to receive your response.

Both options include the body of the original message in the reply. However, attachments

from the original message are not included in the reply.

Depending on how you set your user preferences, the text from previous messages may have
a character showing the number of previous exchanges that have occurred since this text was

written.

For example if the reply is part of an ongoing conversation, and you have the option Include
original message with this prefix set to use the > character, the text from each part of the

exchange is shown with angle brackets:
> Previous message

>> Message before previous message
>>> And so forth

Wy
of % Ifthe message is in a conversation, changing the Subject line will cause your
"
d

5

reply to appear in a new conversation.
LTy




Composing and Sending Email Z

To reply to a message:

1. Select the email you want to reply to.

. o | ©Repl 4 Reply to All | . . .
2. Click LE1ReRY] o, [ =Renl in the control bar. A new compose window is

displayed with the address(es) in the header and the original message in the body.

3. Type your reply.

4. Click OIS T on the toolbar if you want to change how the original message

is included in the reply. The options include:

0 Don’t Include Original Message
0 Include Original As Attachment
0 Include Original

0 Include Original With Prefix

0 Include Last Message Only

0 Your default option is marked but you can change it for this email only.

5. Click Lk=d5end

"..‘ . . . .
a® 'y Ifyouadd your signature automatically to your messages, your signature is

-' . ,.' automatically placed in the message according to the preference you enabled:

L)
an® either at the end of all messages in the compose window or at the end of the

message you compose, above the quoted text.

Forwarding an Email Message

You can Forward an email message to someone else. Forwarding a message includes all file
attachments, whereas Reply preserves the body text but does not include the attachments.

To forward a message:

1. Select the email you want to forward.
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2. Click | L3 Farward | o the toolbar. A compose window opens. The text of the
forwarded message appears in the body unless you have chosen to forward
messages as attachments using the Preferences > Mail tab.

3. Enter addressees in the To, Cc¢, or Bcc fields.

4. Add a few lines of new text at the top of the message to let the recipient know why
you decided to forward the message.

5. Click Hs5end

Optional Email Features

There are several optional email features available when using the ZWC. For example, you
can:

e Create an email signature
e Forward your Zimbra email to another email address

e Customize your initial email page

Email Signatures

An email signature is closing text included at the end of an email. A signature can include
your name and any additional text or graphics allowed by your email account. Contact your
system administrator if you have questions about what is allowed by your email account.

For example, a signature could read:

John Smith

Vice President of Engineering
Widgets Division

Acme Corporation, Inc.
303-555-1212 x111
john.smith@example.com

If you create multiple email identities (also known as personas), you can create different
signatures and assign them to specific addresses. More information on email identities and

personas is provided in the Managing Email chapter.
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To create a signature:
1. Use the Preferences > Signatures tab.

2. Type anidentifiable name in the Signature Name field. You can create multiple
signatures, so using an identifiable name here is important.

gnature S | P

| Test Sgnatues
| Tea

| Compary
LR

P

4.-' @r O iavm rwhuded petiaget ™ Bekow ruiued mevace

& del it signasture Can be net on the Aocount s Page

3. Type the signature text exactly as you want it to appear in the text box.
4. Specify where you want your signature displayed in the Using Signatures section.

0 Select Above included messages to add your signature at the end of the your
composed, replied to, or forwarded text.

0 Select Below included messages to add your signature at the end of the

message.
5. Click Add Signature.

To apply this signature as the default sighature for your account name:

1. Use the Preferences > Accounts tab.

Email address: 1031 1zx@demo2 zimbra, com

Account Name: | Primary Accnunt|

Messages sent from this account have the following settings:

From: Choose the name that appeats in the "From" Field of email messages

|Dan Demauser 108f11zx@demoZ. zimbra, com

Reply-to: [ et the "Reply-ta” field of emal messages to:

" oD it mail -

Signature: | Me -

2. Select the signature name from the Signature drop down menu at the bottom of the
screen.

59



Z Zimbra Web Client User Guide

Undeliverable Emalil

Sometimes a message bounces, meaning it cannot be delivered for a reason such as:

e Recipient is not a valid or existing email address. Verify that you have the correct email

address.
e Recipient's email system rejects the email for one reason or another.
e Recipient's mailbox is full.
If a message is rejected, you will receive an undeliverable mail message that includes:
e At least part of the contents of your original message

e Some system-generated error messages that provide more information as to why the

email has bounced.
Try to correct the problem and re-send the email.
If the email bounces due to a bad email address, but you are certain that the address is valid:
e Contact the recipients using other means.
e Have the recipients resolve the issue with their system administrators.
Contact your administrator if:
e Every email message you try to send is rejected.

¢ Email bounces with user unknown or bad address messages for addresses that you

used from your corporate address list.

e You start receiving bounce messages for email you did not send.
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Setting a Forwarding Address

You can identify an email address to forward your messages to and choose to retain the
message in your mailbox or automatically delete the message when forwarded.

To forward your email:

1. Use the Preferences > Mail tab. Scroll down to the Receiving Messages section.

‘Orward a copy to;

Ienter email address

When a message arrive:

[ send a notification message to:

Ienter email address

[~ Send auto-reply message:

I
[~

Messages From me: When I receive a message originally sent by me

i+ Place in Inbox € Place in Inbox if I'min To: or Cc: 7 Ignore message

2. Type a complete forwarding address in the When a message arrives: Forward a
copy to field.

3. If you want to automatically delete the email from your account, enable Don't keep
a local copy of messages.

4. Click LE153% |
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4 Using Tags and Folders to Organize Your Mailbox

This chapter explains how to...
e  Create and use tags

e Flag email messages

e  Use folders

e  (Create custom folders

Working with Tags

Tags are your personal classification system for email messages, contacts, tasks, and
appointments. Using tags is an aid for finding items. For example, you might have one tag for

Immediate Turnaround and another for Medium Priority.
Some of the advantages of tags include:
e You can sort email using tags.

e You can search for a tag and all messages with that tag will be displayed, no matter
what folder they are in.

* You can create as many tags as you want.

* You can apply multiple tags to the same email message and contacts.

Creating Tags
You can create a New Tag using any of the following:

1. Right-click Tags in the Overview pane, and select New Tag.

¥ Tag
D I C‘.', Mew Tag
D Zimbra

2. Select a message, click in the toolbar, and select New Tag.
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-

[ Zimbra

[y Mew Tag
E\ﬁ Remove Tag

3. Right-click an item in a list view, choose Tag Message, and select New Tag.

O D Zimbra Tear Read pt= Tivsb! Teemmekesmk mmme s Aemm b InFormation - Welcor
O Sam Sample: Re: Fli Matk As Read on UA 852 of ACH 419
O @ Sarah Soap & Searct [ Mark As Unread h within Zimbra: 1. Click
O Zach Zimbra & zimbre Dran, Did you ever che
O Matt Mobile WebB 04 Reply In Zimbra 5.0, we've b
O Cristie Calendar Usew &4 Reply to Al buri! - Zimbra Collabora
O 1 @ alan Ajax Zimbre 5 Forward Can, I have been revie
O ! Chatlie Cannector

Conne & ko your ac
e =g '4 5 [7] Industry News
ﬁ Delete

Subject; Read Me First! Important — (% New Tag
¥ SentBy! A} "Zimbra Team" <demofesdback@zimbr: = prim .
To: 112e79xh@demoz. zimbra, com

[ Junk
Welcome to EZimbra Collshoration 31
[--4 Show Criginal
This e-mail contains important inf &k Mew Fiker v wish to prir

Auratinn nf wnuar trial.

4. Right-click on Tags or a tag in the Overview pane and choose New Tag.

E;‘_ Mew Folder
¥ Folders % 4
¥ (2 Inbox (7)
End-User Project
E;;';. Sent
E:/; Drafts (1)
Ea Junk.
ﬁ Trash
Personal Emails
¥ searches

@\ PaowerPaint attachrment 7]

¥ Tags
a End-Lm

To create a new tag using any of the previously mentioned methods:

1. Select New Tag. The Create New Tag dialog is displayed.
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Create New Tag

Tag narme:

[ Qe -]

| oK || Cancel |

2. Type a name for the tag in the Tag name field, and choose a tag color from the drop-
down menu.

Create New Tag

Tag name:

Dema Tag | | D Cwan
'

[ Cyan

C @ Bl

& Purple
B red

[i Orange
(7] vellow
[ Green

Ik

3. Click

Tag names can have any character except the following
0 :(colon)

0 /(forward slash)

0 " (double quotes)

The new tag is listed under Tags in the Overview pane and can be applied to any
email messages or contacts.

¥ Tags

CI Demao Tag
D Industry Mews
[i Zimbra

You can assign multiple tags to a message. If a message has multiple tags, they are layered and
multi-colored.

pamnN
Mah Soap & Searching within Zimbra - Hi, To search within Zimbra: 1. Click on "advanced' Inbox 165 KE  12§3/2007 |
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Assigning a Tag to Messages and Other Items

Tagging is similar to flagging, except that you can create and apply multiple tags to a single
item to classify it under several categories simultaneously. After you create a tag, you can
apply it to conversations, messages, or contacts.

To tag an item using drag and drop:

Drag and drop the tag from the left-hand Overview pane onto the item on the Content pane.

O @ Zimbra Team Read Me First! Important Demao Account Information - Welcome ko Zimbra O Inbosx 1KE ;26 PM

O Sam Sample Re: Flight Plan - Hi Dan, Il be arriving on LA 852 or ACA 4196 in the morninn Inbos 4 KB 122812007
O @ Sarah Soap &9 Searching within Zimbra - Hi, To search within Zimbra: 1. Click on "advanced Inbos 165 KE  12/3/2007
] ach Zinbra & ZimBrewshe wall Street Journal - Hey Dan, Did you ever check out this arki Inbos 168 KE  11f25/2007
O Iatt M ‘web Baseg/Mobile Client for Phones - In Zimbra 5.0, we've built in & mobile © Inbox ZKE 10/1f2007
O @ valnalenda TebDay & CalDaY with vour account! - Zimbra Collaboration Suite 5.0 = Inbosx GKE Q2512007
O a1 D Alan Ajax Zimbra Foruns, Blog, and Mare, - Hey Dan, I have been reviewing the v Inbosx 3EKE 9/g/2007
O E Charlie Connectar Connect Outlook, YWindows Maobile, Palm, and more ta your account - Zimbra Inbos GKE &/z5/2007

To apply atag to an item using menus:
1. Right-click the item from the Content pane.

2. Choose Tag Message (or Tag Conversation, Tag Contact, etc.).

@ Mal | Ak AddressBook | [ Calendar @ Tasks | [ Documents Preferences

[gMew v  GetMal [ Delete [ S9 search v bo &l 5 Forward | [
¢ Advanced Search
O[> [®[ea[G[rn <
O Dan Pattern [ R el Its - The test equipment ng
[ Alex Adamns 2‘- Add To Contacts today's meeting - Good med
[ Charles Conne is ready - Hope you will h
[ Alex Adams il 35 Meeting 1 - The following
O Donna Brow [ Mark As Unread ths meetings - Expect b
= = - - <::| | " [ e *
. - . . Reply
Subject: Hills review is rei =
£ Reply to Al
¥ SenkBy: &"Charles Connectar” < =E ‘ n: March &, 2008 10:35 A
O
To: zachz@demo. zimbra.com =
%, Edit

Cc: ssample@demo., zimbra, con

(] End-User Training )

Abtachments ;| 7| doployment_worksheet

D Tag Message

Hope wou will hawve time t lﬁ'Delete

¥ Move T3 MEWTIg
Charles

[ Print Femove Tag

[g durk

[ Show Original
=B Mew Filker
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Z

3. Choose the tag name from the list that appears. Only tags not already applied to the

selected item are listed.

To remove atag from an item:

1. Right-click the item from the list and choose Remove Tag.

Subject: Searching within Zimbra

£ Forward

[] TagMessage

O | Sarah Soap & Searchinn within Fimhra - Hi. Tr search within Zimbra: 1. Click on "advanced' Inbox
Il Zach Zimbra & Zimbrair Mark As Read Dan, Did vou ever check out this arti Inbox
1 Matt Mobile web Bas [ Mark As Unread Zimbra 5.0, we've builk in a mobile ¢ Inbox
a a Cristie: Calendar Usi: Wek nt! - Zimbra Collaboration Suike 5.0 ¢ Inbox
[ 1 Q Alan Ajax Zimbra F €4 Reply an, 1 have been reviewing the v Inbox
1 U Chatlie Connector Connect Cﬂl‘g Reply to all , and rmore ko your account - Zimbra Inbox

»

[7] Industry Mews

¥ Sernk By &Sarah Soap On; December 3, 2007 9,32 ﬁ Delate
To: 112e79xh@demoz, zimbra, com ﬂ Move g
i s2arch.png £119.7 KB, add to briefcase =
Aktachments ; | prg s ! I3 print Cﬂ E—— 5 D Dema Tag
Hi, Zimbra
L@ Junk \_D/
To search within Zimbra: [ Shaw Crigi
! iginal .
1. Click on "sdvanced" by the top sean based an &y AllTags
\ \ \ . gh [lew Filker

2. Select the tag you want to remove, or choose All Tags to remove all tags at once.

To apply/remove a tag to multiple items at once:

1. Select all the items to be tagged using Control-Click or Shift-Click.

2. Right-click over any one of the selected items, and choose an existing tag, New Tag,

or Remove Tag.

To find tagged messages quickly:

e (lick a tag in the Overview pane.

C ¥ Tags
T

D Industkry Mews
Iﬂ Zimbra

All messages with the selected tag are displayed in the Overview pane. In the example below,

all messages with the Demo tag are displayed.
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[ g MNew ~ | Gt Mail | ﬁDeIete d’ = | FReply % Reply to Al 5 Forward | [ Junk | [ - | ﬁ | [ View - =12 =

[ &8 0|53 From | & | subject | Folder | Sze | Recewved T
(] 1_]_] &P Searching within Zimbra - Hi, To search within Zimbra: 1, Click on "advanced' Inboe 65 KE  12/3/z2007
[ D Cristie Calendar Use WebDay & CalDaY with vour account! - Zimbra Collaboration Suite 5.0 = Inbox 3KE 92512007

To search for tags, type one of the following into the Search field:

e tag: <"tag name">. Displays all tags with this name.

|tag:"DemD Tag" | Emaill - H Search |

e tag: "color". Displays all tags with this color.

|tag:"c';.r'an"| ‘Email - || Search |

Deleting a Tag

To delete atag:
3. Right-click the tag name on the Overview pane.

4. Click Delete.

¥ Tags
D Demo Tag
[ Industry [T Mew Tag
D Fimbra .+ Mark All s Read
¥ Zimlets Rename Tag
N L
ag olar 2

Deleting a tag removes the tag from any item that had that tag. The items themselves are not
deleted.
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Flagging an Email Message

The flag icon in the message list is a yes/no indicator that denotes whether the email message
has been flagged. This can be used to indicate an action-needed item or to distinguish the
message or conversation from other items of lesser importance.

To turn the flag on:

1. Place your cursor over the flag column for the message or conversation. The flag
icon appears in a shadowed form.

.2] Sarah Soap & Searching within Zimbra - Hi, To search within Zimbra: 1, Click on "advanced' Inbox
Zach Zimbra & Zimbrain the wall Street Journal - Hey Dan, Did you ever check out this arki Inbos

N’

2. Click once directly over the flag icon. The flag icon appears in its active form.

Fach Fimbra & Timbra in the Wall Street Journal - Hey Dan, Did you ever check out this arti Inboz:

N
F( F@)._]_] Sarah Soap &7 Searching within Zimbra - Hi, T search within Zimbra: 1. Click on "advanced' Inbox
N’

To turn the flag off:

e C(Click on an active flag.

Using Folders: General Techniques
There are two types of folders in the ZWC:

e System folders. System folders cannot be moved, renamed, or deleted. Examples
include the Inbox, Sent, and Trash folders.

e User-defined folders. You can create folders to organize your email. Folders you
create are displayed in the Folders list in the Overview pane. Top level folder names
must be unique. The name cannot be the same as any other top-level folder in your

email, calendar, or address book folders.
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Creating a Custom Folder

You can create custom folders. Custom folders can be created inside other folders, including

system folders.

You cannot create two folders with the same name within the same parent folder. For

example, you cannot have two folders named Shopping inside your Inbox folder, but you

could have one folder named Shopping inside your Inbox folder, and another one with the

same name inside the Sent folder.

To create a new folder, either:

1. Click

Ej_ Mew Folder

at the top of the Overview pane, or

Right-click in the Overview pane in the folders list, and select New Folder.

¥ Folders ;I
¥ E Inbox {74
E & Mew Folder

3 sent Al

E} Draft [ Delete

Ea Junk _Ii Rename Folder

ﬁ Trash —

Persa Edit: Properties
¥ Searche dk Expand Al

E Pawel Emply Folder

A Create New Folder dialog appears.

Create New Folder

Mame: ||

[T subscribe ko RSS{ATOM Feed

Select where to place the new folder:

¥ Folders

EE Inbox
E;a Chats
EE') Sent

ﬁ Trash

Zach's Forum Posts
[ zimbra Blog RSS
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2. Type the folder name into the Name field.
Select where to place the new folder. Either:

0 Click Folders to have the new folder displayed at the top of the list.

0 Click an existing folder to place your new folder within that folder.

Ik

3. Click

Renaming a Folder

To rename a user-defined folder:

1. Right-click on the folder, and choose Rename Folder.

¥ Folders =]
¥ [ Inbox (7)
End-User Project

EE') Sent

E} Drafts (1)

Ea Jurik,

ﬁ Trash

Personal Emails
¥ Searches E;', Mew Faolder

E PowerPoint Mark. All as Read

¥ Tags ﬁ Delete

[l End-User -EC_‘ Rename Folder :>
=
1| T

"o March 2 =] Edit Properties

S M T W Expand Al
o4 2moes 2 Ermpky Falder
2 3 4 5

A Rename Folder dialog appears.

Rename Folder: Personal Emails

Mew name:

Personal Emails

2. Type the new name for the folder into the New name field.

Ik

3. Click
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Folder names can have any character except:

0 :(colon)
0 /(forward slash)

0 " (double quotes)

Deleting a Folder

To delete a user-defined folder, either:

1. Drag the folder to the Trash.

¥ Folders =
EE| Inbox
E‘V Chats
EE') Sent
E} Drafts {1)
Ea Junk

ﬁ Trash,
= . Fach's Forum Postsl
Zach'sTForamFost:

& zZimbra Blog RSS (10

In this example, the Zach’s Forum Posts folder is being dragged to the Trash.

2. Right-click the folder, and choose Delete.

¥ Folders -
¥ [ Inbox (7)
End-User Project
E—?) Sent
E} Drafts {1}
Ea Jurk

ﬁ Trash

Persanal Email
¥ Searches E: New Folder

m PowerPoint 5 Read
¥ Tags ﬁ Delete

(] End-User Tt
F ﬂ' Move

« 4 Marchz | EdtPropertes
S 0 v W Expand &l

24 75 26 27
> 3 4 5

7

Empty Folder

When you delete a folder, its contents are moved to the Trash. You can recover contents from
the Trash by dragging and dropping them to another folder.

If you want to save some of the messages in a folder before you delete the folder, move the
messages to another folder.




"Wy
.4- &
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Z

s The Trash folder is purged on a regular basis, which is set by your

1-' ﬁ;" administrator, so items in the Trash do not stay there forever.

Yan
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5 Create Filters to Automate Email Handling

This chapter explains how to...
e (Create filters
e Understand the conditions and actions of a filter

e Use wildcards when creating filters

Email filtering allows you to define rules to manage incoming email. Filtering applies a set of
rules to incoming email and then executes a specified action. You can filter your incoming

email messages to:
e Sort them into folders
e Automatically tag them
e Forward them
e Discard them
For example, you could create rules as follows:
e All email from your supervisor goes into your Management Directives folder.
e All email from the corporate-events mailing list is tagged with the Events tag.

e All email from a specific address goes into the Trash folder.

Filter Conditions & Actions

Each filter rule consists of one or more conditions and one or more actions.

Conditions

For example, if your supervisor sends you emails from more than one address, such as
jane.smith@company.com or jane-smith23@yahoo.com, you could create one filter called
Supervisor which has two conditions, one for each email address.
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Conditions include:

Specific addresses in the From, To, Cc addresses in the email header

Email messages that are under or over a specific size. Size can be specified as B, KB, or
MB

Date is before or after a specified date
The presence or absence of file attachments
Specify that addresses that are or are not in your Address Book.

Words or character strings in the subject or body of the email message

All the conditions allow you to specify not as a negative condition. For example, you can

specify email that does not contain a particular word.

You can combine conditions to search for email with more complex characteristics.

Actions

Each filter rule can specify one or more actions. Actions include:

Leave the message in the Inbox (no action)
Move the message to another specified folder
Tag the message

Mark the message as read or as flagged

Discard the message. This action drops the email message silently, which means that
the message does not reach your mailbox. It is not the same as the Delete action on
your menu. Deleting an item moves it to the Trash folder.

Forward the message to a specified email address

Check Do not process additional filters to prevent the application of any other

4'-'.‘ filter rules to email messages that match this current rule. If it is not checked,

iy A
= % : subsequent filter rules are evaluated for the email message even if the current
/ d

#4a% filteris amatch. You probably don’t want to have the same message match more

than one filter rule and undergo multiple, perhaps contradictory actions.
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Using Any and All

Conditions within a filter rule can be grouped using Any or All. The use of these terms is
similar to And versus Or type searches, with Any being Or and All being And.

e Any. A message that meets any one of the conditions is considered a match.

e All Every condition specified in that filter rule must match in order for that message to
match the filter.

When Filters are Used

All filters currently defined are listed on the Preferences > Mail Filter tab. The Active check
box allows you to turn filters on or off without having to delete the filter rules.

Each incoming message is tested against your active filter rules when it is delivered, and the

filter actions are applied to matching messages at that time.

=R Mew Filker Edit Filter ﬁ' Delete Filker Move Up Move Down
Active Filter Mamne:
| Skaff Mestings

Filter Order

Filters are applied in the order they are listed on the Mail Filters tab. You can change that

. . Mavve Lip Move Down
order at any time using and

The conditions are used to test each email message. If the message meets the conditions
collectively (using the Any or All designation as specified in the filter rule), it is a match. The

order of the conditions within each filter is not important.

If the message matches the conditions, all actions associated with that filter rule are applied, in
the order in which they appear in the filter.

Creating a Filter

You can create a filter in two ways:
e Using the Preferences > Mail Filters tab

e Using a message in the Inbox
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Creating a Filter from the Mail Filters Tab
To create a new filter using the Preferences > Mail Filters tab:

1. Select the Preferences > Mail Filters tab.

ok Wew Fiksr | % Edit Filter ﬁ Delete Filker Move Up Mavve Down

Active ‘ Filker Harme

Mo results found.

2. Click o LT . The Add Filter dialog displays.

Add Filter
Filter Mame: || M active

If | any = | of the Following conditions are met:

Subject - | makches exacthy - | I— R

Perform the Following actions:

Keep in Inbox

ird Do not process additional filkers

3. Type the name for the rule into the Filter Name field.

4. In the If the following conditions are met area, choose a grouping preference.

any v |

any

all

Any means that if any of the conditions in the filter are met, apply the action.

All means that all of the conditions in the filter must be met to apply the filter
action.

Steps 5-11 can be repeated to set up multiple conditions and actions within a single filter:

5. Select from the first drop-down list which part of the email to filter. For example,
choose an email field, a portion of an email message, or an email address.
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Filter Marne: | Staff Meetings 13 Active

If | any = | of the following conditions are met:

Subject {El) matches exactly

Frarm
PerfT Ta

Ce
i Subject
V¥ o Header Named
Size
Crate
Body
Aktachment

Address in

In the above example, Subject is selected. Therefore, the Subject of all incoming
emails will be filtered.

Choose a comparison method. The options shown depend on your choice in the
previous step.

Add Filter

Filter Mame: | Skaff Meetings W Active

If | any | of the following conditions are met:

Subject - | contains @ e

makches exactly

Perform the Following actior  4ass nok match exeactly

Keep in Inbox + Copls s

does not contain

¥ G nat process additior matches wildcard condition

does not match wildcard condition

In the above example, contains is selected. Therefore, the filter will look for Subjects
that contain certain text.

Enter a word or phrase to compare against in the text field. For example, enter Staff
Meeting to filter all messages containing Staff Meeting in the Subject.

I

Click to add more conditions, if needed. You can continue to add more
conditions or proceed to add one or more actions.
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9. Choose an action from the drop-down list in the Perform the following actions
area.

Filter Marne: | Staff Meetings 3 Active

If | any = | of the following conditions are met:

Subject - | contains - | |StaFF MMeeting

Perform the Following actions:

Tag with * | | Browse.., |

" Keepin Inbox
M 0]

- | Filkers

File inka Folder

Tag with
Tark.

Forward to

In the above example, Tag with is selected. Therefore, the filter will tag email
messages with a Subject containing Staff Meeting.

10. Specify a folder or tag name, if necessary. What you specify depends on the action
you chose in the previous step.

Add Filter
Filter Mame: | Staff Meetings 173 Active

If | any | of the following conditions are met:

Subject vl contains v| Skaff Meeting 98

Perform the Following actions:/_\

Tag with ﬂv@ Zimbra | )

Rl
W ba not process additional filers

In the above example, the Zimbra tag is selected. Therefore, all incoming email
messages that have a Subject containing Staff Meeting will be tagged with the

Zimbra tag.
M active . . .
11. Check (upper right corner of Add Filter box) to turn on the filter rule.
| AP . . oK, .
12. Click to add more actions or click to finish.
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The filter will be applied automatically to all new incoming email messages as they arrive.

Creating a Filter from an Email Message

To create a new filter from an email message:

13. Right-click on the message and choose New Filter.

o

®

|53 From || et
@ Zimbra  $2 search

samsa  (C Advanced Search
B sershs [ JiHewEmal

Zath 3 L) e I

MattMc 5 Add T Contacts
Cristie ¢

O AN AL Mk As Read
Charlie [ Mark As Unread

ooooooopd

.

3 Reply

4 Reply to All
(5 Forward
<, Edit

[% (] Tag Message »
T Delete
ﬂ Mave
[ Print

bl Juy
1 Show Original
HF Mew Filter
e

14. The Edit Filter dialog displays with From, To, and Subject set with this information
from the email message.

Filter Mame: M active
If | any = | of the Following conditions are met:
M - | |dem0feedback@zimb@'ﬁ--
To - | conkains - | 114lz6nd@demaz. zimbrz | | &g =
Subject - | matches exactly - | Read Me First! Importan | | gh =
T —— i
\ ———
Perform the Following actions:
Keep in Inbox = L

W bo riot process additional filkers

15. If the filter conditions are correct, enter a name in the Filter Name field and click
(o] 4

You can change the conditions and actions as necessary using the drop down menus in the
Edit Filter dialog.

81



Z Zimbra Web Client User Guide

Editing a Filter
To edit a filter:

1. Select the Preferences > Mail Filters tab.

dr Mew Filter | < Edit Filter ﬁ Delete Filter Move Up Move Down
Active | Filter Mame
¥ Staff Meetings
. “ Edit Filker ey e . .
2. Click . The Edit Filter dialog displays.

Edit Filter
Filter Mame: | Staff Meetings ¥ pctive

If | any  |of the Following conditions are met:
Subject '| contains v| Staff Meeting LH

Perform the following actions:

Tag with - Zimbra ﬂ

¥ Do not process additional Filters

oK Cancel

3. Use the drop-down menus and fields to edit the filter as necessary.

Ik

4. Click

Filter Conditions and Actions Supported

This section describes the conditions and actions supported by ZWC filters. Filter rules are not

case-sensitive, so the rules ignore capitalization.

Conditions

Comparison fields include those in the following table.

Comparison Field | Description

From Use this to specify a From name in an email message.

To Same as From, but looks for specified names in the To header.
CC Same as From, but looks in the Cc header.
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Comparison Field

Description

Subject

Looks in the message's Subject header.

Header Named

When this option is selected, an additional text input field
appears before the comparison operator (the contains portion).
This option allows you to specify any email header. You can
specify the standard fields of To or From and Date, Reply-To, or
other custom fields that may be included in the message header.

You could use this option to filter out email messages that have
malformed headers, meaning they do not contain certain
information that is normally considered standard for an email
message. Sometimes spam, which is automatically generated,
omits information such as the Sender or Reply-To fields. Use the
second text field (the field immediately to the right of the
comparison operator) to specify the header to test for.

Size

Use this to select email messages that are larger or smaller than a
specified size, including any file attachments. You can use this to
discard email messages that are too large.

Date

Use this option to specify email messages sent before or after a
specified date.

Body

The options for Body are Contains and Does not contain. This
allows you to specify matching words in the body of the email.
You cannot filter for words in file attachments.

Attachments

You can filter for email messages with or without attachments.

Address In

Tests for an address in your contacts and allows you to specify an
address.
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Comparison operators include those in the following table.

Comparison Operator

Description

Matches exactly/does not match exactly

Specifies an exact match.

For example, specifying Subject matches
exactly Banana would only match Banana and
not Bananas or A truck full of banana leaves.

Contains/does not contain

Specifies that the subject line must contain the
specified substring.

For example, specifying Subject contains
Banana would match I'm going bananas.

Matches wildcard condition/does not
match wildcard condition

Specifies that the subject must match the
specified string, which includes wildcards.

For example, specifying bana* would match
banana and banana tree but not free bananas.

The wildcard * is a character used in the email
filter comparison field to represent one or more

characters in the filter.

Exists/does not exist

Matches if the specified field is present in the
message. Used with the Header Named and
Attachment fields.

Under/not under, over/not over

Used for comparison against the Size field.

Before/not before, after/not after

Used for comparison against the Date field.

In/not in

Used to test for presence of an address in your
contacts.
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Actions

Available actions include those in the following table.

Action Description

Keep in Inbox Saves email to Inbox. If none of the filter rules match an
email message, this action takes place by default.

File into Folder Moves the email to a specified folder.

Discard Deletes the email message without delivering it. The

message is not in any of your folders, not even Trash.

Forward To

Forwards email to the address you specify.

Stop Evaluation

This action prevents subsequent filter rules from being

applied to any message that matches the current one.

Mark

Select as Read or as Flagged.

Tag with

You can tag matching messages with a selected tag.
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Multiple Actions

A filter rule can specify multiple actions. The combinations of actions are interpreted as
described in the following table.

Multiple Action Description

Discard If combined with other actions, discard is ignored and the
other actions take place.

Stop Evaluation Actions specified after this one are ignored.

File into folder Multiple file into actions results in multiple copies of the
message being stored in different folders. If a specified
folder does not exist, the message is saved to the Inbox.

Tag/Mark These actions apply to the message returned from the
nearest preceding action. In the case of multiple file into
actions, this could result in some copies of the message
stored without a tag, and others stored with a tag.

Keep in Inbox Multiple keep actions can be specified, but only one copy
of the message is saved to the Inbox.

Filter Wildcards

Wildcards can be used in comparisons that use the Matches pattern comparison operator. The

two wildcard characters are * and ?

Asterisk (*)

The asterisk is a placeholder for zero or more characters of any type.

Example Match

Subject-line search string: Subject lines such as bananafloat, bananas,

banana*float banana-leaf casserole float but not super-
banana-float
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Subject-line search string;: Subject lines such as white bandanna or whose
w*bandanna bandanna but not whose bandanna is this?

Question Mark (?)

The question mark is a placeholder for exactly one character.

Example Match
Subject-line search string;: Subject lines such as bananasboat, banana-
banana?boat boat, banana!boat, or banana boat

Escape Character is Slash: \

There may be times that you want to specify an exact match on a string that contains

characters that normally are considered wildcards.

For example, you might want to specify a match on a subject line where the main heading is
surrounded on both sides by three asterisks, such as:

o **MORE MONEY!***
o “*EREE GIFT***

To specify a wildcard as itself rather than a substitution for other characters, use the backslash
\ immediately before the character. For example the comparison string \*\*\**\*\*\* specifies a
subject with three asterisks before and after any string in the middle (including spaces).

Comparison " d-\‘-' ‘-\l \J.
First match 3T Tk

o
o
*
o
ok
o

Second match
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6 Customizing Your Email Features

This chapter explains how to...

. Set up new mail notification
J Create away messages
o Manage your account identities

o Change your default time zone

The ZWC offers several email features that you may choose to use when managing your

mailbox. The advance email features include:

e New Email Notifications. Send email to another email message to notify you when

you receive email in your Zimbra mailbox.
e Away Messages. Send out-of-office auto-reply messages when you are away.

e Personas/Other Email Identities. Create separate email identities, also called personas,
to manage different types of email. For example, you can create a business persona for

your business email and a personal persona for your personal email.

e External Accounts. Configure your Zimbra mailbox to check email at other, external

email addresses.

e RSS Feeds. Create a folder to receive RSS (Really Simple Syndication) feeds directly

into your Zimbra mailbox.

e Mailbox Quotas. Manage the size of your Zimbra mailbox, so you do not exceed your

quota.

Setting a New Email Notification

You can configure your email options to notify you at another email address when you receive

email to your Zimbra mailbox. This feature may be useful if you do not receive a lot of email
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to your Zimbra account, but when you do receive email, it's important enough to require a

timely response.
To set notification:

1. Select the Preferences > Mail tab, and scroll to the Receiving Messages area.

When a message arrives: Forward a copy ko:

| anter amai addhess

™ Don't keep a local copy of messages

™ send a notification message to:
| enter amai aodhess

e —— e

™ send auto-reply message:

Messages from me: \When I receive a message originally sent by me

(* PlacginInbox " Place in Inbox if Tmin To: or Ce: ¢ Ignore message

Check Send a notification message to.

2. Enter the email address.

3. Click L2 |

Creating an Away Message
This feature is also known as an out-of-office auto-reply message.

e You can set an away message that automatically replies to people who send you
messages when you are out of the office for an extended period of time.

e The auto-reply message is sent to each recipient only once, regardless of how many
messages that person sends you during the designated vacation period.

To set an away message:

1. Select the Preferences > Mail tab, and scroll to the Receiving Messages area.
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When a message arrives: Forward a copy to:

| enter ema adiess

I Don't keep a local copy of messages

[ 5end a notification message to:

| enter ema adiess

Ty MES5a0e;

I am currently out of the office. I will be checking voice mail but not email. T vill
rekurn on August 1, 2008]

MessagMDriginally sert by me /

% Placein Inbox ¢~ Place in Inbox if I'min To: or Cc: ¢ Ignore message

2. Check Send auto-reply message.

3. Enter the message to be sent in the text box, such as the message shown above.

4. Click L1528 |

\Jal /
.‘1 %s Remember to turn off the away message when you return. To turn off the away
-" S ,.' message, uncheck Send auto-reply message. The away message is disabled
an?

immediately.

Managing Your Account ldentities
There are two different aspects to account identities in ZWC:
e Account identities. These are also known as personas, within your Zimbra account

e External accounts. These are other email accounts you may have besides your Zimbra
account

When you send new email or reply to or forward an email message, one identity is always
associated with the email. This is the default identity or persona created as your account name
and is used unless you set up different identities.

Creating different account identities, called personas, allows you to use multiple email
addresses from your mailbox. You might want to do this to manage different roles in your job
and personal life from this single email account.
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You can also add external account addresses to your Zimbra account to retrieve email from
your other POP accounts. You can configure the external account settings so that when you
reply to those messages, a specific address is shown in the From field.

If you have set up more than one persona or added external accounts, when you open a new
compose window, your identities are listed in the Account field in the header.

T ||

Cez |

Subject: cunt: | Primany Account ("ZWC Traning™ )

. Training (“vour Trainer™ )
% Primary Account ("TWC Trairirsg” )
{"Dog Lover™ )

mdv 2ip) > 5 B v | == @ 3 B T

Creating a Persona

Creating different personas allows you to use multiple email addresses from your mailbox.
For example, you could use your default persona for your business email correspondence and
you can create a new persona for your personal email correspondence.

To create a persona:

1. Select the Preferences > Accounts tab. Your default account information is shown at
the top of the tab.

———

Account Hame ‘ Status | Email Address | Type

Primary Accaunt o] 114lz6nd@demaz. zimbra. com Primary >

Add External Account | | Add Person

Delete

\

Email address: 114lz6nd@demn?, zimbra.com

Account Names: | Primary Account\

Messages sent from this account have the following settings:

From: Choose the name that appears in the "From" Field of emall messages

Dan Demouser 114lzend@demnz. zimbra.com

Reply-to: [ Set the "Reply-to" field of email messages to:

&.g. Bob Smith Email Address -

Signature: Me -

. fdd Persona | .
2. Click . A new account name appears, and the Persona Settings area

appears.
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Account MName Status Email Address
Primary Accounk oK 115680u4@demaz. zimbra, com
Mew Persona 1 oK 115680us@dema, zimbra, com

Delete

| Tvpe
Primary
Persona

Add External Account | Add Persona |

3. Complete the fields in the Persona Settings area, as shown on the next page.

. =
4. Click SESE on the toolbar to save your new persona.

Complete the fields in the Persona Settings area, as shown in this example where a Training
Persona is created to manage all emails related to training.

Use personas to quickly change many settings when sending email messages, For example, if you sometimes send email in a particular

role at wark, create a persona for that role,

Persona Mame: | Training Persona

Messages sent from this account have the following settings:

From: Choose the name that appears in the "From” field of email messages

| Dian Demouser 115680ud@demc. zimbra. com

Reply-to: ¥ Set the "Reply-to" figld of email messages to:

| Tearn Training training@yahoao.com

Signature: | Me -

Use this persona: [¥ When replying or Forwarding messages sent ta:

| training@yahoo, com
Enter email addresses separated by commas or semi-calons

[¥ Replying to or Forwarding messages in Foldsr(s):

| Training | wa}

Enter folder names separated by commas or semi-calons

5. Enter a name for this persona in the Persona Name field. This is the name used to
identify the persona in the From list when you are composing an email. It does not

appear in the email message.

6. Specify the From information for this persona:

0 Type the name that should appear in the From field of your outgoing email
messages. This is the friendly name that is shown before your email address.

0 Select the email address from which to send messages into the second field. If
this field is not editable, you do not have additional external accounts identified.

7. To direct replies to emails from this persona to a name and address different from

that which you configured in From.

0 Check Set the “Reply-to field of email messages to.
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0 Enter the name and address that should receive replies for this identity. For
example, replies to training messages should be sent to Team Training at
training@yahoo.com.

8. Select a signature for this persona using the Signature drop-down menu.

0 If you have not created the signature, you can come back and edit this persona
later.

0 If you do not want the signature to be applied automatically, select Do Not
Attach Signature from the menu.

9. To automatically use this persona when replying to messages sent to a specific email
address, or when forwarding messages from that address:

0 Check When replying or forwarding messages sent to.

0 Type the email address(es) in the field. If you are entering more than one email
address, separate addresses with either a comma or a semi-colon.

10. To automatically use this persona when replying to messages in a specific folder, or
when forwarding messages from this folder:

0 Check Replying to or forwarding messages in folder(s).

0 Click the folder icon to select one or more folders from the list of existing folders
or to create a new folder.

0 If you are selecting more than one folder, separate the folder names with either a

comma or a semi-colon.

To create a signature for use with this persona, use the Preferences > Signature tab. Refer to
Email Signatures in Chapter 3 for instructions on creating email signatures.

Retrieving Email from an External Account

Using ZWC, you can link your external email accounts to your Zimbra mailbox. Then, you can
retrieve email from your external account(s) in your ZWC, instead of logging into each
external account separately.

When you set up your external account on ZWC, you can:

e Specify where the messages will be saved
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e Create a persona to be used when you reply to or forward a message received from

that external account

Information You Need

When you set up your external account you need to know the following details. You may need

to contact your email provider for this information.
e Account type. This is the type of email you service provider uses: POP or IMAP.

e User name on the account. This is the user name associated with this email account.
Sometimes your user name is the part of your email address before the @ and other

times it is your full email address.
¢ Email server. This is the server name for your external account.

e Advanced settings. Your provider should let you know if they do not use a standard
IMAP (143) or POP (110) port. Enable Use an encrypted connection (SSL) when
accessing this server when you need to connect securely to the external server. The

port numbers will change.

Receiving Messages from Your External Account

When you retrieve your external email messages, the messages and attachments are saved to

the folder you specify when you configure your account information.

Messages from your external account(s) are not automatically received in your Zimbra Web

Client account. To check for email from your external account(s):

e If you configured the Inbox to be the folder to save the external account's messages,

click LS=EM8IT o the toolbar. Your Inbox folder is updated with all new messages

including messages from your external accounts.

e If you configured another folder for your external accounts, select that folder and click

the L5#EMal] bytton on the toolbar. Messages are delivered to your folder.

e If you configured another folder for your external accounts, right-click the folder. The
menu has a Get External Mail option. Select this option to receive messages.
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Adding an External Account
To add an external account to your ZWC account:

1. Select the Preferences > Accounts tab. Your default account and persona
information is shown at the top of the tab. In this example, a persona has already
been created.

Account Name Skatus Email Address | Type
Primary Accounk QK 115680u4@demaZ. zimbra. com Prirnary
Training Persona QK 115680u4@demo?, zimbra,com

Delete Add External Ngeount | | Add Persona

. Add External Account .
2. Click A new external account name is added to your accounts,

and the External Accounts Settings area appears.

Account Mame Stakus Email Address | Type
Primary Account O 115680ud@demo?. zimbra.com Primary
MNew External Account 2 [s]4 POP
Training Persona o4 115680ud@demaZ, zimbra. com Persona

Delete Add External Account | Add Persona ‘

3. Complete the fields in the External Accounts Settings area, as shown on the next
page.

. = .
4. Click = 52 on the toolbar to save the external account settings.

Email address: ‘ e.g. bob@exampk. com

Account Name: ‘ New External Account 2

Account type: (+ POP3 (" IMAP

Username of Account: ‘

Email Server: ‘ &.q. mait exampla. com

Password: [~ show password

Advanced Settings: [ Change POF port 110 (1105 the default)

[~ Use an encrypted connection (5500 when accessing this server
Test Settings

Download messages to: " Inbox
{+ Falder: Mew External Account 2

[ Delete messages on the server after downloading them

Messages sent from this account have the following settings:

Fromy: Choose the name that appears in the "From" field of email messages

| Dan Demouser 115680u4@demc?  zimbra. com

Reply-to: [ Setthe "Reply-to” field of email messages to:

e.q. Bob Smith Email Address -

Signature: | Do Mot Attach Signature +
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10.

11.

12.

13.

14.

15.

16.

17.

Enter the exact email address of the external account in the Email Address field.

Enter a name to identify this account into Account Name field in the External
Account Settings section. You can select this account name from the From address
list when you compose new email messages.

Check the Account type: POP or IMAP.
Enter the name of this email account into the Username of Account field.
Enter the email server host name into the Email server field.

Enter the password you use to log on to this external account in the Password field.
To see that the password you typed is correct, check Show password.

If you service provider uses a different port then the default, change it in the
Advanced Settings area. If you use a secure connection, enable Use an encrypted
connection (SSL) when accessing this server.

Select where the messages should be saved using the Download messages to
section. The default is to create a new folder and enable it to receive the messages.
But if you want the messages in your Inbox, select Inbox.

Enable Delete messages on the server after downloading them if you want the
message deleted from your external account when it is sent to your ZWC account.

Type the name that should appear in the From field of your outgoing email
messages (for example, John). This is the friendly name that is shown before your
email address.

Check Reply-to if replies should be sent to a name and address different from that
which you configured in From. Enter the name and address that should receive
replies for this identity. For example, replies to training messages sent by John
should be sent to Team Training at training@example.com.

Select a signature for this external account using the Signature drop-down menu.

0 If you have not created the signature, you can come back and edit this external

account later.

0 If you do not want the signature to be applied automatically, select Do Not
Attach Signature from the menu.

. 3 .
Click SE on the toolbar to save your new external account settings.
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To create a signature for use with this external account, use the Preferences > Signature tab.

Refer to Email Signatures in Chapter 3 for instructions on creating email signatures.

Subscribe to an RSS

You can subscribe to Web sites that provide your favorite RSS (Really Simple Syndication) and
podcast feeds to send updated information directly to your mailbox.

You need to know the URL for the RSS before proceeding.

To subscribe to an RSS feed:

El Mew Faolder

1. Click above the Folders heading in the Overview pane. You must
create a separate folder for each RSS feed.

E‘_ Iew Folder )
¥

¥ Ea Inbox (2}
End-User Project
EE') Sent
E} Drafts (1)
ES Junik,

ﬁ Trash —

= '
Personal Emails

-

¥ Searches

E& PowerPoint attachment -
| | 3|

The Create New Folder dialog appears.

Create New Folder

[T Subscribe to RSS/ATOM feed

Select where to place the new folder:

¥ Folders
w2 Trbox
EE') Sent

ﬁ Trash

Personal Emails
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2. Type the name of the RSS feed folder in the Name field.

3. Check Subscribe to RSS/ATOM feed. The URL field is displayed in the dialog.

Create New Folder

@ subscribe ko RSS/ATOM feed

Select where ta place the new Tolgder:

¥ Folders
» B2 Inbox
EE'; Sent

ﬁ Trash

- i
Personal Emails

4. Enter the URL for the feed in the URL field.

5. Select where to add the RSS feed folder in the folder menu. If you choose the root
folder, the new folder is displayed at the highest level in your folder view, which is
the same level as your Inbox folder.

Ik

6. Click The new folder, with the RSS feed icon b, displays as the folder in
your Overview pane. The feed is automatically sent to the folder in your Zimbra
mailbox.

El Mews Folder

¥ Folders
E Inbox
E‘V Chats
E.?) Sent
E_; Drafts (1)
Ea Jurk,

ﬁ Trash

& News RSS {Z0)
Zach's Forum Posts >
|5 Zimbra Blog RSS (10

7. Open the RSS folder. The content is displayed in the Content pane.
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[.gNew v | LoadFesd =[] Delete _e’ =1 = Reply =% Reply to all -5 Forward @dunk | [] - ] | [ view =
[ | ﬁ | E | Q |'—T§')| From | §| Subject | Falder | Size: | Received o
O [ Yahoo! News: Top § Bush chides Congress over spy law lapse (AP} - [F News RS 2 KB 8:09 AM 15
O =] Yahoo! News: Top § Bush pushes Kenya deal during tour of Africa (AFl News RS 1 KB 8:08 AM

O [ Yahoo! News: Top § Prayer and protest on eve of Kosovo independen News RS 1 KB 8:06 AM

O =] Yahoo! News: Top § McCain's sharp tongue: An Achilles heel? {AP) - [F. News RS 1 KB 8:05 AM fe
O [ Yahoo! News: Top § Police: 7 dead in likely drag-race crash {AP) - [Em: News RS 2 KB 7:58 AM

8. Click 239F5d] i1y the toolbar to update the content.

Mailbox Quotas

To keep disk and resource usage to a manageable level, your administrator may enforce
quotas to limit the amount of disk space your mailbox can consume.

The display banner under your name in the shows a bar showing how much of your quota
you have used.

ininbog fu

Zimbru [-_] Email "‘ Search ‘ Save

FoAMal AL address Book | [T Calendar E—i Tasks

L Mew Folder [ Send K Cancel %/ MewIM [ Save Draft &

If you are over quota, the following things may happen:

e You receive an email notification.
e Your email interface displays a notification when you log in.
e Email sent to you may be returned (bounced), along with a notification that your

mailbox is full.

To reduce the size of your mailbox:

e Delete old messages that are no longer needed.

e Look for and delete messages with large file attachments. Save the file attachments
locally if you want to preserve them.

e Delete Documents notebooks, pages, images and attachments that are no longer
needed.

e Empty the Trash and/or Sent folders.
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Zimbra also supports automatic purging of messages that are over a certain number of days
old. Your administrator sets the policy for when messages are purged, how old they have to
be, and which folders are purged.

Changing Your Default Time Zone

Change the default time zone for your mailbox using the Login Options area of the
Preferences > General tab.

Login using: (* Advanced (Ajax)
(" Standard (HTML)

Theme: | Sand -
1
T == ctnglish (United States) - |
t | GMT -08:00 USfCanada Pacific B - |

Change Password

e The default time zone setting that is displayed in this tab is used to localize the

.‘1 .' time for received messages and calendar activities in the standard web client.

] . . .

» . ‘@;.. The advanced web client uses the the timze zone setting on the computer as the
am

time stamp for received messages and calendar activities, not the time zone
setting in the General tab.
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7 Managing Your Address Books

This chapter explains how to...

e View your address books

¢ Add new contacts to specific address books

e Add names to email from your address books

e Add contacts automatically to your address books
e Create group contact lists

e Import or export your address book

Your email administrator can set a maximum limit for the number of entries you can have in
all of your address books. When you reach this maximum, you cannot add any more contacts.
However, you can delete unused contacts to free up space.

When you compose an email, the auto-complete feature displays a list of names from your
address books that match the text you are typing.

The Emailed Contacts address book is populated automatically when you send

oWy
"‘-ﬁ ‘i an email to a new address that is not in one of your other address books. You
-' &> : can disable this feature by removing the check from Enable auto adding of
®as®  contacts on the Preferences > Address Book tab.

Viewing Your Contact Information
You can view the contact names in a list or as detailed cards.

e The Contact List view is a vertical list of all of your contacts.
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@ Mail &L Address Bock | [] Calendar @ Tasks | i Documents Preferences

dptiew | < Edt | [ioelete 8 B v | [ v | F]vew ~ 4= 1-80f5 =
|F\"|123|A|B‘C|D|E|F|G|H|I|J|K|L|M|N|O|P|Q|R|S|T|U|V|W|X|\"|Z|
[ L Adams, Alex
[ A Ajax, Alan ;
[ & Brown, Dorna A]ax, Alan Location: E Contacts
[ A, Connectar, Charles feedback@zimbra,com
[ L Demouser, Dan
[ & Linux, Laura Waork
[ L Pattern, Dan 1600 Pennstate ave Ste 1230
§ Springfield, IL
[ A Zimbra, Zack

e The Detailed Cards view shows all the information you entered on the contact form.

@ Mail &k Address Book | [] Calendar @ Tasks | Documents Preferences

iy Mew | < Edit | [ Delete (% =1 = | - | 2] view » G 1-80F8 o
|»Q|||123|Q|B|C‘D|E|F|G|H|I|J|K|L|M|N|O|P|Q|R|S|T|U|V|W|X|\"|Z| 1=
A Adams; Alex A.Ajax, Alan
E alexadams@demo. zimbra, com W 1600 Pennstate ave Ste 1230

Springfield, IL
E feedback@zimbra.com

45 Brown, Donna 4, Connector, Charles .

E dbrown@dema, zimbra.com E cconector@dema, zimbra, com

To change the view for one session, use the View drop-down menu on the toolbar.

r'@ View -

B[] uist

@ [ card

To change the default view for Address Books:
1. Select the Preferences > Address Book tab.

2. Select an option from the Default View drop-down menu in the Options area.
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Display contacts per page: 25 -

Default ¥iewT

|
Zard
S¢ttings: | conpacts to "Emailed Contacks"
UEo-comp#ete includes addresses in the Global Address List

When you pass your mouse cursor over an address, a tool tip displays the full email address
associated with that name. If the name is already in an address book, both contact information

is displayed. If the name is not in one of your address books, only the email address is
displayed.

Subject: test results
¥ SenkBy: &k Dan Pattern On: March 6, 2008 11:2

Tre Hrficdamn ey oo

Pattern, Dan s
Full Name: Dan Pattern |
Email: dpattern@demo. zimbra.com

Ciick fo compose,
Right-click For more options.

Adding a New Contact

You can add a new contact in two ways:

[ g New =

e Using on the toolbar.

¢ Right-clicking a name in a message header and choosing Contacts.
When you add a new contact, you:

e Enter the name, phone, and company information

e Select how you want to file the contact in your list

e Enter up to three email addresses and three mailing addresses

Adding anew contact from the toolbar

[ Mew -

1. Click the arrow next to on the toolbar, and select New Contact.
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[ g Mew =

[-g) M Emnail

?ﬂlw
&New ONCACE Group

{3 New Appaintment
ﬁ New Task

|3 Mew Page

E Mew Address Book
E‘_ Mew Calendar

Eﬂ Mew Task List

£, New Notebook

The New Contact form opens.

[ save 3% Cancel 1= ﬁDeIete M -

< New Contact
Personal Work Home Okher Mokes
Lask: || Job Title:
Firsk: Campany':
Middle: Address Book: | Conkacks -

File As: | Last, First -

Email and Instant Messaging

Ernail: IM Address: | MNone
Ernail 2:
IM Address 2: | None
Ernail 3:
IM Address 3: | None =
Add Photo
Add Mew Photo
i e | Browse... |

2. Enter the contact information, and upload a photo of this contact, if desired.

3. Click [ save on the toolbar.

Adding a new contact from an existing email message:

1. Open the email message, the header is displayed in gray at the top of Message the
Detail pane. You can add email addresses from the Sent By, To, Cc, and Bcc fields.
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Subject: Hills review is ready

Toi zachz@demo,zimbra,com
Ce: ssample@demo. zimbra, com; Donna Brown
Attachments ;| 7| doployment_worksheet (294.3 KB, download)

Hope wou will have time to review this hy tomorrow.

Charles

* Sent By: &"Charles Connector” <cconector@demo.zimbra.com> On: March 6, 2005 10:35 AM

2. Right-click the name to add to your contact list and choose Add to Contacts.

Subject: Hills review is ready
* Sent By: &"Charles Connector” <cconectori@demo.zimbra.com> On: March 6, 2008 10:35 AM
Tt zachz@d p Search
Cr: ssample@ B Advanced Search  [0wn
Attachments :| 7] doploy [ New Email download
Hope wou will Mt I ew thiz by tomorrow.
2'_ Add To Contacts
Charles =R Mew Filter
G Go to URL

3. The New Contact form opens pre-populated with whatever information was
available from the email header. Add additional information and check the pre-

populated fields for accuracy.

File As: | Lask, First b

Email and Instant Messaging

Email: | demofesdback@zimbra, com
Email 2: |
Email 3: |

Add Photo

3 Add Mew Phaoto

Browse. .. |

[isave 3 Cancel | (=1 [Delste | [ +
£ Team, Zimbra
Personal Shark Home Cther Motes
Last: | Team| Job Title:
First: | Zimbra Companty:
Middle: Address Book: | Contacts -

IM Address: | None «
1M address 2: | Mone =

I Address 3: | Mone
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4. Select the following:

0 With File As, select how you want to file the name. The default is to file the
contact by last name, first name.

o0 With Address Book select the address book to which you want to save the

name.

5. Click [ save on the toolbar.

Adding Names to Email from an Address Book
When composing an email, you can select email addresses from your address books.

Company Address Book

Within your organization, you may not always know the correct email address to use. For
example Joe Smith at Acme could variously be joe@acme.com, jsmith@acme.com, or

js123@sales.acme.com.

A company address book (also known as a Global Address List), is usually available to
everyone in the company to help identify email addresses.

To add names from an address book to a new email message:

1. Click Loahew ~

on the toolbar to open a new message.

2. Click To. An address selection dialog appears. Complete the remaining steps as
described on the next page.
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Select Addresses

p | sa Seatch Show names from: | Conkacks

| Marne 2| Email &| Tarme: Ernail

& Sample, Sam ssample@zimbra,com To: Sample, Sam ssample@zimbra, com

Remoye

Previous

oK Cancel

3. Select an address book from the Show names from list. In the example above,
Contacts is selected. The graphic below shows some options in this menu.

Showe names from; | Global Address Lisk J\?}J

&4 Mame Caontacts
Perzonal and Shared Contacks

Global Address List

4. Enter a name or portion of a name in the Search field on the left.

5. Click Search. A list of names and email addresses appears on the left. In this
example, Sam Sample is displayed because it matches the sa entered into the Search
field.

6. Select a name to add it to the recipients list on the right.

7. Click the To, Cc, and Bcec buttons to determine where the name will appear when
the message is addressed. Click the desired button before moving the name across.
Use the Remove button to remove a name from the recipients list on the right.

8. Repeat the search as needed until all names have been added.

oK.

9. Click
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Adding Contacts Automatically

Using the Preferences > Address Book tab, you can select the Add new contacts to “Emailed
Contacts” option to automatically add email addresses from your email messages to your
Emailed Contacts list. With this feature enabled, any time you respond to a message that
includes an email not in your address books, the address is automatically added to your
Emailed Contacts address book.

Display contacts per page: | 25 ~

Default View: | List ~ |
— \

tings: ¥ Add new contacts to "Emailed Contacts” )
s heiclansicl Bddress List

Import: If you are using another contack manager program, you can import your exdsting contacts by saving them in "Comma-Separated Values" {.csv) format,
See documentation in that program for help saving in this format,

CS¥ File: Browse...
Impork .CSY File

Export: YoU can export your contacts in the standard "Comma-Separated Yalues" (.csv) format, then impart them inko another contact manager program. See
documentation in the other program For help in importing,

Export a5 .CSY Filz

The Email Contact address book lets you keep a separate miscellaneous address book from
other address books with random addresses.

Creating a Group Contact List

The Group Contacts feature allows you to create contact lists, also known as email aliases, that
contain multiple mailing addresses. When you select a group contact name, everyone whose
address is included in the group list is automatically added to the address field of the
message.

D
&% & Theicon “4 indicates that a contact name is a group contact.

] @ [ ]
‘l‘.-"
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To create a group contact list:

1. Right-click M%7 on the toolbar and select New Contact Group.

[.g Mew

[og) Mews Ernail
< &r; Mews Conkact Group >
[F3 Mew Appointment
ﬁ Mew Task,

| g Mew Page

E Mew Address Book
[F3 Mew Calendar

E_: Mews Task Lisk

£ J Mew Motebook

The New Contact Group form is displayed.

[ save & Cancel | (=1 [ Delete | ] ~
<1 Training Group
* Group Mame: | Training Group Address Book; | Contacts Add Members to this Group
* Group Members: Enter addresses on separate lines Find: | & Search
“Sample, Sam" <ssample@zimbra.comz :
"Ajax, Alan" <feedback@zimbra.com> n: [[Conkacts T
“aster, Ann" <ann.aster@zimbra.com>
| e | Emai
L Ajox, Blan feedhack@zimbra.com
& Aster, Ann ann.aster@zimbra.com
Add Add All

2. Type the name for this Contact Group into the Group Name field.

3. Select the address book to which you want to add this Contact Group from the
Address Book drop-down menu.

4. To add members to this group:

0 Type a name into the Find field.

0 Select the address book you want to search using the in drop-down list.
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Names that match your entry are listed in the box below the Find field.

5. Select the names to enter and click Add or Add All. The names are added to the
Group Members list.

6. You can also type email addresses directly in the Group Members list box. Separate
addresses with either a comma (,) or a semicolon (;), or using Return.

7. Click S e on the toolbar. The new group contact is added to your address
book.

Importing an Address Book

You can import contact lists and address books that are saved in a comma-separated (.csv) text

file format.

To import an address book:

1. Select the Preferences > Address Book tab.

Display contacts per page: | 25 ~

Default Yiew: | List +

Settings: ¥ Add new contacts to "Emailed Contacts”

™ Auto-complete includes addresses in the Global Address List

Import: IF wou are using another contact manader pragrarm, wo can impokk your existing conbacks by sawing themn in "Comma-Separated Yalues" (.osv) Format,
See document b Eproaram for iely saving in this

Browse.

CS¥ File:

Impork ,C5Y File

Export: 10U £an expart your contacts in the standard "Comma-Separated Yalues" (.csv) format, then impart them inko another contact manager program. See
documentation in the other program For help in importing.

Export as .CSY File

2. Click Browse in the Import / Export area to locate the .csv file to import.
3. Browse to the .csv file you want to import.
4. Double-click the .csv file in the File Upload dialog.

5. Click Import .CSV File. The Choose Address Book dialog appears with a list of your
address books.

6. Select the address book to import into or create a new address book.

7. Click OK.
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Depending on the size of the .csv file, import may take a few minutes. When the import is
complete, the Status Box shows the number of contacts successfully imported. Contacts are

alphabetized by last name.

Exporting an Address Book

Your address books are exported and saved in a comma-separated (.csv) text file format.

To export an address book:

1. Select the Preferences > Address Book tab.

Display contacts per page: | 25 *

Default Yiew: | List ~

Settings: ¥ Add new contacts to "Emailed Contacts”

[ auto-complete includes addresses in the Global Address List

Import: If you are using another conkack manager program, you can import your exdsting conkacts by saving them in "Comma-Separated Values" {.csv) format.
See documentation in that program for help saving in this format,

CS¥ File: Browse...
Import .CSY File

Esport: You can sxport your o ; wComma-Separated Yaluss" {.csv) format, then import them into another contact manager program. See
documentatian j other pragram Far help in imp

Export as .CSY File

2. Click Export as .CSV File. The Choose Address Book dialog appears with a list of
your address books.

Choose Address Book

Choose an address book ko export:

¥ Address Books

@ Contacts
E' Emailed Contacts

3. Select the address book to export.

4. Click OK. An Opening Contacts.csv dialog appears.
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I 1
Dpening contacts.csy il

‘fou have chosen to open

contacts.csy

which is a: Microsaft Office Excel Comma Separated Walues File
fram: http:ffdemoz, zimbra.com

What should Firefiox do with this file?

& {on

Microsaft Office Excel (default) j

£ Save bo Disk

[~ Do this automatically for Files like this fram now on,

Ok I Cancel

5. Check Save to disk and click OK.

6. Select where to save the file and enter a file name. The default name is Contacts.csv.

7. Click Save.

Printing a Contact Name or Address Book
You can print a complete address book or just print the information for one contact.
To print from address books:
1. Select an Address Book a

2. To print, either:

0 Select a specific contact name and click the Print icon =

0 Click the arrow next to the print icon and select Print Address Book.

= v[}\)[ﬂ *  Eview -

[ Print selected contack(s)
[ Print Address Book

Wy
S % For Group Contact lists, if the list is long, only the first few names on the list are

1-" ﬁ;,.' printed and More... displays, to let you know that there are additional names
s that were not printed.
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Editing Contact Information

To open a contact for editing:

1. From the Contacts area, right-click the contact to be modified and choose Edit
Contact.

[ A Adams, Alex |

[0 & Aja, flan (D szarch

[ & Bilat, Gayle C{ Advanced Search

[ A, Demouser, D. 3 New Email

[ A i, La@’

[ A Pattern,

[ A Zimbra, Zack [ TagContact 5
ﬁ Delete

ﬂ Move
1A Print

The Edit Contact form appears.

[ save oclose IE'[J ﬁDeIete [ -

£ Ajax, Alan
Personal ‘Work Home: Other Mokes
Last: | Ajax Job Title:
First: | &lan Companys

Middle: Address Book: | Contacts -
File &s: | Last, First -

Email and Instant Messaging

Email: | feedback@zimbra.com M Address: | Mone
Email 2:
IM Address 2: | None =
Email 3: Q
I Address 3t | None =
Add Photo

2. In the Edit Contact form, make any changes.

3. Click S e to commit your changes.
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To move a contact to another address book:

1. From the Contacts area, right-click the contact to be modified and choose Edit
Contact.

2. Select the address book where you want to move the contact using the Address
Book drop-down menu.

Address Book: | Contacts -

Contacts

Emailed Contacts

3. Click L1 |

Deleting Contacts

Any contact lists you create can be deleted. Contacts can be deleted in one of three ways:

ﬁ Delete

e From an address book, select the contact to be removed, and click on the

toolbar.

e Drag the contact name to the Trash folder.

ﬁ Delete

¢ Right-click on the contact and select

When contact names are deleted, they no longer appear in your address book and information
is not available from the name tool tips for the address auto-completion or from the address
search dialog in the email compose window.

-
.41 "f- If you delete a contact that was automatically added to your address book, the
-" v : contact is moved to the Trash folder. You cannot add the name back to your
ant address books until you delete the contact from the Trash folder.
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Sharing Your Address Books

You can share any of your address books. This is useful if your address books are for specific
categories of contacts and what other users to have access to the names. Depending on the role
you assign to the grantee, the shared contacts list can be view-only or can have full access
privileges to edit, add, and delete names.

To learn more about how to share your address books, see Chapter 15, Sharing Your Account

Items.
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8 Managing Your Calendar

This chapter explains how to...

e Choose a calendar view

e Create calendars

e View multiple calendars

e Import and export your iCal calendars
e Print a calendar

e Delete a calendar

The Zimbra Calendar lets you track and schedule your appointments, meetings, and events.

Displaying the Calendar View

To open the Calendar view, select the Calendar tab in ZWC. The Work Week view is the
default and is displayed when Calendar is opened the first time.

You can change which view is displayed when Calendar is opened from the Preferences >
Calendar tab.

You can change your view from the Calendar toolbar, to see activities for a day, work week,
full week, or month. Changing the Calendar view from the toolbar only changes the view for
that session.

Creating a Calendar

One calendar is created for you, and you can create additional calendars to keep track of
different type of functions. For example, you can create one calendar for work, one for
personal appointments, and one for company activities. Use the Schedule view the see
calendars side-by-side.
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To create a calendar:

1. Select the Calendar tab in the ZWC.

2. Either:

0 Right-click Calendars in the Overview pane and select New Calendar.

= News Calendar o Mew
Conencamss [
¥ Calenda - -
v E Cale =2 Mew Calendar
W 1 ukH (22 Link ko Shared Calendar
V¥ [] usH Check all

¥ ] zach S Clear Al

0 Right-click “4"" ¥ on the toolbar and select New Calendar.

[g New -

[-.4) Mew Emnail
‘9‘ Mew Contact
5, New Conlcact Group

E‘, Mew Appointrent
‘ﬁi Mew Task

| 4 Mew Page

E_J_ TMew Task List
£ New Motebook

The Create New Calendar dialog appears.

Create New Calendar

Marne: |

Color: | Blue -

[ Exclude this calendar when reporting Fresibusy times

[~ synchronize appointments From remate calendar

oK | Cancel |

3. Type the name of the calendar into the Name field.

4. Select a color for displaying the Calendar’s activities using the Color menu.
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5. Select the other options if necessary:

0 Exclude this calendar when reporting free/busy times. The appointments on
this calendar will not be displayed when you view free/busy times.

0 Synchronize appointments from remote calendar. When you select this option,
a URL field appears. Enter a valid iCal file URL for the remote calendar.

Create New Calendar

Marne: | Training Calendar

Color: | Pink. =

[T Exclude this calendar when reporting freefbusy times

¥ synchronize appointments From remate calendar

URL: |

OF | Cancel |

6. Click OK. The new calendar displays in the Calendar list.

(=4 Mew Calendar

¥ Calendars

v E Calendar

q: [ | Training Calm>

v E IS Holidays
W 53 Zach's Calendar

121



Z Zimbra Web Client User Guide

Adding Color to a Calendar

You can color-code calendars in your mailbox so that activities for that calendar always
display in the selected color. When you are looking at activities from all calendars in one view,

the color signifies activities on different calendars. There are eight colors available, and you
can use a color more than once.

Thu, Feb 21

7:30 AM |
Or. £ g:00 am

Sys. Admin
Course
Trammg Room

L0oPM  1:00PM
All-Hands Interview

Meeting
Conf, Room A I

5:00 PM

The above shows that gray, green, pink, and red calendars have activities on February 21, and
the pink calendar has an all-day event.

To select a color for a calendar:
e Select a color when you create a calendar.
e Select a color when you accept a calendar to share.

e Edit the calendar's properties to change the color.

Viewing Multiple Calendars

All of your calendars, including shared calendars, are visible in your Calendar list. Each

calendar has a check box to the left of its name. Check the boxes for the calendars you want to
view.
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Eriefcase Preferences

[lDekte 1 7] v [Fpay | workweek = wesk R Month 3 Schedule 52 Today 4

Thu, Feb 21 Fti, Feb 22
George Washington's Birthi
L 1
Dr. ¥ g;00 aM
Sys. Admin
Course:
Trainng Koom

1:00PM  1:00PM

All-Hands | Interview

Meeting
Conf. Room A

5:00 PM

[AMal Ak AddressBook [ Calendar | [£] Tasks 47 IM[Beta] = &[] Documents
~4 Mew Calendar Fanew v (@) Refresh
¥ Calendars 2005 Man, Feb 18 Tue, Feb 19 ‘Wed, Feb 20
¥ [ calendar George Washington's Birth
Iv E Personal
¥ [ Training Calendar
¥ [ UK Halidays St
¥ [ s Halidays
[ [ zach's Calendar, 2an 9:00 AM
¥ Rexiew Meeting
10 AM Conf. Room A
D Industry Mews
[ zimbra L 11:00 4M 10:30 AM
¥ Zimlets =| B Skaff Meeting
W Travel agent
@ e Moon
Z Flight status 12:00 PM
Ws Currency L Lunch with Mark
A 1PM
Y Finance
% Flickr
- 2PM
# 4 February2008  » W
s M T W T F 5 3PM
7 2 2% 30 3 1 2 :00eH]
Dertist Appt,
3 ¢ 5 6 T 8 9
Or. Smith
10011 12 13 14 15 4P
17 18 19 20 21 22 I3 .00 PM
24 25 26 27 2@ 29 1 SPM
2 3 4 &5 & 7 =]

The Work Week view is displayed by default, as shown above. You can change your view:

e For this session only by clicking options on the Calendar toolbar.

e For the default view using the Preferences > Calendar tab.

The views are as follows:

o E Day

Wiork Week

is one day's activities.

. displays Monday through Friday activities.
. = o displays seven days of activities.
o Select which day is the first day of the week view using the Preferences > Calendar
tab.
. 2] Month displays a month's activities.
Schedul
o afsehedie displays each calendar in a separate column.
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0 The All column is a color-coded free/busy indicator for the viewed calendars.
White indicates no activity. The deeper the red in this column, the more
overlapping appointments.

0 Move the mouse over the All column for tool tips that show which calendars
have activity scheduled within a time period.

Importing Your iCal Calendar

You can import iCalendars (iCal) calendars that are saved in the .ics format. iCalendars are the
standard for calendar data exchange over the Internet, and .ics is the standard format for

iCalendar information.
To import an iCal calendar:
1. Select the Preferences > Calendar tab.

2. Scroll down to the Import / Export area.

If wou are using another calendar pragram, you can impork your existing appointments by saving them in iCalendar {.ics) Format, See
dacumentation in that program For help saving in this Format.

ICS File: Browse..
Import ICS File

‘You can expart your appointrments in the standard iCalendar (.ics) Format, then import them into another calendar program. See
documentation in the other program For help in importing.

Export as | ICS File

Import:

Export:

3. Click Browse to locate the .ics file to import.
4. Click Import.

0 If you want to add this calendar to an existing calendar, select the calendar to
import into.

0 You can also create a new calendar.
5. Click OK.

Depending on the size of the .ics file, the import may take a few minutes.

Exporting Your iCal Calendar

You can export calendars in the .ics format.
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To export an iCal calendar.

Select the Preferences > Calendar tab.

2. Scroll down to the Import / Export area.

M it documentation in that program Far help saving in this Format,

ICS File: Browse..
Import ICS File

If ywou are using another calendar program, you can import your existing appointments by saving them in iCalendar {.ics) format, See

EHpOrE: i mentation in the other program for help in importing,

Export as | IC5 File

‘You can expart your appoinkments in the standard iCalendar [.ics) Farmat, then impart them inta another calendar pragram. Ses

Choose Folder

¥ Calendars
E Calendar
E Personal
E Training Calendar
E LK Holidays
E US Holidays

3 Zach's Calendar

o |

4. Select the calendar to export.

Opening training calendar.ics

‘fou have chosen to open

:ﬁ training calendar.ics

which is a: iCalendar File
from: http:f{dema?, zimbra,cam

]

What should Firefox do with this Fille?

Microsoft OFfice Outlook: {default) j

" Save to Disk

™ Do this automatically For Files like this fram now on.

[o]4 I Cancel

6. Click Save to Disk and click OK.

3. Click Export as .iCS File. The Choose Folder dialog appears.

5. Click OK. The Opening training calendar.ics dialog appears.
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7. Select where to save the file and enter a file name.

8. C(Click Save.

Sharing Your Calendars

You can share your calendars with other people in your office, with external guests, and with
the public. This can be useful if you maintain different calendars and want others to know
your schedule. When you share your calendars with internal users, you can select the type of
access the internal users can have, either manager which gives full access to view and modify
the calendar, or viewer, which gives read-only access. External guests and the public have

read-only access.

To learn more about how to share your calendars, see Chapter 15, Sharing Your Account

Items.

Printing a Calendar

You can print individual calendars in any of the views. The printed schedule includes present

and previous month calendar and meetings displayed per day.
If you view more than one calendar and then print that view:
e All schedules are combined on one calendar.
e The printed calendar does not specify the calendar's name.

To print a calendar:

1. Display any calendar view.

2. Click = on the toolbar. Your printer dialog appears, and the Calendar view to be

printed displays. The example below is a Day view.
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Zimbra Collaboration Suite 11568 0ud@demo2.zimbra.com
Thursday, February 21, 2008 February 2008 March 2008
Thursday S MT WTF = S MT WTF 8

1 2
3 45 67 8 9 2 3 4 5 6 7 ;
0 11 12 12 14 15 18

9 1011 12 13 14 18
17 18 19 20 21 22 23 16 17 13 18 20 21 22

24 25 26 27 28 29 23 24 25 26 27 28 29
30 31

7:30 AM - 8:30 AM Dr. Appt. (Dr. Lemare) [Accepted]

8:00 AM - 5:00 PM Sys. Admin Course (Training Room) [Accepted)]

1:00 PM _ 2:30 PM All-Hands Meeting (Conf. Room A) [Accepted)]

1:00 PM - 2:00 PM Interviess (Conf. Room B) [Accepted]

3. Click OK on your printer dialog. Close the Calendar Print view.

Deleting a Calendar
You can delete any calendar in your Calendars list, except your default calendar.
To delete a calendar:
1. Right-click on the calendar to be deleted.
2. Click Delete. The Confirmation dialog appears.

Confirmation

Are you sure you want to permanently delete the "Personal” calendar?

Yes ‘ Mo |

3. Click Yes.

The calendar is immediately deleted. There is no undo. However, the meetings that were

created from this calendar are not automatically deleted from invited attendee's calendars
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9 Scheduling Appointments, Meetings, and Events

This chapter explains how to...

e Create an appointment, meeting or event

e Use QuickAdd to quickly create an appointment

e Create recurring appointments or meetings

e Change an appointment or meeting

e Turn a message or a contct into a meeting request

e Respond to an invitation

Activities you schedule on a calendar are either appointments, meetings, or events.

e Appointments. An appointment is an activity without other people. When you
schedule an appointment, no email is sent to confirm the appointment. You can set
recurring appointments. QuickAdd can be used to quickly create an appointment.

e Meetings. Meetings are appointments that include other people. When you create a
meeting, you select attendees and send an email invitation to them. You can reschedule

meetings and set up recurring meetings.

e Events. An event is an activity that lasts all day. Events do not display as time on the
calendar-they appear as banner at the top of the calendar schedule.

All three types of activities can be entered in several ways. You can schedule an appointment

from any calendar view.

Creating an Appointment or Meeting
There are several ways to create an appointment in the ZWC:
e Using the QuickAdd Appointment dialog.
e Using the Appointment Details tab.

e Dragging and dropping a message from the Inbox to the mini-calendar.
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. A meeting includes other attendees. An appointment is scheduled for
.".*-. "' yourself only. The steps to create appointments and meetings are the same
] ‘% § with the exception of scheduling attendees-this step is not performed for
'j- - -" appointments. Therefore, follow the steps in this Participant Guide for both

creating appointments and creating meetings.

Opening the Appointment Details Tab

To use the Appointment Details tab to create an appointment:

E‘_New -

option is available from the New menu in any view, except the Preferences view.

e  On the toolbar, click the arrow on

and select New Appointment. This

[ g Mew =

[ g Menw Email

2'_ Mew Contact
| < biew ContaciGrowp |
< E Mew Appaintment >

3 Mew Task

|3 Mew Page

E Mew Address Book
[ Mew Calendar

E_j_ Mew Task List

£ ) Mew Notebook

This action opens the Appointment Details tab.

[ save | # cancel &P add Attachment A SpellCheck L Format v

[ appointment Detals £ Schedule F& Find attendees | [By FindLocations  (cf  Find Resources

Details Time

* Subject: | [~ Al day event
Locatmn:| Start: | 2/17/2008 @6 v |30 ~|AM -
Show as: | Busy 'l Mark as; | Public End: | 2/17j2008 @ 7w :/00%| AM ¥
Calendar: | Calendar - Repeat: | Mone -

Attendees:

Resources: ‘

derdona v Sitzp v 5 = v I E & | B J U | A0 - A - — =
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Opening the QuickAdd Appointment Dialog

The following three methods open the QuickAdd Appointment dialog.

e Right-click on either the mini-calendar or the start time in one of the calendar views.

You can select to create a New Appointment or a New All Day Appointment.

# 4 February 2008 » B
S M

- . _ \
27 28
3 4 {53 Mew Appointrznt >
10 11 1z

1313}S
24 25 2
z 3 4

¢ Within an email message, certain text is interpreted as a date and triggers the ability to

right-click to create an appointment. Text such as today, tomorrow, a day of the week,
or an exact date are highlighted in messages.

0 Hover the mouse over this type of text to see if you have an appointment
scheduled.

0 Click on the highlighted text to open your calendar.

Subject: Re: Flight Plan

¥ Sent By 2y Sam Sample On: December 28, 2007 12:59 PM
To: 1156Boud@demo?. zimbra.com

I'll be arriving on W& 852 or

4 4196 in the morning (arriving 11:00am PST on
September 2Elth?
Tha nlan is tn - tLrn rewt wodt

on UaA 7 in the morning (arriving 11:00am PST
iday, September 07 |in mid-day (arriving 1:30pm PST on June
Mo APRD afternoon {arriving 5:00pm PST on June

s in stone yet,

Enter appointments directly on the calendar. In any calendar view, except Month,
either:
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0 Click on the start time and drag through the end time.

Tue, Feb 19

9:00 A

Review Meeting
Canf. Room A

11:00 &M

1Z:00PM
Lunich with Mark

1:00 PM
New AppuintmeI\t

0 Double-click the start time.

The QuickAdd Appointment dialog opens.

QuickAdd Appointment

*Subject: |

Location:

Show as: | Busy Mark as:

Zalendar: | Calendar

I
4

Start Time: | 2/19/2008 |Z|@| 1w o0 v v

End Time: |2,l'19,|'2008 |3@| 2w | ;| oo ” PM |

I

Repeat: | Mane

More Details. .. oK | Cancel

Creating a QuickAdd Appointment

All of the options previously described open the QuickAdd Appointment dialog.
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QuickAdd Appointment

*Subject: |

Location: |

Show as: | Busy - Mark as: | Public -
Calendar: | Calendar hd

Start Time: | 2/19/2008 j@ 1 v| oo v| M v|
End Time: | 2152008 j@ = v| oo v| M v|
Repeat: | None -

Mare Details. . Ok | Cancel |

To create an appointment using the QuickAdd Appointment dialog:

1. Specity the following information:

0 Subject. Brief description of the meeting. The text added here becomes the
description in the calendar.

0 Location. Where is the meeting? If the location is in the company directory,
when you start to type, locations that match are listed. You can also go to the
Find Locations tab to search.

0 Show As. Determine your Free/Busy options for this appointment. This
information displays on the Schedule Attendees page.

Show as: | Busy

Calendar: | Free
Tentative
katt Time: [
Busy

End Time: [ out of Office

0 Calendar. Show all calendars in your Calendar List. The first calendar displayed

is your original Calendar.

Zalendar: | Calendar
Start Time:  Calendar
Personal
End Time: Training Calendar
Repeat: LK. Halidays
LIS Holidays
ar— Zach's Calendar
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0 Mark as. Mark an appointment as private or public. Details about events that
are marked private do not display in a grantee's shared calendar. Only the start
and end time, duration, reoccurrence information, and the organizer's identity
are shown in the shared calendar.

Mark as: | Public =

Public

Privake
'l L0

0 Start Time and End Time. Define the start and end day and time.

0 Repeat. Define how often this appointment occurs.

Repeat: | Mone -

Mane

= Details. . Ewary Day

Every Week

Ewery Month

Ewery Year

0 More Details. Opens the Appointment Details tab if you want to specify
additional appointment information, such as Attendees and Resources. This is
optional. Use of the Appointment Details tab is described next.

]9

2. Click

Creating a Meeting Using the Appointment Details Tab

This section describes how to schedule a meeting using the Appointment Details tab,
including using the following:

Details area

e Time area

e Find Attendees tab

e Schedule tab

e Find Locations tab

e Find Resources tab
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To schedule a meeting from the Appointment Details tab:

i Mew

1. Click the arrow on in the toolbar and select New Appointment. This
option is available from the New menu in any view, except the Preferences view.

[ New ~

[ gl Mew Email

g, Mews Contact

%}_ Mew Contact Group

< F.‘_ Mews Appointrent >
TR |

|4 Mew Page

E Mevs Address Book
53 MNew Calendar
E_g Mewvy Task List
£ )l New Notebook

The Appointment Details tab appears.

[ save | 9 Cancel &P add Attachment 7 Spell Check L Format -

Details Time

* Subject: | ™ All day event

Calendar: | Calendar - Repeat: | Mone -

[ appointment Details  [£2  Schedule Eg Find Attendees | [Bh  Find Locations  {cf  Find Resources

Location:| Start: | 2/17/2008 j@ 6 >
Show as: | Busy - Mark as: | Public - End: | 2/17/2008 j@ 7|

Attendees:

Resources: |

— 1=

— 2=

Verdana » 3(l2pt) » § -

[T
a4

2. Specify the following information in the Details area:

Details

* Subject; | Training Rewview

Location: |Cc-nF. Room ©

Show as: | Busy - Mark as: | Public -
Calendar: | Training Calendar +
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0 Subject. Brief description of the meeting. The text added here becomes the

description in the calendar.
0 Location. Where is the meeting? Either:

0 Type the location. If the location is in the company directory, when you start to

type, locations that match are listed.

0 Go to the Find Locations tab. Use of the Find Locations tab is described later in
this chapter.

0 Show As. Determine your Free/Busy options for this appointment. This
information displays on the Schedule Attendees page.

Show as: | Busy

Calendar: | Free

Tentative

tart Time: [
Busy

End Time: [ Out of Office

0 Mark as. Mark an appointment as private or public. Details about events that
are marked private do not display in a grantee's shared calendar. Only the start
and end time, duration, reoccurrence information, and the organizer's identity

are shown in the shared calendar.

Mark as: | Public

Public

Private

v | o

0 Calendar. Show all calendars in your Calendar List. The first calendar

displayed is your original Calendar.

Calendar: | Calendar

otart Time: Calendar

Personal

Endiiv=; Training Calendar
Repeat: UK Holidays
US Holidays

Zach's Calend.
re Dekails, , A -alEnaar

3. Specify the following information in the Time area:
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Time
[ all day event
211

Start: | 2/15/2008 j@ AR RANERS

End: | 2{19/2008 ~ @z -| | oo .| P .|
Repeat: | None -

0 All day event. Select this option to make this appointment an all day event.
Events do not display as time on the calendar, they appear as banner at the top
of the calendar schedule

0 Start Time and End Time. Define the start and end day and time.

0 Repeat. Define how often this appointment occurs.

Repeat: | Mone -

Mone

= Details.. Every Day

Every Week

Every Month

Every Year

4. Specify the following remaining information:
0 Attendees. Either:

* Type the email addresses of your attendees, separating addresses with a
semicolon (;). Names in your Contact list matching what you type
auto-display as you type.

=  Go to the Find Attendees tab. Use of the Find Attendees tab is described
later in this chapter.

0 Resources. Either:

* Type the email addresses of your resources, separating addresses with a
semicolon (;). Resource names in your Contact list matching what you type
auto-display as you type.

=  Go to the Find Resources tab. Use of the Find Resources tab is described

later in this chapter.
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0 Body. Type an email message that will be included in the appointment

invitation email

0 Options. Either:

5. Click

Click

& add Attachment

in the toolbar to include an attachment in the

appointment invitation email.

aﬁ Spell Check

Click

email.

B Save

in the toolbar to spell check the appointment invitation

Scheduling Attendees: The Find Attendees Tab

When creating an appointment from the Appointment Details tab, you can use the Find

Attendees tab to search for attendees using your address books and your company GAL.

To use the Find Attendees tab:

& |":Li_nd Attendess

1. Click in the Calendar view. The Find Attendees tab appears.

[ save 3 Cancel | & Add Attachment ag Spell Check J;g; Format -

[F]1 appointment Details [ Schedule E& Find attendees | [ Find Locations o} Find Resources

- Find Attend

Find: |alan Source: | Contacts - | Search |
Falder Mame Ernail | ‘Work Phone Home Fhane
Contacts Alan Ajax feedback@zimbra.com
Add Al Add Femove | Remove Al

- Attendees for this appointment
Folder Mame | Ernail | ‘Wark Phone Horme Phone
Contacts Sam Sarmple szample@zimbra. cam
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2. Type a name into the Find field.

3. Select which list to use from the Source drop-down menu. The options will include
your address books and the GAL (if your account is linked to a GAL).

4. Click Search.
5. Select the name(s) displayed.

6. Click either Add All or Add. Names are displayed in the Attendees for this
Appointment area.

[ save

7. When complete, click

Viewing Free/Busy Times: The Schedule Tab

After selecting your appointment attendees, you can use the Schedule tab to see the free/busy

schedules for attendees.

To use the Schedule tab:

| Schedule

1. Click in the Calendar view. The Schedule tab appears.

[Flsave 3 Cancel o add attachment dg Spell Check Jﬂlj Farmat =

[F] Appointment Details  F3]  Schedule E& Find sttendees | [Bh  Find Locations | {cf  Find Resources

[T &l day evert: Key
Start: | 2/19/2003 j@ j (30w | PM o [ Free M Eusy W Tentative
- ,72,1’19,1’2008 j@ ﬂ i [ [ urknown [ Out of Office
“Feb19,2008=1: 1 2z 3 4 5 & 7 8 9 10 11 12 1 2 3 4 5 & 7 & 9 10
All Attendees IIII II I I
Py Dan Demaouser IIII II I I
&L v |5am Sample ? II
£ | Alan Ajax ? II
L~ [

2. Use the Key area to determine the free/busy time for each attendee.

3. This column identifies the following:
o] i Indicates that an attendee has not accepted the invitation yet.

o & Indicates a location.
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0 {3 Indicates a resource.

Scheduling a Location: The Find Locations Tab

When creating an appointment from the Appointment Details tab, you can use the Find
Locations tab to search for locations using your address books and the GAL (if the GAL is
linked to your Zimbra account).

To use the Find Locations tab:

I8 Find Locations

1. Click in the Calendar view. The Find Locations tab appears.
[Fisave 3 cancel o add attachment ég Spell Check. Jﬂlj Farmat =
[F] Appointment Detals 2] Schedule Fg Find attendees  [By  Find Locations | {cf  Find Resources
~Find Locations
Mame: | Site: | Search
Minimurn Capacity: | Building: |
Motes: | Floor: | [T allow multiple locations
Marme | Locakion Conkack | Capaciky |
Select: Remaove
- Location{s} for this appointment
Marme Locakion Conkack | Capaciky |
Conf, Room C

2. Type a search value into one of the fields. For example, type a location name into
the Name field or type a site name into the Site field.

3. Click Search. Locations matching your search are displayed.
4. Select a location displayed.

5. Click Select. The location appears in the Location(s) for this appointment area.

E Save

6. When complete, click
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Scheduling Resources: The Find Resources Tab

When creating an appointment from the Appointment Details tab, you can use the Find

Resources tab to search for resources using your address books and your company GAL.

Examples of resources include projectors and other electronic equipment.

To use the Find Resources tab:

1. Click .o} Find Resources

in the Calendar view. The Find Resources tab appears.

[ save 3% Cancel

& add Attachment

a&Spell Check ,!;B’Format -

E Appoinkment Details ﬁ Schedule

Eg Find Attendees  [B5  Find Locations \tF  Find Resources

- Find R es

Narme: ||

Motes: |

Contact: |

Mame Location

Site: |

Search

Building: |

Floor: |

| Contack

Add Al Add Remove | Remove Al

-~ Resources for this appointment

Mame Location

Contack

Type a search value into one of the fields. For example, type a resource name into

the Name field or type a site name into the Site field.

Click Search. Resources matching your search are displayed.

Click either Add All or Add. Names are displayed in the Resources for this

2.
3.
4. Select the resource(s) displayed.
5.
Appointment area.
6. When complete, click S ,
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Wy
.‘1 % If you are adding an appointment to a shared calendar, you may need to

1-' @" refresh the screen to see the appointment.
*unt

Scheduling an All Day Event

To schedule an all day appointment, which is called an event in the ZWC, use the
Appointment Details tab.

To schedule an all day appointment:

1. Select the All day event option on the Appointment Details tab.

[ save | 3% Cancel ¢ Add Attachment ag Spell Check K';E Farmat +

]  appointment Details 2] Schedule E& Find Attendess | [ FindLocations | {cf  Find Resources

Details me

* Subject: | [ all day even

Location: | Start: ,W j@ 6= s v]am~
Show as: | Busy v| Mark as: | Public - End: ,Wj@ M 100 w | AM w
Calendar: | Calendar - Repeat: | Mone -

Attendees:

Resources: |

— 1

— 2=

I
¥

B I U s~ &~ — =

Yerdana v 3i{lzpt) v § -

(i
q

If you are using the QuickAdd Appointment dialog, click the More Details button. This will
open the Appointment Details tab from which you can select the All day event option.
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QuickAdd Appointment

*Subject: |

Lacation: |

Show as: | Busw - Mark as: | Public =
Calendar: | Calendar -

Start Time: | 2/19/2008 j@ pow| oo v Em v
End Time: | 2/19/z008 j@ 2| o0 em~|

Repeat:

Mone

Mare Details., .. (0] ‘ Cancel |

Creating a Recurring Appointment

Recurring appointments are appointments that repeat on some sort of schedule. You can
schedule recurring meetings to repeat daily, weekly, monthly, or yearly. In addition, you can
customize recurring appointment schedules.

To create a recurring appointment:

1. Select an option from the Repeat drop-down menu on either the QuickAdd
Appointment dialog or the Appointment Details tab.

Repeat: | None -

Mane

= Details, . Every Day

Ewvery Wiesk

Ewery Month

Every Year

Cuskomize

The link appears.

Cuskomize

2. Click to display the Custom Repeat dialog.
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Custom Repeat

- Repeat

Weekly -
= Every weeks on

Tsom T rMon WTue Twed T Tho T Fri [ Sat,

-~ End
(+ Mo end date,

" End after occurrencels),
¢ End by 2/12j2008 B

3. Select options from the Custom Repeat dialog as necessary.

0 Repeat. Use this drop-down to specify the frequency of the meeting: daily,
weekly, monthly, or yearly. The remaining fields in this dialog change based on

the repeat frequency selected.

0 Daily. Customize daily repeats.

Daily -

{+ Every day.
= Every weekday,

{~ Ewery days,

0 Weekly. Customize weekly repeats.

Repeat

(o Evervweeks an

Tsun TMon WTue T wed T Thu T Fri T Sat.

0 Monthly. Customize monthly repeats.

- Repeat

Monthly «

& Day|l2 of everylzlmonth(s).

(8 The| first || Tuesday |0F everyll |m0nth(s).
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0 Yearly. Customize yearly repeats.

- Repeat

Yeatly w
(" Ewery vear on| February = || 12 g

{~ The| First v| Tuesday "|DF every | February v|.

0 End. Specify the end date and other information.

(8]4

4. Click

Changing an Appointment or Meeting

You can change any meeting or appointment, including the date, time, attendees, frequency (if
repeating), at any time. If you created a recurring meeting, you can change one occurrence or
the series of meetings. An email is sent to attendees to update the meeting details.

There are two ways to change an appointment:
1. Double-click on the meeting you want to change.

2. Right-click the meeting you want to change and select Open.

1:30 PM - Train Accent
- | Tentative
Decline
Edit Reply 3
ﬁ Delete
D Tag Appoinktment  #

If you are opening a recurring meeting, the Open Recurring Item dialog opens.
Use this dialog to either change this single instance of a recurring meeting or to change the
entire series.
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Dpen Recurring Item

"Training Fevew" is a recurring appointrment. YWould wou
like to open only this instance or the serigs?

" Open this instance

= Open the series

K | Cancel |

3. The Appointment Detail tab appears. Change any information necessary and click

E Save

4. Select whether to open only the selected date or to open the series. The
Appointment page opens.

5. Make your changes. You can change the schedule, the attendees, add an
explanation in the Text field and add an attachment.

6. Click OK. An email is sent to the attendees.

Deleting an Appointment or Meeting

If you created a meeting, you can cancel or delete it. If you created a recurring meeting, you
can delete one occurrence or the entire series of meetings. An email is sent to attendees to
inform them of the cancelled meeting.

Wy . . .
.‘1 % Only the originator of an appointment can cancel the appointment. Attendees

,-' & ,.' can cancel the appointment on their own calendars, but attendees cannot cancel

* . .
ant the entire appointment.

Deleting a Meeting

You can delete a meeting in two ways:

1. Right-click on the meeting in any calendar view and select Cancel.
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E Open

Accept
Tentative
Decline

“= Edit Reply

»

[T T=reroointment  »

2. Click a meeting in a calendar and click

ﬁ Delete

in the toolbar.

If you are canceling an appointment, a confirmation dialog appears.

Confirmation

Are you sure you want to delete this appointment?

Ves |

ilu]

3. Click Yes to cancel or delete the appointment. The appointment is immediately

removed from your calendar. You cannot undo the delete.

If you are canceling a meeting, a different confirmation dialog appears.

Confirmation

Do you want to edit the appointment cancellation message?

es |

s}

| Cancel ‘

4. Click Yes to edit the email sent to attendees. Edit the email as necessary, and click

Send to send the cancellation message.

The appointment is immediately removed from your calendar. An email is sent to

the attendees, and the appointment is deleted from their calendars. You cannot

undo a delete.
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Deleting a Recurring Meeting

There are two ways to delete a recurring meeting;:

1. Right-click on the meeting in any calendar view, select Instance or Series, and select

Delete.
1:00 PM | =] open
Training Revew
E Instance »
Accepk
% ] seties  » _

Tentative
Decline
Edit Reply 3

[ Celete
(] Tang Appedfiment  »

I
2. Click a meeting in a calendar and click I Delte

where you can specify the instance or the series.

Delete Recurring Item

"Training Revew" is a recurring appointment. Would you
like to delete only this instance or the series?

{+ Delete this instance
i~ Delete the series

(0’4 | Cancel |

3. Select whether to delete the instance or to delete the series, and click

confirmation dialog appears.

in the toolbar. A dialog appears

CIE

A

4. Click Yes to delete the meeting instance or series. The appointment is immediately
removed from your calendar. An email is sent to the attendees, and the appointment
is deleted from their calendars. You cannot undo a delete.

Printing an Appointment or Meeting

To print appointment and/or meeting information, refer to Printing a Calendar in Chapter 8.
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Creating a Meeting Using Drag and Drop: Turning a Message
or Contact into a Meeting Request

You can quickly create a meeting request by simply dragging and dropping a message,
conversation, or contact to a date on the mini-calendar. When you drag and drop a message
or conversation, the information in the message is used to populate many of the fields on the
Appointment page.

e The Subject of the appointment is the subject of the message.

e The attendees are the email addresses in the To and Cc fields of the message or for
conversations, the most recent message in a conversation. When you drag a contact

from your Contacts list to the mini-calendar, the contact's first email address is added
to the attendee field.

e The text of a message or the text of all messages in a conversation thread becomes the

text of the invitation. Message attachments are not attached to the appointment
request.

Turning a Message or Conversation into a Meeting Request
To turn a message or conversation into a meeting request:

1. Click on a message or conversation and drag it to a date on the mini-calendar.

4 March 2008+ W ToT GIEE] SEammpeE ST aE T, 2O S, ot
S M T W T F 5
Hi Gayle A

23250 26 27 [ L Q Donna, Sam End-User Project - Hi Gayle & Sam, I finished my deliverables eatly (3)  Mar03
2 3 4 5 b7

I finished mwy deliverables early, so I will plan to present at our meeting on Thursday.
9 10 11 12 13 14 1S

16 17 18 19 20 21 22
23 24 25 26 27 28 29
W 3N 1 2 3 4 5

Thanks for organizing, Gayle.

Lonna

The Appointment Details tab appears.
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[ save | % Cancel @7 Add Attachment ag Spell Check J;E Format =

Details

Location: ‘

Resources:

E Appointment Details

ﬁ Schedule E& Find Attendees E Find Locations  {c;  Find Resources

Time

* Subject: ‘Re: Flight Flan

[T all day event

Start: | 24202008 j@ 12 v |: 30 | PM =

Show as: | Busy - Mark as: | Public + End: | 2j20/2008 *|@|1 | : 30 * | PM
Calendar: | Calendar - Repeat: | Mone -
Attendees: [ 5o Sample

Verdans + 3({l2pt) v § ~

— 1
— =

i
4

B I U .0~ &~ — =

Hi Dan,

Tl be arriving on UA 852 or ACA 4196 in the moming (arriving 11;00am PST on
September 28th)

I'm flying home on UL 8212 in mid-day (arriving 1:30pm PST on September 20th)

The nlam im fo reties ok vmar sem LA T s b mesersise Careivimes 11 Ofaems DCT ~e LI

2. Review the meeting request details and make any necessary changes.

3. Click

[ save

. A meeting invitation is sent to all attendees.

Turning a Contact into a Meeting Request

To turn a contact into a meeting request:

1. Click on a name from your Address Book list and drag the name to a date on the
mini-calendar.

“ oA February 2008 » »

S M T W T F 5
27 28 29 3 3 1 2

i 4 5 & F & 9
1n 11 12 13 14 15 16
(17 18 (19| 2 ler 22

24 25 26 230 ioAjay, Alan
2 3 4 5 B 7 8]

The appointment page opens with the contact name in the Attendees field.
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[Pl save 3 Cancel & add Attachment 2 spell Check | LfY Format

] Appointment Detalls ﬁ Schedule F& Find Attendees E Find Locations o} Find Resources

Details Time

* Subject: | ™ all day event

Lacation: | Start; ,Wj@ ﬂ H MM
Show as: | Busy '| Mark as; | Public ~ End: ,Wj@ g MM
Calendar: | Calendar - Repeat: | Mone -

Attendees: [valan e’ <Feedback@zimbra, coms

Resources: |

Werdana v 3(lZpt) v § =

i
a
iT
1]
Ii¥1

BIU &8~ A~|— v

2. Finish the meeting request details: add a subject, select a time, add more attendees,
etc.

. 3 TR PP
3. Click Ll save . A meeting invitation is sent to the contacts.

Responding to a Meeting Invitation

When you receive an email notification for a meeting, the meeting is added to your calendar
and marked New. You can quickly respond to the invitation either from the email Inbox or
from the Calendar List pane.

To respond to a meeting invitation:
1. Open the message that contains the meeting request by either:
2. Clicking on the invitation email in the Inbox.

3. Right-clicking the appointment in the Calendar List pane and select New. The
meeting invitation appears.
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w7 decept v 7 Tentative v 3¢ Dacline -

Subject: Training Deliverables Review
¥ SentBy: &y "Donna Brown'" <dbrown@demo, zimbra.com=> On: February 26, 2008 4:11 PM

To: "ssample" <ssample@demo. zimbra.com>

The following is a new meeting request:

Subject:  Traning Deliverables Review

Organizer: "Tionna Brown" <dbrown@demeo. zmmbra. com=

Location: Conf Room 2
Time: Thursday, February 28, 2008, 3:00:00 PI - 4.00:00 P GMT -08:00 TU3/Canada Pacific

Invitees: "ssample”

Hi Sam,

Let's mest to review the training deliverables.

4. Select an action. There are three actions:

Accepk = .
o] & Accep Accepts the meeting.
'? Tentative - . . .
o] Shows the meeting in orange in your calendar.
% Decline « .
o] Removes the meeting from your calendar.

5. Click any of these actions to automatically send a reply to the meeting organizer
indicating your response, either I will attend; I might attend, or No, I won’t attend.

6. Click the arrow on the action and select Edit Reply to add comments to the reply
email. This is optional.

4 hocept W

4 Bocepk

4+ Edit Reply
S saera |

If the meeting is a recurring meeting, you have the option to reply for an Instance or
the Series.

To add comments when responding to a meeting invitation in Calendar List pane,
right-click the appointment and select Edit Reply.
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E Open
4 Arccept
? Tentative
3 Decline
o= ;
=3 Edit Reply » «# hccept
‘? Tenkative
ﬁ Deleke
9 Decling
D Tag Appointment  »
S E—

After you make your choice, the invitation is moved to the Trash, and New is removed from
the calendar notice. Declined appointments display on your calendar in a faded view, as a
reminder of the meeting you declined. You can delete declined message any time.

vy
A

o
1-" '“;..' If you would prefer to have the invitation email remain in your Inbox, change
as this preference on the Preference > Calendar tab.

To read the message or to see any attachments that may have been sent, click the meeting
notice.

Changing Your Response to a Meeting Invitation

If you decide to change your response to a meeting invitation, for example, if you want to
accept a previously declined meeting:

1. Right-click the meeting in your calendar.

2. Select Accept from the menu.

E Open

Accept
c? Tentative
Decline

23 Edit Reply »

ﬁ Delete

D Tag Appoinktment  »

An automatic response is sent to the meeting organizer to indicate that you have
accepted the meeting.
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10 Using the Preferences Tabs

This chapter provides a high-level overview of the features of each tab. You can
do such things as:

e Create away messages using the Mail tab
e Create email signatures using the Signatures tab

e Create additional email personas and link to external email accounts using
the Accounts tab

The key functionality for each of these tabs is covered in detail in other chapters
of this user guide. This chapter provides a high-level overview of the features
of each tab.

Your default user preferences are configured when your account is created. These options
define how your mailbox, address books, and calendar work. You can also set up your
personal email identities and POP accounts and select a theme for your mailbox.

You can change the default settings using the Preferences tabs. If an option described here is

not visible in your view, it is not available for your account.

Saving, Canceling, and Reverting Changes to Preferences

There are three things you can do on each Preferences tab:

Click LE152v8

o in the toolbar to save any changes you made on the tab. This saves your

changes and returns you to your ZWC view.

e Click L SE in the toolbar to cancel any changes you made on the tab. This cancels

your changes and returns you to your ZWC view.

. Revert This Page || .
e Click in the top right corner of any Preferences tab to reset any

changes for that page to your last saved settings.

This revert feature does not affect changes to passwords.
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You can navigate to different Preferences tabs, making changes on multiple tabs, before you

. S
click |5 or # Cancel

General Tab

Login using: ¢ Advanced (Ajax)
 Standard (HTML)

Theme: | Sand =
Language: =S English (United States) v

Default Timezone: | GMT -08:00 US/Canada Pacific -

Change Password

Search Settings: [ Include Junk Folder in Searches

[™ Include Trash Falder in Searches

Search Language: [ Show advanced search language in search toolbar

Settings: [V Display checkboxes to quickly select items in lists (requires refresh)

Use the options on the Preferences > General tab as follows:
e Login using. Defines your default Client Type at log in.

e Advanced. Offers the full set of Web collaboration features. This Web Client works

best with newer browsers and faster Internet connections.

e Standard. Recommended when Internet connections are slow, when using older

browsers, or for easier accessibility.
e Theme. The background color for your mailbox interface.
e Language. The language used to display the text in the ZWC.

e Default Time zone. The default time zone for your account. This determines the date
and time for messages that you send or receive and the time to display for Calendar
appointments. This can be different from your computer time zone configuration.

e Change password. Used to change your password. If you have trouble changing your
password, or if this button is not displayed, contact your administrator for password

help.
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e Search Settings. Check Include Junk Folder in Searches and/or Include Trash Folder
in Searches to include these folders in any search you perform. By default these folders

are not searched.

e Search Language. Check Show advanced search language in search toolbar to show
search string details in the search text box at the top of the ZWC window.

e Settings. Check Display checkboxes to quickly select items in lists (requires refresh)
to display a checkbox for each item in the Content pane. When this is enabled, use the
checkbox to select one or more items to perform the same action on, such as delete,

move, or mark as read/unread.

Mail Tab

Display: 100 =
Group mail by:  Message -

Check for new mail every: | 15 minutes =

Display Mail + As HTML (when possible)  { As Text

Message Preview: i Display Message Reading Pane
[¥ Display snippsts of messages in email list
¥ Double-click opens message in new window

Images: [V Download pictures aukomatically in HTML Email

Default Mail Search: ‘ insinbiox

When a message artives: Forward a copy to:

| enter emar aoaess

™ Don't keep a local copy of messages

™ Send a natification message to:

| enter email aditass

I Send auto-reply message:

Messages Ffrom me: Wwhen I receive a message otiginally sent by me

¢ Place inInbox ¢ Place in Inbox if I'min To: or Coi €7 Ignore message
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Setting an auto-reply message, also known as an away message, is a common task performed

by Zimbra end-users. This task is performed using the Mail tab. For steps on creating an auto-

reply message, refer to Chapter 6.

Use the options on the Preferences > Mail tab as follows:

Display. Select how many items (messages or conversations) to display per page. The
default is to display 25 items per page, but you can select 10, 50, or 100 items per page.

Group mail by. Select how you want to group your email, by conversation or message.

If you have the Conversation feature, Conversations is the default.

Check for new mail every. Select the polling interval, which is how often your
computer checks for new email. The default is every 5 minutes. The minimum length

of time is defined by your administrator.

Display Mail. Select As HTML (when possible) to display messages with HTML
formatting, for example, with bold, colored, or otherwise styled text. Select As Text to
display messages in plan text format. In plain text format, HTML tags are displayed,

not applied as markup.
Message Preview options:

0 Select whether to show the Reading pane when viewing messages. The default

is to always show the Reading pane.

0 Select whether to display snippets of messages in email list. When on, the first
line in the email is displayed when the cursor is over the subject of a message.
When off, only the first few words of the message are displayed.

0 Select whether a double-click will open messages in a new window.

Images. Select whether to download pictures automatically to your HTML email

message.

Default Mail Search. Defines the search to execute when you log in. The results of this
search are displayed in the Content pane when you log into your mailbox. The default
search is your Inbox. Therefore, when you log in, the results of your Inbox display. You
can change this field to have another folder, tag, or a saved search displayed when you
first open the Zimbra Web Client.
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¢ When a message arrives: Forward a copy to. Specify an address to which you want to
forward your email. Select the checkbox if you do not want to keep a copy of the

forwarded message in your mailbox.

0 Send a notification message to. Specify an address where you want to be

notified of new email in your ZWC mailbox.

0 Send auto-reply message. Use this to send an away message saying that you are
out of the office. Specify the text for the message using the field provided. Set
the Start and Stop dates for which this auto-reply message should be used.

e Messages from me. Use this section to handle messages you send that include your
address as one of the recipients of the message or that are included in an address, such

as a mailing list, that includes you.

Composing Messages Tab

% AsHTML Font: | Yerdana ¥ | Size: | 12pt ~ |l:u|or: M

C 5
OMPOSE! -~ ne Text

™ Always compose in new window

¥ Automatically save drafts of messages whils you are composing

Reply / Reply All: Wwhen replying to an email:

Include original message - |

Forward: \When forwarding an email:

Include original message - |

Prefix: Prefix included messages with:

@ ]

Sent Messages: (* 5ave a copy to Sent Folder
(™ Do not save sent messages

Additional composing options can be set on the Accounts Page

Use the options on the Preferences > Composing tab as follows:
e Compose. Select your default text editor, either HTML or plain text.

Set the default font settings to be used when using HTML to compose in Email,
Documents, and Calendar. You can define the font style, size, and color to use as your

default style. Verdana, 12 point black is the default.
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e Always compose in new window. When selected, a new compose window opens,
separate from your mailbox, when you compose a message. You can view and
navigate your mailbox while the compose window is open.

e Automatically save drafts of messages while you are composing. When selected,
drafts of messages are saved every few minutes. If you prefer not to have messages

automatically saved, disable the feature.

e Reply/Reply All. Select whether to include the original text in the body of your reply

message. You can choose:
0 Include original message
0 Don’tinclude original message
0 Include original message with the prefix below (either > or | )
0 Include original message as an attachment

0 Include last message only. Includes only what was written by the person who

sent the last message, and not previous text

e Forward. Select whether to include the original text in the body of a forwarded

message. You can choose:
0 Include original message
0 Include original message with the prefix below (either >or | )
0 Include original message as an attachment

e Prefix. Specify whether to prefix each line with > or | for email messages that are

forwarded or replied to, if you chose to include the original message text.

e Sent Messages. Specify whether or not to save a copy of sent messages in the Sent
folder. By default, the Save copies of messages to sent folder is enabled.
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Signatures Tab

Signature Name: | Drerno Clear
John Smith o
ACME Corp
jsmith@acme.com
(1231 555-1212] hd|

Add Signature

Place the signature: & Above included messages ¢ Below included messages

A default signature can be set on the Accounts Page

You can create signatures for your email messages. This is a task commonly performed by

end-users. For detailed steps on creating an email signature, refer to Chapter 3.

Your signature can include your name and additional closing text to the maximum number of

characters that your account allows. If you create multiple identities, you can create different

signatures and assign them to specific addresses.

Type a name that identifies the signature into the Signature Name field. You can create

multiple signatures, so using an identifiable name here is important.

1.

2.

Type the signature text into the text box exactly as you want it to appear.
Specify in the Using Signatures section where you want your signature displayed.

Select Above included messages to add your signature at the end of the your
composed, replied to, or forwarded text.

Select Below included messages to add the signature at the end of the message.

Click Add Signature.
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Address Book Tab

Display contacts per page: | 25 *
Default Yiew: | List ~

Settings: [¥ Add new contacts to "Emailed Contacts"

™ Auto-complete includss addresses in the Global Address List

Import: If you are using anather contact manager program, you can impart your existing cantacts by saving them in "Comma-Separated Values" {.csv) format,
See documentation in that program For help saving in this Format.

CSY File: I Browse. .. I
Impart (CSY File

Export; 10U can export your contacts in the standard "Comma-Separated Values" {.csv) Format, then impart them into another contact manager program. See
documentation in the ather program For help in imparting.

Export as .C5Y File

Use the options on the Preferences > Address Book tab as follows:

e Display contacts per page. Select how many contacts to display per page. The default
is to display 25 contacts per page, but you can select 10, 50, or 100 items per page.

e Default View. Choose to display contacts either in a list view or in business card view.

e Settings. Select Add new contacts to “Emailed Contacts” to automatically add
addresses to your address book when you send email. If this is enabled, addresses are

saved to your Email Contacts folder.

e Import/Export. Import contacts to and export contacts from your ZWC Contacts list.

The file to import must be in a comma-delimited format.
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Accounts Tab

Accounts
Account Mame | Skatus | Email Address | Type
Primary Account QK 114/z6nd@demoz. zimbra,com Primary
Delete | #Add External Account || #dd Persona |

Primary Account Settings

Email address: 114lz6nd@demoz, zimbra,.com

Account Name: ‘ Primnary Account|

Messages sent from this account have the following settings:

From: Choose the name that appears in the "From" Field of email messages

| Dan Demouser 114lz6nd@demoz. zimbra. com

Reply-to: [~ Set the "Reply-to” field of smai messages to:

.. Bob Smith Emal Address -

The Accounts tab is used to create and manage your personas and external email accounts.
Persona is the email identity used in the From field of email messages you send.

Adding external accounts and personas are tasks commonly performed by Zimbra end-users.
For detailed steps on these tasks, refer to Chapter 6.

Mail Filters Tab

ok Mew Filker | %y Edit Filter | E Delete Filker ? Move Up | Q. Mave Down
Ackive | Filter Mame
v Staff Meetings

Use the Mail Filters tab to define email filtering rules.

Refer to Chapter 5 for further information on creating and using filters.

163



Z Zimbra Web Client User Guide

Calendar Tab

Default Yiew: | Month Yiew -
Start week on: | Sunday -

[¥ Always show the mini-calendar

After responding to an invitation: [ Delete invite on reply

Show reminders: | 5 minutes before »

¥ Usz the Guickadd diglag when creating new appointments

™ Show timezone list in appointment views

If you are using anather calendar program, vou can impart your existing appointments by saving thern in iCalendar {.ics) farmat, See documentation in
that pragram For help saving in this Format.

ICS File: I Browss. .. |
Import .ICS File

Impork:

‘ou can export your appointments in the standard iCalendar (.ics) Format, then import them inko another calendar program. See documentation in the
other program for help in importing.

Export as .ICS File

Export:

Use the options on the Preferences > Calendar tab as follows:

Default View. Select how you would like to view your Zimbra calendar. The default is
by work week. The view options include: Day, Work Week, 7 Day Week, Month, and

Schedule.

Start Week On. Specify which day of the week should be the first day of the week in

your calendar.

Always show the mini-calendar. Specify whether the mini-calendar is displayed at the

bottom of the Overview pane.

After responding to an invitation. Specify whether to automatically delete invitations

from your Inbox after you respond to them.

Show reminders. Set the number of minutes before an appointment to be reminded.

The default is five minutes.
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e Use the QuickAdd dialog when creating new appointments. Specify whether to
create new appointments using the QuickAdd dialog. This is often helpful if you
create many appointments without attendees.

e Show time zone list in appointment view. Select if you often schedule meetings with

other in different time zones.

e Import/Export. Import and export iCalendars.

Shortcuts Tab

Keyboard Shortcuts

Shorkcut: List Mail Folder Shortcuts Saved Search Shortouts Tag Shortcuts

Shortcuts for All Applications

gl m Switch {"ga") ko Mai

gla Switch ko Contacts ("address book™)

g|c Switch to Calendar

gt Switch to Tasks

gli Switch bo Chat (“instant messaging”)

glo Switch ko Options

g|d Switch ko Documents ("notebook”)

n Create a new item (within the current application)

nm| or |c Mews message {'compose”)

C| | Mew message in a new window

Keyboard shortcuts let you use the application without going to the mouse. A large number of
shortcuts are available. You can also create custom shortcuts by assigning numeric aliases to
folders, tags, and saved searches.

e Shortcut List. Shows all the existing keyboard shortcuts.

e Mail Folder Shortcuts. Used to create a shortcut to quickly go to your email folders
and to move a message to that folder. You select the folder and assign a number to it.
For example, if you assign 3 to the Inbox folder: From anywhere in your mailbox,
typing v3 will move you to the Inbox. Selecting an item and typing .3, will move the

item to the Inbox.

165



Z Zimbra Web Client User Guide

e Saved Search Shortcuts. Used to create shortcuts to quickly access Saved Searches.
Select a saved search and assign a number to it. For example, if you assign 3 to your
favorite search, then from anywhere in your mailbox, you can type s3 to run that

search.

e The Tag Shortcuts tab is used to create shortcuts to quickly access all items with a
specific tag or apply a tag to a message or contact. You select a tag and assign a
number to it. For example, a tag called Follow up is assigned 3. From anywhere in
your mailbox, you can type y3 to see all items marked with Follow up. Select an item
and type t3 to tag that item with Follow up.

You can assign any number, but it cannot be repeated within a Shortcut tab.
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11 Using Task Lists

This chapter explains how to...
e Create a new task list
e Manage your tasks and task lists

You can use your task lists to create and track the progress of a task. In addition, you can write
notes within your task and attach files for easy access from within the task. Having all the
relevant information with your task is useful when you share your task list with others.

For simple task all you may need to do is create a task from the Content pane. If a task needs

to be managed, you can add more details, define a start and due date, set the priority to the

Creating a New Task List

There are two ways to create a new task list:

0 N -
53 ew in the toolbar and select New Task List. This option
is available from the New menu in any view, except the Preferences view.

1. Click the arrow on

E_J_ Mew Task Lisk

2. (Click on above the Task List display.
< Ej Mew Task List D
¥ Tasks

@ Tasks
E Training Tasks
E_;j Zach Zimbra's Tasks

Using either method, the Create New Task List dialog appears.
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Create New Task List

Marne: |

| (0] 4 || Cancel |

3. Enter a name for the task list in the Name field.

4. Select a color for the tasks on this task list.

Ik

5. Click The task list is displayed in the task list display. In the example
below, the new task list is Training Tasks, which is pink.

E_;', Mew Task Lisk

¥ Tasks

@ Tasks

< /maining Tasks

= 3

D

Creating a New Task

There are two ways to create a task:

1. Click ke Tesks on the toolbar and click

2. Click the arrow on

i Mew -

"Eﬁ,r\lew -

in the toolbar and select New Task. This option is

available from the New menu in any view, except the Preferences view.
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[ gl Mew
[ g Mevw Emnail
E,., Mews Conkack
&', Mew Contact Group
ﬁ Mew Appainkment
Mews Task,
g Mew Tas >

| g Mew Page

E", Mew Address Book
ﬁ Mew Calendar

E"‘, Mews Task, Lisk

£ ) Mew Motebook

The Tasks Details tab appears.

BSave eclose | &2 add Attachment | agSpell Check. | ,L:EFDrmat -

~Details ~Progress

* Subject: |Training Deliverables - | In Progress A | | 0% |

Lacation: | Start Date: | 2/6/2005 n

Proty: | Nomal ~ | Due Date: [2/18/2008 | + |
Task List: | Training Tasks -

— 1=
— 2

]
a4

I
b

|B I U|Am~ & ~|— -

Verdana * 3(12pt) * § -

3. Specify the following information in the Details area:

~Details

* Subject: | Training Deliverables

Location: |

Task Lisk: | Training Tasks - |

0 Subject. Brief description of the task. The text added here becomes the
description in the task list.
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0 Location. Where does the task occur, if applicable?

0 Priority. Select the priority for this task.

Priarity: | Marmal -

lask List:  Low

Marmnal
High
T ETEE S

0 Task List. Select the task list where you want this task displayed.

Task List: | Training Tasks -

Personal

Tasks

Training Tasks

Zach Zimbra's Tasks

Specify the following information in the Progress area:

Progress

[T | In Progress v| 0% -

Skart Dake: |2,I'En,l'2IIIIIIB - |
Cue Date: |2.l'18,l'2IIIIIIB - |

0 Status. Select the status for this task. You can reopen this task and change this
status at any time.

[ | 1n Progress -

Mok Starked

Completed

In Progress

Waiting on someone else

Deferred

0 DPercentage. Select a percentage to go with the status of the task. You can reopen
this task and change this percentage at any time.
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4. Define the start and end day and time for the task.

5. Specity the following remaining information:

0 Body. Type any notes to be included in the task list.

Options:
e C(Click
e C(Click
e Click

&2 add Atkachment

ag Spell Check,

[ save

in the toolbar to include an attachment for the task.

in the toolbar to spell check the task body.

Adding a Task Quickly

To quickly add a new task to a task list:

1. Open the task list to which you want to add a task. Double-click on the task list in
the Tasks area of the Overview pane to open a task list.

E_l New Task Lisk

ﬁNaw b

ﬁDeIete ﬂ' = -

<, Edit

E1-1oft =

T Tasks
E Personal
EI Tasks
E Training Tas
E?j Zach Zimbra's Tasks

|+

|_|Q| g |§|Sub]ect

& ko add a new Task
| Training Dphverables
ks ——

| Skatus % Complete

In Progress 0%

Due Date i

2/15/2008

2. Click Click here to add a new task.

3. Type a name for the new task and press Enter.

This adds the task subject to your task list, but it does not give any details. To add
details, edit the task.

There are two ways to edit the task information:

e Double-click the task.

e (lick the task and click

the information displayed and click

<, Edit

E Save

If you add or create a task in the wrong task list, either:

in the toolbar. The Task Details tab appears. Edit
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‘i’.#

N .
]
-

Open the task, and select the correct task list from the Task Lists drop-down.

Drag and drop the task on the Content pane to the correct task list in the Overview

pane.

»

You can use Zimbra Assistant to quickly add a task while working within an

email message, a meeting within calendar, or viewing a contact. When the task

tant

area. For more information on Zimbra Assistant, refer to Chapter 1.

Changing or Updating a Task

- %
"
¥o is created, any of the information that was available is added to the Task text

As you progress on a task, you may want to change its status and % complete information.

To update a task:

1.

Open the task list you want to update. Double-click on the task list in the Tasks area
of the Overview pane to open a task list.

W FiMew v < Edt [l Delete (% =1 [ - e 1-tafl e
¥ Tasks } |_| 0 | g |§| subject: Skatus % Complete | DueDate  ©
@ Fersonal Click here to add a new Task
EI Tasks ] Training Deliverables In Progress 70% 2j18j2008
E Training Tasks y/
ﬁZach Zimbra's Tay

Edit the task information using one of these two methods:

Double-click the task.

Click the task and click

Edit | .
“u Ed in the toolbar.

The Task Details tab appears.
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[ Mail & Address Book E Calendar EI Tasks ‘;_) IM [Beta] §=|] Documents Eriefcase Preferences

[ save | €I Close & add Attachment 2 Spell Check  LE Format -

Details Progress

-] [o% -

* Subject: | Customer Care Training Class [~ | Mot Started

Location: | Start Date: v

Priority: | Mormal PR EEE ,7 -
Task List: | Training Tasks -

— 1

verdana * 3(lzpt) v 5§ v = v | T 3T

B I U|sE~ &~ — v

i
¥

E Save

5. Edit the information displayed and click

Moving a Task

You can move a task to another list in one of the following ways:
e Using the Move option from the right-click menu
e Using drag-and-drop
e [Editing the task details

To move the task using the Move option:

1. Right-click the task and select Move.

FiMew » <, Edt  [fDelete % I [ +
r‘m‘i‘@‘Suhject

Click. here to add a new Task

Training Deliverables

W
| Custorner Care Training %y Edit

[] Tag Task »

The Move Task dialog appears.
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Move Task

Select the destination folder

¥ Tasks

EI Personal
El Tasks

@ Training Tasks

@ Zach Zimbra's Tasks

2. Select the task list to which you want to move the task and click OK.
To move the task with drag-and-drop:

Select the task to move, hold down the left mouse button and drag the task to the lists in the
Overview pane.

¥ Tasks I= E & | subject
EI Personal Click here to add a new Task
@ Tasks m . — -
E' Training Deliverables Training Celiverables
Traii .
— | Cuskomer Care Training Class
E.:PE Zach Zimbra's Tasks

To move atask by editing the task:

Open the task page and in the Task Lists field, select the task list.

BSave eclose | & add attachment | aﬁSpell Check | ,L:EFormat -

~Details Progress

* Subject: |Training Deliverables - | In Progress - | | 0% - |

Location:| Start Date: | 206/2008 -
Priatity: | MNormal = Due Date: | 2/18/2008 n

Task List: Araining Tasks

Personal

Tasks [
— L= = = —
verdand - Training Tacks v | 3D £ | B I U | sé(. A Brl— A | M
Zach Zimbra's Tasks
 —
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Deleting a Task

To delete a task from a task list:

1.

2. Select the task to delete and click

Open the task list containing the task you want to delete. Double-click on the task

list in the Tasks area of the Overview pane to open a task list.

E_l 151

ﬁNaw A

< Edt  [dDelete % =[] +

-0t =

Tasks

EI Personal

@ Tasks

EI Training Tasks
\E Zach Zimbra's Tasks

| v

o

|_|Q| E |§|Suh]ect

Click here ko add a new Task

Training Deliverables

| Status

In Progress

% Complete DueDate  ©

0% 2/18/2008

N

Delete the task using one of the following methods:

ﬁ Delete

on the toolbar.

3. Right-click on the task and select Delete. Click Yes in the Confirmation dialog.

ﬁf_mew hd

<, Edit

[0 Delete (% =1 [ -

-
-

|_| D| E |§| Subijeck

Click here to add a new Task

Training Deliverables

Cuskomer Care Training

<, Edit

(7] Tag Task »

T Delete

Sorting Tasks

You can sort tasks in a task list by subject, status, percentage complete, and due date.

To sort tasks:

1.

Open the task list containing the tasks you want to sort. Double-click on the task list
in the Tasks area of the Overview pane to open a task list.
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El Mews Task Lisk

PiNew v < Edt [l Delete % B0 [] - o 1-1afl o

/ Tasks
@ Personal

EI Tasks

@ Training Tasks

: E?j Zach Zimbra's Jhsks

| >

|_| ] | g |§| Subject Skatus % Complete | DueDate  ©
Click here ko add a new Task

(] Training Deliverables In Progress 0% 2j18/2008

2. Click on any of the following column headers to sort the tasks by that column:

(0]

(0]

(0]

(0]

Subject
Status
Percentage Complete

Due Date

Sharing Task Lists

You can share your task lists with other people in your office, with external guests, and with

the public. When you share your task lists with internal users, you can select the type of access

the internal users can have, either manager which gives full access to view and modify a task,

or viewer, which gives read-only access. External guests and the public have read-only access.
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12 Working in Documents

This chapter explains how to...

e Create notebooks

e Create and design pages using a rich text editor or using HTML
e Upload and link files and images to different pages

e Search through all notebooks, pages, and attachments

The Zimbra Documents application is a document sharing and collaboration application that
gives you a central place on the ZWC to develop and organize information. Images,
spreadsheets, and other rich Web content objects can be embedded into Document pages.

External documents can also be uploaded. The pages display in your browser.

Zimbra Documents is made up of notebooks with individual pages that are organized in a
table of contents.

Creating a New Notebook

By default, every ZWC account includes one notebook. You can create as many additional

notebooks as you need.

To create a new notebook:

B | -
1. Click the arrow on 53 hew in the toolbar and select New Notebook. This option
is available from the New menu in any view, except the Preferences view.
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[ gl New

[ 4! Mews Email

2,., Mew Contack

-&“‘, Mew Contack Group
ﬁ Mew Appaintrent

ﬁ Mew Task
| g Mew Page

E‘,' Mew Address Book
(74 New Calendar

E_rlg Mew Task List
| Mew Mokebook,
< L4 A

[ —

£ 4 Mew MNotebook

2. Click on == above Notebooks in the Overview pane.
< % 4 Mew Motebook /:>

¥ Mokeboo
okebonk,
School Nokes

Using either method, the Create New Notebook dialog appears.

Create New Notebook

Mame: |

Select where to place the new folder:

¥ MNotebooks

£ | Motebook
£ | School Motes

0 Enter a name for the notebook in the Name field.
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0 Select a color for the notebook.

0 Select the location for the notebook.

3. Click oK The notebook is displayed in the notebook area of the Overview

pane. In the example below, the new notebook is Training Notebook, which is pink.

£ Mew Nokebook

¥ Motebooks
£ [ Mokehook

<_§=|] Training Notebook >

Wy
*» % All notebook names must be unique within the hierarchy of your mailbox
- °

L
-' ,.' folders. Notebooks cannot have the same name as any top-level folder in your

Yunt Zimbra email, calendar, or address book.

Creating a New Page
You can create a page in a notebook. On any page, you can:
¢ Design the content layout using either rich-text format tools or HTML tags
e Check the spelling on the page
e Use keywords to easily create links to other pages

To create a new page in a notebook:

1. Open the notebook to which you want to add a page. Double-click on the notebook
in the Notebooks area of the Overview pane to open a notebook.

£ ) Mew

¥ Notebooks
i || Mokebook
|| School Motes
i || Training Mokehook

The table of contents page displays in the Content pane.
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| g Mew = Refresh . Edit  Import ﬁ'DeIete [% [ - [ 5end ﬁ a =

Training Notebook
by 117ndIm&@demoz .zimbra.com

Table of Contents

Document name Actions Modified by Modified on Version
. | g MEw -
2. Click on the toolbar. A blank page appears.
[Fsave [E €dCose & spell Check LE Format
Page: |Pagel
verdana v 3{lzpth v 5 v = » |2 12 £ ¥ | B J U
T T T 6B~ &l ~|— v |E @ & R

3. Enter the name for the new page in the Page field in the header. This name displays
in the table of contents.

4. Compose the content of the page. Later you can use either of the following to format
this page (instructions for both methods are described later in this chapter)

0 Default rich text editor to add styles, color, tables, and spreadsheets to your
page
o HTML tags

5. Click e to save the page. You can now proceed to format the page, or click

G Close

to return to the table of contents page.

Formatting a Notebook Page: Overview

You can compose your pages using either the rich-text editor to format the content on the page
or HTML source to format your page using HTML tags. You can switch between the two
formats to take advantage of the rich-text editor features and to insert tables and spreadsheets.
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Formatting a Page Using the Rich-Text Editor

When you edit using the rich-text editor, the two-row toolbar lets you easily format your page
layout. Select, change, or add the following;:

e Font sizes, faces, and colors
e Text styles

e Background colors

e Tables

e Spreadsheets

e Attachments

e Images

These formatting tools work the same as many word processing tools.

Page: | Training Deliverables - Customer Care

— 1=
— Fe

T T T, | oW~ &l ~ | — M

Yerdana * 3({12pt) = 5 -

-

I

i W

B I U
- @ &

ab
+a3c

Adding a Paragraph Style

Use the 8~

icon on the toolbar to view the available paragraph styles. The styles include:
e Normal for most paragraphs

e Headings (six levels) to identify section titles

e Address to make text italic

e Preformatted to use when you want to display text in Courier font

These styles cannot be modified, but you can use the editing options to format a style
differently. For example, you can change the font, size, color, etc.

Adding a Table to Your Page

Adding tables to your page is a three-part process: add a table, configure the table properties,
and then add content to the table.
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To add atable to a page:

1. Click EE= I on the toolbar. The table menu is displayed.

@ -
Eﬁ Insert Table 3

% Table Properties...
.:.$ Cell Properties .

=% Insert Row Ahove
. Insert Row Under

== [glate Row

§ Insert Column Befare

& Insert Column After

1" Delete Calumn

= Merge Cells

mm Split Cells

i Delete Table

2. Select Insert Table, and select how many rows and columns should be in the table.

-
f P
Eﬂ Insert Table 2 Ty 4 \
\
El Table Propettigs. ..
v

|:|$ Cell Properties. . h;;
=% Insert Row Above \

\
o Insert Row Under \\

S —

The table is added to the page.
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Flsave B €Icose & spel Check LE Farmat -
Page: | Training Deliverables - Cuskomer Care

Verdana v 3{izpt) » § v = v | Z IZ £ 22 | B f U

F T T AR~ Al - — LR

The following deliverables are reguired for the Customer Care training course:
Participant Guide

Slide Presentation

Job Aids

|
-
0 To set the table properties, click on the toolbar and select Table

Properties. The Table Properties dialog appears.

Table Properties

Description

Caption: | |

SUMNINEKY: |

Layout
 Auta

A
Table Width: m

Text Style

0
Texk Alignment: | Left = Font Colar: | Ar [ =
Wertical Align: | Middle - Font Background: &|— -

Border Style

Border Widkh: Botder Calar: . -

Padding Within Cells: Border Skyle: | Solid

QK Cancel

You can define table alignment and width; text style, including font color and table
background; and border style, including cell padding.

0 To set the cell properties, click on the toolbar and select Cell Properties.
The Cell Properties dialog appears.
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Cell Properties

~Border Style

Click to draw a border: Or pick a style below:

Style.: Color: Width: _ \:\ \;\ \:\ @
[soid - |[[AM - [T EEEERE
(B (o [[a] | w1 ==
BEE0E

~Layout

[T width: ™ Harizontal Padding:
™ Height: [ vertical Padding:

~ Text Style

[T Text Alignment: Mot Set = [ Font Calor: e[ =

[T wertical Align: Middle - [ Fork Background: Pg|— -

o ot |

You can define border style for the cell and layout and text styles, including font
and background color for a cell.

-

You can also click

on the toolbar to insert more rows and columns and
merge or split cells after you created the table.

After the table properties are set, click on a cell to begin to type text.

Adding a Spreadsheet to Your Page

To add a spreadsheet, click the spreadsheet icon it

on the toolbar. A six-column
spreadsheet is added to the page.

[Fisave [E] €3 Cose | 2 Spell Check L Format
Page: | Training Deliverables - Customer Care
Verdana * 3(lgpt) v § v = ‘|:: - = __|B I u
FTT M- & ~|— =~ Bu o G
-
G| BIZJU[E=[=[=][4C -] & -]
== == !EI El.l 1 | ¥ | Insert Function | | Text - | Auko decimals -+
(8 e B = D E F
1
Z
5
4
5
]
7
g
9
10 p—
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Spreadsheets can be used to create databases to keep track of lists of activities, schedules, tasks

to do, etc. The spreadsheet includes basic spreadsheet functionality and a set of predefined
functions.

Adding Attachments, Images, and Links to Your Page

You can upload files and images that link to the notebook page.

e (lick & to add a file.

e Click *t0 add an image.

e Click % to add a link. You can link to other notebook pages or to an external
Web URL. Give the link a descriptive title so the URL address does not display.

Browse to find the file or image to be uploaded, or enter a descriptive title for a link (this will

be displayed instead of the URL). You are notified if you upload a file that already exists in
your Documents.

Formatting Using HTML Source

If you know HTML, you can use HTML tags to create your content. All basic HTML elements
can be used.

To create pages in HTML:

1. Click Format on the toolbar and select HTML Source.

Save Close Spell Check ” Format -
[ L3

Page: | Training Deliverables - Customer Care

@ Rich Text
— HTML 5
Werdana * 3(lzpt) v § v = - | 1= IZ B I U ource

F T T | A0~ & - — ' w 2 & &

The following deliverables are reguired for the Customer Care training course:

I

i Wb

| »

Participant Guide
Slide Presentation
Job Alds

Sharing Your Documents Notebooks

You can share your notebooks with other people in your organization, with external guests,
and with the public. When you share your notebooks with internal users, you can select the
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type of access the internal users can have, either manager which gives full access to view,
create and edit the notebook’s content, or viewer, which gives read-only access. External

guests and the public have read-only access.

To learn more about how to share your notebooks, see Chapter 15, Sharing Your Account
Items.
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13 Briefcase

This chapter explains how to...

Create Briefcase folders

Upload any type of file to your Briefcase

Save attachments sent in email messages to your Briefcase

Work in files in Briefcase

The Briefcase application lets you copy files from your computer to your ZCS account. You
can access these files whenever you log in to your ZWC account from any computer and you

can share these files with other.

Note: Files in your Briefcase can also be accessed from a WebDAYV Client.

Creating Briefcase Folders
1. Click the Briefcase tab.

2. Click New Briefcase on the toolbar.
4 New Briefcase
=Y Al

The Create New Briefcase dialog displays.

3. Type aname for the new briefcase folder.

Create New Brielcase Folder

Marne; [ Team Project

Color: | Green = |
Select where to place the new Folder:

¥ Folders
B2 Brisfrase
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The briefcase folder name must be unique within the hierarchy of your all of
mailbox folders. This name cannot match any top-level folder in your mailbox,
calendar, or address book. For example, if you have a calendar named Holidays,
you cannot name a top-level briefcase Holidays. Holidays could be a name of a
briefcase within another briefcase.

4. Select the folder hierarchy, either under Folders or under another briefcase folder.
You can create a new top-level briefcase, or you can place it under an existing
briefcase.

5. Click OK. The new briefcase displays in the Overview pane.

Adding Files to Your Briefcase Folders

Uploading a file transfers a file from your personal computer to your ZWC account. This
makes the file available any time you log into your account. You can upload files in the
following ways:

e Clicking attachments you receive with your email messages
e Using the file upload tool when working in Briefcase
e Using WebDav Client tools

To upload files from Briefcase

1. Open Briefcase, select the Briefcase to save the file and then click Upload file on the
toolbar.

[y New Briefrass |3 New' = || | Upioad File
3 Folders al

2. In the Upload dialog click Browse to find the file to upload.

Upload New File to Briefcase

Choose one or more files to upload:

C:\Documents and Settings\candar Remove Add
If & file already exists with the same name: | Ask Me -

Replace With My File
Keep Existing File

=

3. To add another file, click Add.
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You cannot upload a file with the same name to the same briefcase. You can specify
on the Upload dialog how to files with the same name should be treated when you
attempt to upload the file. When you change this option, the change is saved in the
dialog.

0 If you want to be notified that you are uploading a file with the same name,
select Ask Me. If a file has the same name as an existing upload, the Upload
Conflict dialog displays. You can either keep your existing file or replace it
with the uploaded file. You can also view the new file. This the default.

o0 If you always want the file you upload to replace the existing file with the same
name, select Replace With My File. The new file is uploaded and replaces the
existing file. You are not notified of this.

0 If you do not want the files in your Briefcase to be replaced, select Keep Existing
File. The file is not uploaded and you are not notified.

4. When all files are uploaded, click OK. The file is displayed in the Briefcase.

Note: If you selected the wrong briefcase, you can use drag and drop to easily move the file to
the correct briefcase folder.

Your account may have a maximum size for upload files. If the file is too large, a warning is
displayed. Files that you upload impact your account quota.

To upload email attachments to Briefcase
Email attachments can quickly be added to your briefcase.

1. To add the attachment, click the add to briefcase link in the message header next to
the Attachments link.

Attachments: s buddy-ist-tree.gif (111.9 KB, mmniﬁw

2. Inthe Add to Briefcase dialog, select the destination folder or create a new briefcase
folder.

3. Click OK.

Viewing Files in Briefcase

You can select how to view your files in your Briefcase folders. On the Briefcase toolbar select
one of these options from the View menu.
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ED View -
Explorer Wiew
El | Detail Wiew
& ED Colurnn Browser Yiew

e Explorer View. Files are displayed as thumbnails.

i ?

Sunietphg Vo fra

e Detail View. Files are displayed in a horizontal line with the file size, date uploaded,

Conatray T, ..

i ] LG

owner, if a shared file this may not be you, and which folder the file is in.

] )] | Nore

i - Surset,png

0 & (3] tintrofm

B i) Conkacting Tmbes Support. padf
O | 7 costestess

Type Sie
PG Image 4EB
Unilncawn Binary 84 KB
Adche POF 102 KB
Test Documents 646 B

Date
Af2512008
10j26/2007
10j26/2007
10/25/2007

e
charrison
charrison
charrison
charrison

Folder
Eriefcase
Eriefoase
Eriefoase
Eriefease

e Column Browser View. Files are displayed vertically. In this view you can click on a
tile to see information about the file, including size, create date, creator, modified date

and modifier.

aMew = | L UpkadFle [ Delste (¥ ] -
. Sunset.png
| 7] PTO_req.pdf
|71 Ky words.doc
7] Managng.docx
MName
Path
Size
Created
Creator
Modified
Modifier

]

Friday, Apel 25, 2008
12:22:05 PM

2ackz@demo. zimbes com

Friday, Aprl 25, 2008
I222:05PM

2ackaiderns, simbea.com

In addition, you can view files using a Web Dev client.
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Working in Briefcase

In Briefcase, you can open files to work in them, move files, tag files and send an email with a

link to a file in your Briefcase.

pMew ~ |, Uploadfle  [JDelete (% | [ ~ | [ivew v [ Send

Opening files in Briefcase

You can open files in your briefcase from any computer. You must have the appropriate
software application to open and read or update the file. Common file formats such as text
tiles, HTML files, and images such as .gif or .jpg files can be opened in a variety of programs.

To open a file, right-click on the file and select Open.

If the type is unknown, a dialog displays asking what to do with the file, save to disk or open
with a specific application.

Moving files

You can move files from one briefcase to another.

1. On the toolbar, click m .
2. Select the destination folder or create a new briefcase folder.

3. Click OK.

Tag files
You can tag files.

-

1. Click on the file and on the toolbar, click 1D—
2. Select the tag.
3. Click OK.

Tags only display in the Detail view.
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Send an email with a link to a file

You can send an email that has a link to a file in briefcase. The recipients must have the
appropriate software to open the file and have permission to view the contents.

1. Right-click on the selected file. A confirmation pane opens. Click Yes to proceed.

Confirmation

In order for the recipient to view the links, ey must
hawve permission to view the contents of the containing folder.

Do you want bo send the links anyway?

2. A new compose email message opens with the link displayed in the body of the
message. Complete the email message and click Send to mail the message.

Sharing Your Briefcase Folders

You can share your Briefcase folders with other people in your office, with external guests,
and with the public. When you share your briefcase folders with internal users, you can select
the type of access the internal users can have, either manager which gives full access to view,
edit, and add files to the shared folder’s content, or viewer, which gives read-only access.
External guests and the public have read-only access.

To learn more about how to share your Briefcase folders, see Chapter 15, Sharing Your
Account Items.
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14 Searching Your Account

This chapter explains how to...

e Use Quick search

e Use the search syntax to create your own searches

e Use Advanced Search to easily create complicated search queries
e Save your search query

The ZWC lets you search messages, contacts, appointments, notebooks, pages, and files. You
can search by:

e Specific words

e Dates and time

e URL

e Filesize

e Tag

e  Whether or not a file has attachments or attachments of a particular file type
There are two mailbox search tools:

Search. This is a quick search that executes the search query displayed in the Search text box.
The drop-down arrow at the left of the Search box enables you to select the type of item for
which to search.

Advanced. This search opens a new pane and makes it easier to execute more complex
searches. You can save your advanced search queries and re-execute them at a later date.

Search Syntax

If you are familiar with text-match searches or word-processing features such as the
Find/Change in Microsoft Word, note that the content search in the Zimbra Web Client is
slightly different from performing a literal string match.
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Zimbra search syntax works as follows:

e Itis an exact text search. You can search for phrases, but each word within that
phrase is matched literally by whole-word only. Spelling variants are not allowed.
For example, if you search for bananas, messages with banana are not a match.

e Search is not case sensitive; South, south, and SOUTH are all the same thing.

e These special characters cannot be used in your search text. ~'!@ #$ % * & * () _-+

215"

e The asterisk * as a wildcard after a prefix is supported. For example, if you search
for do*, it returns items with the word dog, door, etc.

Searching for content will search the body of a message plus any (system-readable) file
attachments it may have. A system-readable file attachment is a type of file that can be
converted to HTML-viewable text. These attachments include Microsoft Office documents

(Word, PowerPoint, or Excel), as well as text files. You cannot search for image and audio files.

Using Quick-Search

The search feature is a powerful tool. It provides a quick shortcut to searching without
keywords. For example, to find all email containing the word tim anywhere in the Subject
line, To, From, Cc, or Bcc lines, message body, or file attachment, simply type tim into the

search box and click Search.

You can enter any value, such as a word, first name, last name, phone number, or domain
name. To search for contacts in your address books, the search field must contain a whole
word or number string. For example, to search contacts by phone number, you have to enter
the full phone number as it appears in the contact entry; you cannot search by the area code

alone.

To perform a quick search:

1. Enter the search query into the Search field.

[ Ernail v| Search | Save Advanced

2. Select one of the following options from the search type drop-down menu:

%7 All Ttem Types ) ) )
o to search all items in your mailbox
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O | [-d Emai to search email messages

Contacks .
= to search contacts in your personal address book

E Appoinkrnents

o to search appointments
7| Tasks
o &l to search your tasks
Pages and Files
o] ] Pag to search notebook pages and files

3. Click | search | .

Advanced Search Criteria

The Advanced search features opens separate mini-panes to perform different types of
searches. You can open multiple instances of each mini-pane. You might want to do this if you
are doing AND type searches.

Refer to the table below for advanced search criteria.

Criteria Description

Basic Search header information such as From, To, and Subject.
Search the content of messages and attachments for a
specific word or phrase.

Attachment Search for No Attachment, Any Attachment, or Specific
Attachment. If you select specific attachment, a list of
attachment types is displayed.

Date Search for messages received after, on, or before a selected
date. Open two Date panes to search between dates.

Domain Search for messages where the address headers
(From/To/Cc) contain addresses from certain domains. The
domains that you can search for are pre-defined with check
boxes.
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Criteria Description

Folder Limit search to selected folders only.

Saved Search Open a search query you previously saved.

Size Search for messages that are larger or smaller than a

specified size (bytes, KB, or MB).

Zimlets Search for messages or contacts containing URLs, phone
numbers, or other objects as defined by your administrator.

Status Search for messages or contacts that are flagged or
unflagged. Search for messages that are read, unread,
forwarded, or replied to.

Tag Search for messages or contacts that have a specific tag or a
specified set of tags.

Time Search for messages that arrived within a time-frame, such
as the last hour, this week, last month, etc.

Searching for Messages with Quick Search

To search for messages using Quick Search:

| [ Ernail v| Search | Save Advanced

1. Enter search criteria in the Search box. For example, enter a sender's name.

2. Select an option from the Search drop-down menu. Email is the default.
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[ Email = |

%4 Al Tkem Types

@ [ Email
E Contacks
=1 Appointments

E Tasks

i || Pages and Files

Search
3. Click ﬂ . Search results are displayed in the Content pane.

4. Click any tab on the menu to exit the search.

Searching for Messages with Advanced Search
To search for messages using Advanced Search:

1. Click Advanced to open the Advanced search area.

|| §=|] Pages and Files = | Search | ave anced
N ——

The Advanced search panes appear, with the Basic Search pane displayed.

& Attachment [Basic T Date ﬁ'ﬁ Domain [ Folder [ SavedSearch [ Size | Z Zinlets F Status (] Tag T Time  Remove Al chose
[ Basic Search g
Fram;
Toj Ce: ’7
Subject: ’7
Content: ’7

[" also search Junk

" also search Trash

2. Depending on your search requirements, click an icon in the toolbar to open the
appropriate pane. Each time you click an icon, another pane is displayed.

3. Enter information in the pane fields.

If you enabled Always Show Search String on the Preferences > General tab, the
search text box updates as you type or make selections.
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0 Search Execution. When you enter a criterion in a search pane, or as soon as you

have made any selection change in a search pane, the search executes. Therefore,
if you enter text in a field, the search executes. If you select a radio button, the

search executes. Etc.

Search Results. [tems matching the search criteria are listed in the Content pane.
If the Conversation feature is enabled, conversations containing messages that

match the search criteria are listed.

Search
4. Refresh. Click 4 to refresh the search results area.

|
5. Click Q o to exit the search.

Advanced Search Example

To search for a specific type of attachment file. A message with a news clip attached. You
don't remember who it's from or what date it was sent, but the filename has a .PDF extension.

. | Use Standard (HTML
Zlm bru attachment;"application/pd™ | [ Email ~ | Search | Save Advanced ‘ J Search the Web... 9" J 5H:I: ar (ﬂ] Li;eﬂri:n
Attachment Basic T Date 72 Domain || Folder Saved Search |~ | Size Zimlets Status Tag 53 Time = Remave Al Close
L2 =3 L2
& Attachments 0
= Mo Attachments
" Any Attachment
{+ Specific Attachment
" Specific Filename
¥ |5 Adabe POF
[ 7] application/name
[l |ba Image
I sl PrG Image
Dan Demouser [ Mail & Address Book E Calendar E Tasks ‘;’ IM [Beta] §=|] Documents Briefcase Preferences
L Mew Folder Mew v  GetMal | [ Delete % (=1 S Repk “yReplyto Al 5 Forward wnk | [+ View - 1-1
+ * = ]
¥ Folders - |—‘ ﬁ 1N |L7®| From |§| Subject |Fulder ‘Sizs | Recgived T
[ mbox ] & Zimbrain the Wall Street Journal - Hey Dan, Did you ever check out this article th Inboxe— 168KE 11/25/2007
R Chats

How it was done:

e Select Email from the search drop-down menu.

e Click Attachments in the Advanced search area to open just the Attachments pane.

e Choose Specific Attachment. A list of check boxes appears beneath the radio button.

Check the box next to Adobe PDF.

An email message is displayed in the search results area (the Content pane).

198




Searching Your Account Z

Using * as a Wildcard in Search

The asterisk * can be used as a wildcard in a search to find content with words that have
similar spellings.

Use the asterisk * as a wildcard after a prefix. For example, do* returns items with the word

dog, door, etc.

Saving a Search Query
If you create a search that you think you will want to use again, you can save it.
To save a search:

1. Create the search query, either by entering text in the Search bar or by creating a
query with Advanced search.

. Save |
2. Click in the Search area to save the search.
|| | §=[| Pages and Files - || Search | manced
_—

The Save Search dialog appears.

Save Search
Mame For the saved search

Select where to place the new saved search

¥ Folders

L3 E& Inbio
E% Sent

ﬁ Trash
Personal Emails
¥ Searches

E PowerPaint Attachment Search

| (04 || Cancel |

3. Enter a name for the search into the field.
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4. Select where to place the saved search. Searches are saved as a Searches folder in the
Searches section of the Overview pane by default, but you can select another folder.

Ik

5. Click

The saved search is displayed in the Overview pane.

Sam Sample

E]_ MNew Folder

¥ Folders

E Inbox (1)
Li.?) Sent

E/; Drafts {1}

Ea Junik,

ﬁ Trash

Perso

¥ Searches

Ei PowerPoint Attachme
¥ Tags
D End-lser Training

- Zimlets

To use a saved search, click the search folder. The search results immediately
display in the Content pane.

Search Examples

The different panes in the Advanced search area can be used to search by different criteria.
The following examples include which Advanced search panes you would use.

Here are a few possible search examples:

e To search for an attachment that may be one type or another. Messages with either
PDF attachments or JPEG attachments.
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Zimbra attachment:("sppication/pd” || emal v | search || save || advanced H [Fearchihewes.. || &Y J U@s? :tEaI:dard (%MLLI: l;reﬂrzi:n
o nttachment  []Basic TP Date § Domain [ Folder [ SavedSearch []See 2 Zimlets [ Status ] Tag SF Time  Remowe Al {9 Close |
& Attachments g
" Ma Attachments
" Any Attachment
& Speific Attachment
" Spedfic Filename
¥ |51 Adobe POF
[T 7] application/name
[V a4 Image
™ |aal FNG Image
Dan Demouser [-IMal AL AddressBook | [ Calendar | ] Tasks 7 M[Beta] | ] Documents Briefcase Preferences
L Mews Folder CoNew v  GetMal [ Delete [# [0 & Reph iReplytodl S Foward [glrk | ] v ] [dvew ¥ a2
¥ Folders it I—‘ F|E| ] ‘%| From |§| Subject ‘ Folder ‘ Size ‘ Recelved T
B2 1nbox ] 5] & searching within Zimbra - Hi, To search within Zimbra: 1, Click on "advanced" by | Inbox 166KE  12/3/2007
EE Chats ] Zach Zimbra &2 Zimbrain the Wall Street Journal - Hey Dan, Did you ever check out this articks b Inbox 168KE  11/25/2007
N -

How it was done: Select Email from the search drop-down menu. In the
Attachments pane, choose Specific Attachment and then check both Adobe PDF

and JPEG Image.

To search for a contact within a specific company. A contact who works at a company

[ )
called Zimbra.
Zlmbrﬂ content:(Zimbra) 8] contacts v| Search | Save || Advanced H Search the Web... &' J U@Sﬁj:zﬂam (%Mti;eéi:n
& pttachment [ ]Basic P Date G Domain [ Folder 7 SavedSearch [|Size 2 Zimlets I8 Status [ Tag SF Time | Remave Al €. Close
[ Basic Search =1
Frarm:
Tofca
Subert:
Content: [Zimbra
[T Also search Junk
" Also search Trash
Dan Demouser [AMal o AddressBook | [ calendar | [£] Tasks | &7 M[Beta]l | {_|Documents | [ Brisfrase Preferences
&} New Address Book LpMew v < Edt [ipelste {4 5 v ] v C|Vew ¥ Sl
'EM::‘:;:""S = al 123‘A|E‘C|D‘E‘F|G|H|I‘J|K‘L|M‘N|O|P|Q‘R‘S|T‘U|v‘W|>(‘V‘Z|
E‘ Emalled Contacts [T & zmbra, Zack . =
T rrash = EZ Zimbra, Zack Location: [& Contacts
W 4 February 2005+ W [ zzimbra@somectherdomainz com
S M T w T F s
B work
130 141 lSZ 163 174 185 195 555 . 310th Ave Work Phone: 602-555-5090
o Phoenix, AZ
How it was done: Select Contacts from the search drop-down menu. In the
Advanced search area, open the Basic Search pane. Enter Zimbra in the Content
field. (You could also do this search without using Advanced Search.)
e To search for an item that was tagged. Description of the new procedures for your

industry, which you had tagged as Industry News.
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8 = 1 Use Standard (HTML} version
tag:"Industry News" Al Ttem Types Search Save Advanced Search the Wab... ] J
Z" | Ibl’o ° v L Lis ‘ ‘ H 49 @help  <flLogout
&P Attachment [ _|Basic TS Date 7 Domain Folder (& Saved Search sizz 7 Zmlets [ Status ) Tag S Tme | Remove Al ) Close
) Tags (%]
¥ [ Industry Kews
T @ Zimbra
DaniDemouser; [AMail | A Address Book | [ Calendar E] Tasks “_) M[Beta] | £ | Documents Briefcase Preferences
L New Folder CjNew v  GetMal [Delete (% =1 [ + 11 =
¥ Folders = 0O ‘ F| ] ‘Q| From |§‘ Subject | Date
£ mbox O (] E Alan Ajax Zimbra Forums, Blog, and More. - Hey Dan, T have heen reviswing the v, zimbra, com site. In case 9/8{2007
==

How it was done: Select All Item Types from the search drop-down menu. In the
Advanced search area, open the Tags pane. Select the check box for the Industry
news tag. Note that tags are user-defined, so this assumes that you have previously
1) created the tag definition, and 2) applied it to objects in your mailbox.

e To search by a date range. Search for a message someone claims to have sent you in

early December.
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&7 dttachment [ ]Basic - Date G Domain Folder & Saved Search Size | Z Zimlets [ Status [ Tag 5 Time | Remove Al ) Close
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z 3 4 S [ 7 )

13 14 15 16 17 1& 19 9 10 1t 1z 13 14 15
2z

29

[LAIVAE 4

=
-
@
o
S
"

20 21 22 23 24 ;X % 16 17 18 19 20 21
27 28 29 30 31 1 2 23 24 25 26 27 028
3 4 S L 7 8 9 30 3 1 z 3 4 S

DanDe oy sl [AMal ok AddressBook | [ calendar | [£] Tasks | &7 m[Beta] | {_| Documents Brifcase Preferences
L} New Folder [gMew v | GetMal | [ Delste [ % [0 | qReply TiReplytodll & Forward | Lglunk | [ v | [ | [view al1-7 =
¥ Folders = I | L ‘ E‘ ] |’-7®‘ From |§| Subject | Folder | Size: | Recsived T
[5 nbox O [ Zimbra Zimbra's at FUDCon Raleigh 2008 - And we've ot a surprise for blog sul ZimbraE 2KB Jan 09 ﬂ
E5 chats O [ Zimbra January is a Busy Month - 'we're going to be all over the place this month Zimbra E 3 KB Jan 08
< F\ Sent | LlLIE O [ Zimbra Zindus: The Thunderbird Contacts Extension - Toolwars Pty has witte ZimbraE 2KB  Jan 07 E

How it was done: Select Email from the search drop-down menu. In the Advanced
search area, open two instances of the Date pane to set the date range. In the first
one, set the Date drop-down to is before and select an end date. Use the other Date
pane to specify is after and a start date. You can also search by sender using a basic
search.
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15 Sharing Your Account Folders

This chapter explains how to...

e Share folders from your Mail, Address Book, Calendar, Tasks, Documents
notebooks, and Briefcase folders

e Set up sharing with others
e Cancel a shared folder

e Accept a share invitation
e Work in shared folder

e Link to a shared folder

You can share your mail folders, address books, calendars, task lists, Documents notebooks,
and Briefcase folders. Sharing your ZWC items lets you collaborate with others, letting them
make changes to or just view the folder details. The process to share an folder is as follows:

e The grantor selects the folder to share: email folder, address book, calendar, notebook,

task list, or Briefcase folder.

e The grantor decides with whom to share and the access privileges, manager or view-
only, the grantee can have, and then sends them an invitation.

e The grantee accepts the invitation and gets access to the shared folder.

Selecting Access Privileges

From within the appropriate application, you select the folder and specify the type of access
privileges to give the grantee. You can share with internal users, who can be given complete

manager access to the folder or only the ability to view the folder.

You can set permissions per user or group, so everyone does not have to have the same

permissions to your shared folder.
You can share with the following:

e Internal users or groups. You select the type of privileges (role) to grant to internal

users. The user or group must have a valid address in your company’s mail server.
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0 Viewer. The grantee can read the contents of the shared folder, but cannot make

changes to the content.

0 Manager. The grantee has full permission to view and edit the content of a
shared folder, create new sub folders, edit and delete files in the shared folder.

0 None. An option to temporarily disable access to a shared folder without
revoking the share privileges. The grantee still has the shared folder in his
mailbox but cannot view or manage activities on the grantor's folder.

Note: You can share your Mail folders only with internal users or groups.

e External guests. You create a password for the shared folder that guests must enter to

view the content. They cannot make any changes to the information they view.

e Public. Anyone that knows the URL to the folder can view the content. They cannot

make any changes to the information.

Share Properties
Mame: Inbaox
Type: Mail Folder
Share with: (@ Internal users or groups
External guests (view only)
Public {view only, no password required)

Email: | |

Role

(") None Mone
(®) Viewer  \View
(") Manager View, Edit, Add, Remove, Accept, Decline

Message

Send standard message -

Mote: The standard message displays vour name, the name of the
shared item, permissions vou have granted ko the recipients, and
login information, if necessary,
URL
To allow athers to access this itern, direct them ta this URL:
https: /fdogfood, zimbra, comfhome/charrisonyInbox

oK Cancel

How Sharing Works

The access privileges for each application is described in the following sections.
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Sharing Your Mail Folders

You can share any of your mail folders, including the Inbox folder and sub-folders, with valid
users within your organization. You cannot share your mail folders with external users or
with the public. A copy of the shared folder is put in the grantee's Folder list on the
Overview pane. When the folder is selected, the content displays in the Content pane. The
grantee do not need to log into the grantor's mailbox.

Grantees that has the manager role have full permission to view and edit the contents of the
shared mail folder, create new sub-folders, send email on the grantor’s behalf, and delete

email messages.

Scenarios for sharing a mail folder

e Your sales department wants one central mailbox for all email messages requesting
information about your product, and everyone in sales should be able to view email
messages immediately when they come in. You can give everyone in the department
permission to view the mail folder and they can copy the messages to their mailbox, or
you can give them permission to manage the mail folder and they can reply on behalf
of this address.

e A manager is often out of the office and does not have time to respond to her email
messages. When the manager delegates access to her Inbox mail folder, her assistant
(grantee) can manage the content of her mail, respond to messages on her behalf, create
folders to organize message in that mail folder, and delete messages.

e Instead of sending email messages to dozens of addresses every time you have an
announcement, you can identify one of your folders as a public folder that contains the
email announcements. You can create shared access to only specific email addresses
and set a password that must be entered to view the content, or you can make it a
public URL for anyone who has the URL can view the content.

Sharing Address Book Contact Lists

You can share any of your address books with other people in your office, with external
guests, and with the public. Depending on the role you assign to the grantee, the shared
contacts list can be view-only or manager which has full access privileges to edit, add, and

delete contacts in the address book.

Sharing your address book is useful if your address books are for specific categories of
contacts and you want other users to have access to the names.
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Sharing Calendars

You can share your calendars with other people in your office, with external guests, and with
the public. Depending on the privileges you assign to the grantee, the shared calendar can be
view-only or manager which has full access privileges to create meetings, accept or decline
invitations, and edit and delete activities on the shared calendar.

Sharing Task Lists, Documents Notebooks, Briefcase Folders

You can share your task lists, Documents notebooks, and Briefcase folders with other people
in your office, with external guests, and with the public. When you share your folders with
internal users, you can select the type of access the internal users can have: either manager,
which gives full access to view and modify the content of the shared folder; or viewer, which

gives read-only access. External guests and the public only can have read-only access.

Setting Up Shared Folders

When you select the item to share, you can select the top level folder or you can select a
specific folder under the folder. If you select to share the top-level folder, all folders within

that folder are also shared.
1. Right-click on the folder you want to share.
Note When you share your mail folders, you cannot share the Trash or Junk folders.

2. Click Share Folder. The Shared Properties dialog displays. Select whom to share

with; Internal user or groups, External guests, or Public.

Share Properties
Name: Inbox
Type: Mail Folder
Share with: (&) Internal users or groups
External guests {view only)
Public {view only, no password required)

Email: | |

Role

() None Mone
(@) Yiewer  View
() Manager ‘iew, Edit, Add, Remove, Accept, Decline

Message

Send standard message -

Mote: The standard message displays your name, the name of the
shared item, permissions you have granted to the recipients, and
login information, if necessary,
URL
To allow others to access this item, direct them ko this URL:
https:fdogfood, zimbra.comfhome jcharrison/Inbox

Ok Cancel
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3. Depending on with whom you share, you do the following;:

0 For Internal users or groups, enter the email addresses and in the Role area

select the access privileges.

0 For External guests, enter guest's addresses and the password to enter to view

your mail folder.

0 For the Public, direct the public to the URL that displays in the URL area. For

example, you could copy and email this URL to those you want to view the
page.

4. In the Message area select which type of message to send. This message can be sent

to internal users and to external guests. The options are as follows:
0 Do not send mail about this share. No message is sent.

0 Send standard message. The standard share notification message is sent to the
email address. This message includes the name of the mail folder that is being
shared, your address, the grantee's address and the role assigned, with a list of

the allowed actions.

0 Add a note to standard message. You can add additional information to the

standard message.
0 Compose email in new window. Create and send a new email message.
5. Click OK.
Note: Remember, if you selected Public, you will need to notify the public of the
URL.
Changing or Cancelling Access

You can cancel the share privileges and edit the grantee's role from the Share Properties

dialog.
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To change access permissions

1. From the appropriate application, right-click on the shared folder to change.

Folder Properties

Properties

Mame: Inbox
Type: Mail Falder

Calor: | e -

Sharing for this folder

joesmow@infodey.zimbra.com  Manager  Edit Revoke Resend

add Share... (04 | Cancel |

2. Select Edit Properties. The Folder Properties dialog opens. This dialog displays the

names that share the folder.

3. In the Sharing for this folder section, click Edit by the name to change. The Share
Properties dialog opens. You can change the privileges.

0 Viewer. The grantee can read the contents of the folder, but cannot change it.

0 Manager. The grantee has full permission to view, edit the contents of a folder,
add new pages and remove pages.

0 None. This is an option to temporarily disable access to a grantor's shared folder
without revoking the share privileges. The grantee still has the folder in their
list, but cannot view or manage activities in the folder.

4. An email message will be sent to notify the user, or you can select to either not

send an email message or to send a standard or composed message.

5. Click OK.

To cancel access
1. From the appropriate application, right-click on the shared folder.

2. Select Edit Properties. The Folder Properties dialog opens. This dialog displays the

names that share the folder.

3. Click Revoke. A Revoke Share dialog opens. An email message will be sent to
notify the user, or you can select to either not send an email message or to send a

customized message.
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4. Click OK. The user can no longer access your folder. The user can delete the folder
from their Overview pane list.
Accepting an Invitation to Share Items

If you receive an email notice that you have been granted access to share another person's mail
folder, you can accept or decline the share.

When you accept the share, the shared folder displays in the specified application’s list in the
Overview pane.

To accept

1. Click Accept Share in the email. The Accept Share dialog opens and describes the
role granted to you.

% Accept Share 3% Decline Share

Subject: Share Created

¥ SentBy oy "Andy Able” <andyable@infodey.zimbra,com> On: April 29, 2008 10:29

To: joesmow@infodey. zimbra, com

The following share has been created:

Shared item: MNotebook (MNeotebook Folder)

Owner: Andy Able
Grantee: joesmow@infodey. zimbra.com
Role: Manager

Allowed actions: View, Edit, Add, Remove, Accept, Decline

2. Before you accept, you can change the folder name and select a color to high-light
the folder.

Accept Share

Andy Able has shared their Notebook Folder with wou,

They have granted you the Manager role, which means:

* ‘{ou can Wiew and Edit items in the Folder,
+ %ou can Add and Remove items tojffrom the Folder,
*+ ‘You can Accept and Decline workflow actions For the Faolder,

Do you want to accept this share?

Mame: |andy able's Motebook,

Color: | ge -

Do niot send mail about this share |

fes Mo

3. (Optional) Select to send a confirmation back to the Grantor.
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4. Click Yes. The folder is added to the granttee’s Overview pane. The message is

moved to your Trash folder.

joe Smow
E.& KB af unlinited

£ 4 Mew Nokebook

¥ Notebooks
i || mMotsbook
£ 1 andy Able's Notebook

Working within a Shared Folder

When you accept to share a grantor's folder, the folder is displayed in your Overview pane.
When you open the folder, you see the content of the folder. This information is not actually
saved in your mailbox.

e When sharing a Mail folder, the grantees can open the email and if they were granted
permissions of Manager, they can reply to, forward, or delete the message. Copies of
the messages the grantee sends are saved in the grantor's mailbox, and if the grantee
delete something from the grantor's mailbox or marks it as spam, the message is
moved to the grantor's Trash folder or Junk folder.

If the grantee has access to more than one of the grantor's folders, the grantee can
0 Move the contents from one folder to another folder in the grantor's mailbox.

0 Copy an email message from the grantor's folders to the grantee’s mail folders.

The grantor's mail folder also retains a copy.

0 Create folders within the shared mail folder and the new folder appears in the

grantor's mailbox.

e When sharing an Address Book folder, the grantee with manager’s permission can
add, delete, and edit contacts in the address book.

e When sharing a Calendar folder, the grantee with manager’s permission can add,

delete, and edit meetings and appointments on the calendar.

e When sharing a Task list, the grantee with manager’s permission can add, edit, and
delete tasks in the task list.

e When sharing Documents notebook, the grantee with manager’s permission can add
pages, edit and delete pages in the notebook. The version control lets users know when
a page was last updated and who updated it.
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e When sharing a Briefcase folder, the grantee with manager’s permission can add new
files to the folder, edit existing files if they have the appropriate software, and delete
files. The detailed information shows when a file is modified and who modified it.

Linking to Shared Items

In addition to accepting email notification that you have been granted access , you can also
establish links to shared folders by using the Link to Shared dialog. For example, this may be

the case when your organization has public notebooks that you want to view but not manage.

Note: The access privileges you have are set by the grantor.

1. In the appropriate application, right-click on the application header and select Link

to Shared. A dialog opens.

= Notebooks |
[ | companyre=< | _Compan
]l motebook & Mew Notebook
L test 2} Link to Shared Notebock: |
Tags
|| share Noteback
[ Datete
27| Edit Propertes
[ Refresh

2. To add the shared folder link, you must know the email address of the owner and
the name of the shared folder. For example, Jdoe@example.com created a notebook
called Projects with second notebook under Projects called Project 1. Jdoe then
shares Project 1 with you.

Link to Shared Notebook

To link ko an ikem thak has been shared with wou, enter the owner's email
address and the location of the Folder in their mailbox {2.q. Work/Projects):

Emnail: |

Path: |

Properties of wour new link:

Marme: |

Color: | Blue
Ok Cancel

- |
In order to access Project 1, enter the information as follows:

0 Email. jdoe@example.com
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0 Path. projects/projectl

0 Name. The name auto-completes with the email name and the path. You can
change this.

0 Color. Select a color from the list (optional)

3. Click OK. The notebook is added to your Notebooks list.
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Appendix A: Standard Zimbra Web Client

Overview

The appendix gives a brief introduction to the standard Zimbra Web Client,
including features available and navigation overview. The standard ZWC is a
non-Ajax web Ul for poorer connections, legacy browsers, or easier accessibility.
Features that are available and general navigation around the applications is

different.

Features Available on the Standard ZWC

The table that follows lists the main features of the ZWC and whether the feature

is available in the standard ZWC.

Feature Description ADV STD
ZWC | ZWC
General Web Interface
AJAX-based end Rich, interactive, web-based interface for end user v
user interface functions (access via HTTP or HTTPS)
Online end user help Online en.d user help accessible directly from the v v
end user interface
Themes Ability t(.) customize the colors and appearance of v v
the web interface
Cross-Application Features
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Feature Description ADV STD
ZWC | ZzZwWC
Drag/D hd Ability to drag/drop items, with dynamic indicators
r rop with dra
atg ¢ P 8 | of the number of items being dragged and valid v
contex
drop zones
Addresses auto-complete as they are being typed,
Auto-complete . . . . .
including a dynamically updated selection dialog v v
addresses .
when multiple addresses match
Ability to quickly categorize messages, contacts,
and/or documents by attaching "Tags" with user-
Tags ) 4 v
defined names and colors
*Standard can only tag mail
Ability to render and create messages,
HTML formatting Y 8¢ v v
appointments, and web documents in HTML format
Option to check and correct spelling in a mail
Spell check message, calendar appointment, or web Document | v/ v
*Standard - HTML compose must be checked
Mini dialog for quick actions (e.g. send message,
Zimbra Assistant create appointment) without changing the v
underlying application context
"View as HTML" . . . .
) Option to quickly view attachments in HTML
option for v
format
attachments
Keyboard Keyboard shortcuts are available for Zimbra Web v v
Navigation Client
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Feature Description ADV STD
ZWC | ZzZwWC
Custom keyboard Users can create custom shortcut keys for folders, v
navigation shortcuts | tags, and saved search from their Options page
Mail
Automati ing of i
Conversations utomatic gr?uplng <‘) messages in a me.ssa'ge v v
thread, enabling efficient message organization
Ability to view a highlighted message in a preview
Preview pane y gie 8 P v
pane
Subscribe to
Ability to subscribe to RSS/ATOM feeds v v
RSS/ATOM feeds
Message print and
. 8 p Ability to print a message and see a print preview v v
print preview
Ability to sort messages based on subject, date, or
Message sort y 8 ) v v
sender
Flags Ability to flag/unflag messages/conversations for v %
follow up
Filters T’Xbilit}.l to define filter rules and priorities for v v
incoming messages
Away messages Ability to enable/disable a custom away message 4 4
v

Signatures

Ability to add a custom signature to a message
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Feature Description ADV STD
ZWC | ZzZwWC
Compose in Option to popup a separate window when v
window composing a message
Ability to save in-progress messages to a Drafts
Drafts Y PEOS & 4 4
folder
Ability for a user to set an automatic forwarding
User-controlled .
) address and choose whether to leave a copy in the v v
forwarding ) .
primary mailbox
Reply with Option to Reply or Reply-All while retaining the v
attachments option attachments from the original message
Right-clicking a message displays a menu of actions
Right-click message 8 & 8 Py
to take on that message (e.g. Mark Read, Reply, 4
context menu
Delete)
Right-click email Right-clicking an email address displays a menu of
address context actions to take on that address (e.g. view website, v
menu add/edit contact, create filter, search for messages)
Hover over attached . . .
) Hovering over an image attachment in a message
image shows . . . . v
) displays a thumbnail preview of the image
preview
Create calendar
Ability to drag a message to a mini-calendar date to %

appointment from

message

create an appointment based on the message
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Feature Description ADV STD
ZWC | ZWC
Visual indicator of quota and amount of quota
Quota indicator 91 91 v v
consumed

Export messages as

P ] 8 Ability to export a set of messages as a ZIP file v
ZIP file
Reply/Reply-All Ability to toggle between Reply and Reply-All while v
Toggle composing a reply
Persona (Mail Ability to create multiple identities in Zimbra Web v
Identities) Client and use different names and mail settings.
Support for multiple | Within ZWC, users can identify other POP email
external email accounts that they have, retrieve email from those v
accounts accounts and save in specific folders
Reading Pane view | Users can set their default preference for viewing v
can be set messages in the reading pane
User-specified Users can set the default font family, font size and
default HTML font color to use when composing email messages v v
settings and Documents pages
Ability to insert . o . .
o ] Users can insert inline images in email messages
inline images in _ v v

) and calendar appointments
HTML Editor
Different signatures
8 Users can define v different email signatures touse | v/ v

can be defined
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Feature Description ADV STD
ZWC | ZWC

Checkboxes to select Users can check multiple emails in the list view to

N mark as read/unread/tag, delete, or to move to a 4 4
mai

different folder
Message priority can | When sending a message, the priority is normal, but v
be set it can be set to high or low as well
Multiple messages Multiple messages can be selected and forwarded in v
can be forwarded one email
Aggregation of mail . i
) Users can aggregate multiple external accounts in
accounts using L. . v
their Zimbra account using IMAP
IMAP
View the number ) )
) Users can right click on a folder to see the number of
and total size of ] i i v
. . messages and the total size of items in folder
items in folder
Address Book
Import/export
contacts in CSV Ability to import/export Contacts in .csv format v v
format
Multiple Address Ability to create multiple Address Books in a single v v
Books per mailbox mailbox
Move/copy contacts Ability t y tacts f Add
ility to move/copy contacts from one ress

across Address Y Py ¢ v v

Books

Book to another (based on access privileges)

218



Appendix A Standard Zimbra Web Client

Feature Description ADV STD
ZWC | ZWC
Personal . L .
o . Ability to create group contact lists in their user
Distribution Lists v v
i Address Books
(Group Lists)
Calendar
Personal scheduling | Ability to schedule personal appointments v v
Ability to schedule meetings and view attendees'
Group scheduling Y . . & v
free/busy information
Recurrences and Ability t ¢ . " d ’
ility to create recurring meetings and exceptions
recurrence y i ) & & P v 4
. to recurring meetings
exceptions
Ability to book resources (locations, equipment,
Resource scheduling Y i ( P v
etc.) for a meeting
Option to enable an alert popup for upcomin,
Calendar alerts P . POpUp p & v
appointments
Time zone Appointments/schedules are automatically v %
adjustment displayed in the users current time zone
Day, Week, Work Ability to view calendars in Day, Week, Work % %
Week, Month views | Week, or Month views
Customizable first User setting for the first day of the week; value v v
day of week chosen impacts the Week calendar view
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Feature Description ADV STD
ZWC | ZzZwWC

Create/dra

) & . Ability to create an appointment and/or drag an
appointment inline ) y L i v
) ) appointment's boundaries inline in calendar views
in calendar views
Quick
Accept/Tentative/De | Ability to quickly mark Accept/Tentative/Decline v
cline from calendar | from calendar views
views
Faded display of
dedlined . Declined appointments display faded so that the v

ecline

i user remains aware of their occurrence
appointments
Calendar print and Ability to print calendars in day, week, work week, v
print preview or month views and see a print preview
Hover over . . . .

i Hovering over an appointment in calendar view
appointment shows ) . ) i v

i displays additional appointment details
details
Mini-cal Option to display a miniature calendar at all times v
Hover over date in
.. Hovering over a date in the mini-cal displays
mini-cal shows ] ) v
calendar information for that date
schedule
Multiple calendars Ability for a user to create multiple calendars within v v
per mailbox a single account
v v

Free/busy inclusion

Ability for a user to designate which calendars will

220



Appendix A Standard Zimbra Web Client

Feature Description ADV STD
ZWC | ZzZwWC

by calendar be included in the user's free/busy calculations
Subscribe to external | Ability to subscribe to an external calendar in v v
calendars iCalendar (.ics) format
Publish calendar in Ability to publish/export a calendar in iCalendar v v
iCalendar format (.ics) format

) Ability for a user to view multiple calendars
Multi-calendar o . .

. overlaid in the same view, which each calendar v v
overlay views . .
optionally represented by a different color

Import calendars as . . .
o . Users can import calendar iCalendars (.ics) 4
ics iCal files
Mark appointments ) ) )

) Appointments can be marked as private or public. v v
as private
Calendars can be for o .

Administrators can configure the Calendar feature

personal ) v v

: to be able to create only personal appointments
appointments only
Search for Users can search for appointments within their v
appointments calendars
HTML Read-Only
View for Public Public calendars display in HTML read-only format | v/
Calendars
Tasks
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Feature Description ADV STD
ZWC | ZzZwWC

Add tasks and set the start and due date, set the

Manage tasks priority and keep track of the progress and v 4
percentage complete

Create task folders Users can organize task lists into folders v v

Sort tasks Users can sort tasks by Status or Due Date v v
Users can set the priority of tasks to high, normal or

Prioritize tasks P y & v v
low

Tag tasks Individual tasks can be tagged 4 4

Attachments to tasks | Files can be attached to a tasks v v

Documents

Create and use v

Documents feature

Briefcase

Create and use P

Briefcase feature

Zimlets™

Use Zimlets v
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Feature Description ADV STD
ZWC ZWC
Search
Advanced Search Advanced interface for building searches v
Ability t h £ ific item t Mail,
Cross-context search ility to search for a specific item Ype (Mai v
Contacts, Documents, etc.) or across item types
Wildcard searches Ability to search using a prefix plus a wildcard v
When using Advanced Search, the search result set
Continuous search updates continuously as search conditions are v
changed
Saved Searches Ability‘ to save searches for subsequent one-click re- v
execution
Sharing
Ability to share Address Books, Calendars, Task
Share with internal Lists, Document Notebooks, and Briefcase folders v
users and groups with internal users and groups. They can set the
permission levels to manage or to view-only.
Ability to share Address Books, Calendars, Task
Share with External Lists, Document Notebooks, and Briefcase folders v
Users with external users by assigning a customer
password.. Permission level view-only.
Share with Public Ability to share Address Books, Calendars, Task v

Lists, Document Notebooks, and Briefcase folders
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Feature Description ADV STD
ZWC ZWC
with the public. No password is set. Permission
level view-only.
Ability to share Mail Folders with internal users and
Share Mail Folders groups. They can set the permission levels to v
manage or to view-only
Link to shared Mail Users can link to an item that has been shared with v
Folders them
Link to shared Users can link to an item that has been shared with v v
Address Book them
Link to shared Users can link to an item that has been shared with % %
Calendar them
Link to shared Task Users can link to an item that has been shared with v v
List them
Link to shared Users can link to an item that has been shared with v
Notebooks them
Link to shared Users can link to an item that has been shared with v

Briefcase Folder

them
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Navigating the Standard Zimbra Web Client

When you log into the standard Zimbra Web Client you see a full screen view similar to the
one shown below.

Refer to the following table when viewing the ZWC.

- Advanced Version | Offfine Verson
_ T ; pp| e 1
Zlmbrc Firvd in [Email Messages v Search | Search web ! | @ne &JLogout
2
Sam Sample | Q 3 s -
e Mo T [ mail | J AddressBook = [T] Calendar | [ Tasks [ ] Preferences [ Compose 3
Y i -
:f'd“: 8 N (5 pefresh | [Compose | 1= Print | [ Delete |[Move to... v |Move [tore Actions... v Go | g dunk 1-11 of 11
* L Inbox -
(3 sent O 70 From & subiect 7 Recewved |
L7 Drafts (1) | Dan Pattern test results - The test equip f el e
E:é Junk O Ale Adams Highlits of koday's meeting Mar 06
Trash
Ij res O Charles £ Hils review is ready - Hope I e bin rer this by bomorrow, Charles Mar 06
Connector
[ Persanal Emails ) 4
¥ Searches edit O Donna Brown Next months meetings - Expect to see some important mesting invites over the Few weeks, We Mar 06
L& PowerPoint ... O ! Drofifia Browe Daadiing is tomorrow! - Hi Sam, Just a reminder that the first draft w deliverables is dus Mar 04
¥ Tags edit )l O] £) oonna, Sam End-User Project - Hi Gayle I finiche jeliverables early, so I will plan ko present st our (3) Marod
D End-User Training || || ] GayleBilat @ End-User Training Temglate - Hi 51 35 use the attached rPoint shide template For the Mar 03
O Duan Dedmnoiser Flight Plan - Fror an Demouser T ; e, 2imbs Sent: Frid e 7 Mar 03
El Dan Demouser 49 Zimbra in the Wall Street Journal - From: Zach Zimbra To: 20%23%60@demo2, zimbra,com Sent: Sunday, ... Mar 03
O Dronna, Sam Re: First Draft sm, Todd pushed out the deadine for the first draft, s 51 r mesting (3) Feb2
I Lo froen Mlelcogue o qur departent ST B ) . ETEvc| Eehon
([lirefresh [ Jcompose [=d Print [ Delete [Moveto... v Move |[more actions... v Go | [g Junk 1-11 of 11 3

Number Description

1 Window Header. Displays the following;:

Search Bar

@ Help

and ~JLog Out are displayed on the right

2 Overview Pane. Displays the following:
User Name - the user name under which you logged in
Quota Display — your mailbox quota

Folders — including system folders (Inbox, Sent, Draft, Junk, Trash) and
folders you created
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Searches — search queries that you created and saved for future use while working
in the Advance ZWC

Tags — any tags you have created. Click on a tag to quickly see all messages that are

tagged with that tag.

3 Toolbar. This bar displays at the top and again under the Content pane and
displays the following;:

Tools Tabs — click a tab to access the different ZWC tools available for your

account. In this example, Email is open.

Action Buttons — click an action button to perform a task available for the
application you are currently using. The Move to and More Actions fields

gives you menu choices available in the application.

4 Content Pane. The content of this area changes depending on what application is in

use. In the Inbox view, it displays all messages or conversations in your Inbox.

Move to...

This menu displays the moves that you can make within the application you are in. In this
example, In the email application, the message from Dan Pattern is selected and the options

for the message are to move to folders in your folder list.

[ Mail o Address Book ] calendar @ Tasks |_| Preferences | [y

(lirefresh [} Compose [0 Print [ Delste [Moveto... T Move
L] F U [ From & subject

Inbox ;
[ ] Dan Patkern kest resulks - The b InbosEnd-User Project projec
] Alex Adams Highlits of today's gzrns'.:n:nnal Emails [ooks

Move to Options
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More Action...

This menu displays the different actions that you can make within the application you are in.

This example is for when you are the email application.

Maove | [More Actions, .

| Go

rark as read
; Mark, as unread
AFOIEEEE ndd Flag
 ooks ik Remove Flag

review End-User Training
irEank me

hat the f End-User Training

all

fn P

q af

xk Fr

bles

More Actions

Navigation Functions Not Available

The following navigating features are not available with the standard ZWC

Down-arrow menus
Drag and drop
Reading pane
Movable sash

Tool tips

Right-click

Folder information

227






Appendix A Standard Zimbra Web Client Z

229



	Conventions Used
	1 Getting Started with the Zimbra Web Client
	Advanced and Standard ZWC
	Features of the Zimbra Web Client (ZWC)
	Zimbra Web Client Components
	Browser Compatibility
	Logging In
	If Your Session Expires
	Navigating the Zimbra Web Client 
	User Interface Features and Shortcuts
	Zimbra Assistant
	ZWC Keyboard Shortcut Keys

	2 Receiving and Managing Email 
	Customizing Your Initial Email Page
	Email Views
	Reading Email
	Printing an Email Message
	Organizing Email Messages Using Folders
	Mail System Folders Overview

	3 Composing and Sending Email 
	Composing a New Email Message
	Automatic Address Completion
	Saving Your Work
	Replying to an Email Message
	Forwarding an Email Message
	Optional Email Features

	4 Using Tags and Folders to Organize Your Mailbox
	Working with Tags
	Flagging an Email Message
	Using Folders: General Techniques

	5 Create Filters to Automate Email Handling
	Filter Conditions & Actions
	Using Any and All
	When Filters are Used
	Creating a Filter
	Editing a Filter
	Filter Conditions and Actions Supported
	Filter Wildcards

	6 Customizing Your Email Features
	Setting a New Email Notification
	Creating an Away Message
	Managing Your Account Identities
	Creating a Persona
	Retrieving Email from an External Account
	Subscribe to an RSS
	Mailbox Quotas
	Changing Your Default Time Zone

	7 Managing Your Address Books
	Viewing Your Contact Information
	Adding a New Contact
	Adding Names to Email from an Address Book
	Adding Contacts Automatically
	Creating a Group Contact List
	Importing an Address Book
	Exporting an Address Book
	Printing a Contact Name or Address Book
	Editing Contact Information
	Deleting Contacts
	Sharing Your Address Books

	8 Managing Your Calendar
	Displaying the Calendar View
	Creating a Calendar
	Adding Color to a Calendar
	Viewing Multiple Calendars 
	Importing Your iCal Calendar
	Exporting Your iCal Calendar
	Sharing Your Calendars
	Printing a Calendar
	Deleting a Calendar

	9 Scheduling Appointments, Meetings, and Events
	Creating an Appointment or Meeting
	Scheduling Attendees: The Find Attendees Tab
	Viewing Free/Busy Times: The Schedule Tab
	Scheduling a Location: The Find Locations Tab
	Scheduling Resources: The Find Resources Tab
	Scheduling an All Day Event
	Creating a Recurring Appointment
	Changing an Appointment or Meeting
	Deleting an Appointment or Meeting
	Printing an Appointment or Meeting
	Creating a Meeting Using Drag and Drop: Turning a Message or Contact into a Meeting Request
	Responding to a Meeting Invitation

	10 Using the Preferences Tabs
	Saving, Canceling, and Reverting Changes to Preferences

	11 Using Task Lists
	Creating a New Task List
	Creating a New Task
	Adding a Task Quickly
	Changing or Updating a Task
	Moving a Task
	Deleting a Task
	Sorting Tasks 
	Sharing Task Lists

	12 Working in Documents 
	Creating a New Notebook
	Creating a New Page
	Formatting a Notebook Page: Overview
	Formatting Using HTML Source
	Sharing Your Documents Notebooks

	13 Briefcase
	Creating Briefcase Folders
	Adding Files to Your Briefcase Folders
	Viewing Files in Briefcase
	Working in Briefcase
	Sharing Your Briefcase Folders

	14 Searching Your Account
	Using Quick-Search 
	Advanced Search Criteria
	Searching for Messages with Quick Search
	Searching for Messages with Advanced Search
	Using * as a Wildcard in Search
	Saving a Search Query
	Search Examples

	15 Sharing Your Account Folders
	How Sharing Works
	Setting Up Shared Folders
	Changing or Cancelling Access 
	Accepting an Invitation to Share Items
	Working within a Shared Folder
	Linking to Shared Items
	Overview
	Features Available on the Standard ZWC
	Navigating the Standard Zimbra Web Client 

	Appendix A: Standard Zimbra Web Client

	Features Available on Standard ZWC
	Navigating the Standard ZWC


